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Getting Started with the Quick Start Guide

The purpose of this guide is to give the brand-new user an easy path to getting the software
running for the first time. That means using it without any external interfaces, initially and only then
adding radio control. Further interfacing (such as CW, PTT and transmit audio) is covered in later
chapters, along with related operating techniques. | have not tried to address digital modes in this
guide, because while some aspects of program operation are identical, most are different, because
of using MMTTY, MMVARI or a terminal unit to decode the digital transmissions.

Special thanks to Bob, KORC, for his contributions to this second draft. He sanity-tested the original
by installing N1TMM from scratch and uncovered some errors and omissions that are (hopefully)
corrected below.

For starters, I'm assuming that you followed the instructions for downloading the program on the
N1MM website gor in the manual g, first installing Version 10.0.0 and then updating to the latest
version. I'm also assuming that during the base installation you installed the DLPORTIO port driver
(for 32-bit Windows 2000, NT, XP Vista and Windows 7; it does not work with 64-bit operating
systems, but is only needed for parallel port control functions, and testing of a substitute for that
purpose is underway).

With Version 10.X.X, special precautions for installing on Vista or Windows 7 are no longer
necessary, so long as you install N1MM Logger somewhere other than in Program Files (C:\ is the
default).

Once you have downloaded and installed the program, you're ready to start it for the first time.

L Country File warning

If you have been using N1MM Logger for a while, or if you have downloaded files such as a new
country file (wl_cty.dat), then before you see anything else you may see a warning message.
Don't be alarmed - the program is simply reminding you that the country file loaded into your
current database is less current than the one it found in the program directory. You can fix this
at any time from the Tools menu in the Entry Window.

Once that's out of the way, the very first thing you'll see is the following notice:

-
l]) Loading cotmty File, Thers will be & 1-5 minube dalay in starking the program AFTER vou close this message bosx,
.

Click on OK, and after a few seconds (the time required is vastly over-stated) what comes next is
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what we call the "splash screen."

About WTMM Logeer

—

After that, the next dialog that opens automatically is referred to as Station Data:

= Edit Station Information

Tip:%ou need to fill out this form

Call 1M or the program will nat perform
properly... Alzo, make sure your
Marig | T am w computer date and time are 2et
{Tom Btagher to the LOCAL date and time
Address igm Bow Maourtain Drive zone for pour ||:|_|:ati|:|r'|.
Address ]
City Ieman State |CT Zip| 060G
Courtey |54

Grid Squiare iFNE'IST Ca Zone |5 ITU Zane |g

Licenze Clazs iE:-:tra'
Latitude (41803180 Longitude (7245413 Enter 5, E as negative numbers

Facket Mode Call !K'I TTT
ARRL Section !ET 8.0, 5TH, SDG. Enter "D for non-US stations

Club iYankEﬁ Clipper Contest Club
email Elddf.ESS']

SMTP Server addr!H_H

Ok Help Cancel

Since you have never run the program before, it is filled in with Tom, N1MM's information. You
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should replace it with your own information, in the same format. This is very important for proper
operation of the program. Later, if you need to change anything, you can re-open this window
through the Config menu.

When you see one of the blue 'Tip:' notes, be sure to pay attention! For example, this one warns
you to be sure your computer is set up for local time, NOT GMT. N1MM Logger will take care of the
conversion for you. Don't worry about the SMTP server address unless you know it off-hand - it is
only useful for bug reporting. When you have completed the form, click OK.

Next comes what looks like an error message:

Setup Error

i Wave is being muted,
- It is being chanaged to Mic.

Don't take it seriously - this is related to playback of audio files, something you won't need for a
long time yet. Just OK out.

After that you will see an Entry Window. Let's get a little terminology out of the way first. The top
blue part of this (or any) window is called the Title Bar. Each of the places where you can type
information is called a textbox. The Title Bar displays the current frequency, mode (if one has been
selected), and which radio it is (nominally, Radio A). You will have to enter a mode before you begin
to operate, and a band and/or mode each time you change either. Simply type a frequency in KHz
(3500, 7000, etc.) in the Call-Sign textbox (to the far left) and hit Enter; then type a mode (CW,
USB, LSB) there, hit Enter again, and you're set.

The Entry Window is your main starting place for everything you do with N1MM Logger. The first
row is a standard Windows-style menu, and we'll be using it in a minute. Take a moment and
explore the various drop down menu choices, but don't change anything right now.

Below the menu is a set of entry textboxes. This row is where you log your contest QSOs. The
left-most textbox is the Call-Sign textbox. You always enter the call-sign of the station you are
working into this textbox.
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™ 14200.00 Manual - A
File Edit Wiew Tools Config Window Help

Snt Fov  Zone
SO wipe | | Edt | Maik | | Spot It| Buck |
Ezc: Stop | Col Exch F3Long CO | F4 My Call
[ Running  F5His Call FE Rpt F7? F8 Agn
FAMR F10 F11 F1z

Bearing information appears here.
Thiz databaze iz for. N4ZR 99/36/17 18179

The rest of the data entry textboxes are titled above them - depending on how you have resized the
window, the titles may not line up perfectly with the entry textboxes, but they are always in the
same sequence as those textboxes. Depending upon the specific contest and the required contest
exchange, the number of textboxes and the titles may be different. The example Entry Window
shown above would be used during the IARU Contest. This contest requires a call sign, sent and
received signal reports, and the IARU Zone be logged for each contact

For now, you can ignore the 'Running' check-box, as well as the rest of the buttons alongside it.
This controls one of the most important features of N1MM Logger - it distinguishes between Run
and Search and Pounce modes, providing different features for each. However, these aren't really
relevant until you get into sending stored CW and phone messages, which are covered in Chapter
4. The rest of the buttons in the Entry Window are related to this, and to other advanced
capabilities.

If you want to save space on your screen, you can reduce the size of the Entry Window, like this.
Just use your mouse to grab the lower right corner or lower edge of the window and drag it upward.

e 1A200.00 USE Manual - A
File Edit Mew Tools Confio Window Help
~Snt Fov  Zone—

FMSBH ] | | -

FM - Martinique, Zone B, N S5 -

There are two more useful features of the Entry Window. The box in the lower left corner, called the
Status Line, provides a lot of useful program status information. For example, if you enter a call
sign, the Status Line will tell you what country it represents. If you have set up the Entry Window
just a little bigger than the minimum, it will also show you the distance and bearing, like this.
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= 14200.00 USB Manual - A

File  Edit View Tools Confip Window Help
St Row  Zone

FMSBH 59 539 [
@ wipe | Logit| Edt | Mark | Store | Spotit| Buck |
Esc:Stop | CO Exch F3 F4 N4ZR
| Running  F5 His Cal FE# F7 FB&gn
FaRpt | FIDGRL | F11Move | FI2LONG

Beating =145° 1995 mi. 3217 km, LP = 325°

Fb - M artinigue, one 8, Ma 0040 o

To the right of the Status Line is the progress box, where you can keep track of your QSOs and
multipliers without having another window open, and to its right is a running score.

If you press the backslash (\) key, the program opens a second, almost-identical entry window. The
only difference is that it will have a "B" instead of the "A" in the title bar of the first entry window,
and it may well have a different frequency and/or mode as well. But if you pop up the second Entry
Window by mistake, and want to get rid of it, you simply close it by clicking the big red X.

When you first open the program, it will be in SO2V (Single Operator Two VFOs) mode. The idea is
this - most modern transceivers have two VFOs, or a main VFO and a sub-VFO. There will be
circumstances - during a contest on 40 meter SSB, for example - when you will want to receive on
one frequency and transmit on another, widely-separated one.

For the moment, you should change to SO1V (Single Operator One VFO) mode. Select the Config
menu, and under the dropdown menu, select Configure Ports, Telnet Address, Other.
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= 14200.00 USE Manual - 4

Configure Forts, Telnet Address, Other
Ii FM  Change Your Station Data
Change Sub Bands ¥

@' Clear IMI file settings
Find all windows {move to within 500 x 600)

[~ Enter sends messages (ESM mode) Ctrl+M
AutoSend Threshold
Spot all 58P QSO's
v 05Ying wipes the call & spots QS0 in bandmap [(S&F)
v Show non-workable spots
———  ResetRx freq when running split
Ii Dual Rx always on
» C0 Repeat alt+R
Set CO repeat time Cirl+R
v Call History Lookup
Record Q50s

Change CW /358 Digital Message Buttons ¥
Multizer Mode

Edit Station Computer Names

Change Operator Cirl+0

Change Exchange Abbreviations
SO2R.

Testing

WAE

v T v v
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That opens this rather intimidating dialog:

™ Configure

r
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[ Winkey T tode Control T Antennas T Audio 1
Hardwaie Filez T Function Keys T Drigital Modes T Other
Part Fadio Digital Packet Cw!/PTT Detallz-— ¢ S01W O 5024 & 502R
s ) ST | et e e
Comz2 r—_] BT ol DTR=tlways OnRTS=tways
Carm3 W I [= Sl - _S._.Et_J 4300.M.8.2 DTR=Always
Comd |Kenwu:u:u:| | = B e _S_.et_J 4300 M.8.2 DTR=Always
ComS [ | W T T Bet || DTR=Always OnRTS=PTTTx=1
Comf [ie <] # T [ 5et || DTR=Always OnRTS=PTTTs=2
Com? [Hoe | T T R Set || DTR=Always OnRTS=Always
Bamd: [Nore: =]l 0 T [ _Sa |
LPT1 ] _J
LPTZ2 Y
LFT3 m
Télﬁet Cluster
|KITTT.NET || _Edit]

ITI Cancel I Help

Ignore everything else, and just select your operating mode, from among the choices "SO1V",

"SO2V" and "SO2R." SO2R stands for Single Operator 2 Radios. Select SO1V to disable this for

now (it prevents the program from opening the second entry window any time you press the "\"

key). Now O

K out.

In the row below the entry fields in the Entry Window are two colored dots - the green dot denotes

which Entry window (if you are using two VFOs, or have more than one radio) has the Entry or

Receive Focus. The window with the Entry Focus is where information will be entered if you type it,
and also the radio (or VFO) which will transmit any Function Key you press on the keyboard. The
blinking Windows cursor denotes the same thing, and so does the change in color of the title bar
and frame of the entry window. The red dot denotes the Transmit Focus, which frankly is not very
useful, because it denotes the radio (or VFO) that transmitted the last message. More on this whole
2-radio/2-VFO business later.
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g= 14200.00 USE Manual - A
File Edit Vew Tools Confio Window Help

| i~ Snt Fow  Zone
[FMSBH I 1 0
=W wWine l Lu:ugItJ Edit J ark j Store J Sgutlt] Euck-]
Ezc: Stop ] Co Exch F3Llong CO | FdMup Call
™ Running FimisCal | 0 | F77 | FBAgn
FI MR F10 F11 Fiz
Bearng = 1457, 1995 i, 3217 km; LP = 3257
FM - Martinique, Zone 8, N& [ s HE

A word about fonts. Windows defaults to a sans-serif font that does not distinguish well between
"oh" and zero. If you click on View in the menu row, you'll see "Set Font" as one of the options.
Click on that and you'll be given a list of available fonts, like this:

Font: Font style;
il Manaco iBﬂhﬂ
4| |Regular
Monotype Corsiva — |kalic
H MS Gothic
T MS Mincho Bald kalic
T MS Qutiook
B MS PGothic
T M5 PMincho el
Effects — Sample
I Stikeout
AaBbYy/Zz
[ Undedine y
Color;
| I =k > | | Scrpt:
: ]Westaﬂ _Y_J
This font style-is imitated for the display. The closest matching shvle
will be used for prnting.

| have chosen Monaco for my font, even though it is normally used by Macs, because it gives a
good clear 0/0 and I/1 distinction. In addition Monaco bold is a little bit bigger than the unbolded
type-face in a given size, which helps legibility in some windows. You can make similar choices in
the Log and Check windows, by right-clicking them to get the appropriate sub-menu. You may have
to play around a bit with the window size and font characteristics (Bold/Regular, or point size) to fit
everything in the exchange field - this is particularly true of the signal reports "59" and "599".
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You can download a large set of slash-zero fonts (as they are usually called) here .
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Now, we're ready to set up a contest. Note that the first database the program creates is named

ham.mdb by default - you can have as many databases as you want, and name them what you
want. I'm using ham.mdb, but my program directory is named MM Beta (for historical reasons).

Some people prefer to create a database for every contest, while others create one for a period of
time, like every year. If you want to create a database, for example "2007.mdb", just click Files to

drop down the menu, and then click on "New Database".

= 14200.00 USE Manual - A
Fie Edit View Toole Config Window Help

Mew Log in Database: C:\Program Files{MM BetaiTest.mdb
Open Log in Database: C:\Program Files MM Beta{Test.mdb

COpen Database. ..

Copy (and Compact) Database. ..

Copy This Contest to Another Database...
Repairing a corrupted databaze {Internet)

Import
Export

1 COWWEW (7/26/2007)

2Z10TA {7/28/2007) in C:\Program FilesMM Betatham.mdb

3 ARRLDXCW (2/13/2007) in C:\Program Files\MM Betaiham.mdb
410TA (7/23/2007)

5 COWWCW (11/25/2006) in C:\Program Files'{M Betatham.mdb
& COWWWSSE {43/2007)

7 RUSSIANDY (3/16/2007)

80% (1f1/1900)

9 COMIPKSSE (3/23/2007) in C:'\Program Files\MM Betatham.mdb

Exit Alt4+F4

Mew Database, .,

That will open a standard file creation dialog in your program directory
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Choose a File

My Recent
Documents
F‘F‘Z

Desldop
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Savein: |;;} MM Beta

_-r_1 = & iy Ea~

[=acall history Files
DX

IChiFkeys - CW
[CTaFKeys -RTTY
| TiFkeys - 558

| igrayine

|{f] et
Chletters

[ hrealtmescore
i=15ource
iChway
@ham.mdb
@Test.mdb

] Thucy 1-30-07.mdb
[#wagzr.mdb

File name:

Save as type!

[New MDBE

| Access databases (" mdb)

=
=]

Save

Cancef

Name your new database and click Save. You'll be switched to the new database and ready to go.

Back to the Files menu again. This time click "New Log in Database: C:\Program Files\N1MM

Logger\ham.mdb" A new dialog opens.
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CG\Program Files\N1MM Logger\ham.mdb

i Select Contest Type for Mew Lag -

Start Date {2007-10-19

%

[ Contest T Azzociated Files 1

Hperator Cetegay | SINGLEDP = - State for Log Typs QSORAATY
B Bslegen: ]"i'"LL j' Mote: the program does
]ﬁ not validate categores.
Power Cateqoty |HiGH . Check the contest rules
Maode Category |, - | farvalid categories:

Overlay Category | a -] Shaw Rules [Intemet
access reguired]

Sent Exchange /5 Omit BST, E.g. CwA: 05 5504 56 ERMA
Operatars. IN4ZR Update Ops fram Log |
Soapbox
Comments:

O Help| Eancel.l

The first thing to do is to click on the down button of the Log Type field. That will open a list of
abbreviated contest names, as | already have done above. You can use your mouse to scroll
through the list, or type the first letter of the contest to jump to the right general area. Once you
have found the contest you want and highlighted it, click back in the original field and the
drop-down list will close.
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C\Program Files\N1MM Lnggerl_ham.mt-i:h

Select Contest Type for Mew Lag -

Log Type  iEERY

Start Date {2007-10-19

Contest T bzznciated Files 1

Operator Categoyy (cinGLE-OP R State for Log Type DSOPARTY

R J"i'"LL LJ Mote - the program does

Fower Categar — 1 notvalidate categones.
A% |H|GH T Check the contest nles

Mode Categon ||:-w LJ far walid categories.

Overlsy Category |y s = Show Rules [Ikternet
access required)
Sent Exchange Is Omit RST, E.g. COMWY 05 550 A BB EMA
Gt |N42F| |Ipdate Ops from Log
Soapbox
Cormments

oK Help| I:an.:e|]

The program fills in today's date as the start date for that instance of the contest,. You may want to
change it to the actual start date of the contest, though this is not mandatory. This is a good idea
for calculations of total contest time and to keep track in case you have logs for many different
instances of the same contest name, such as QSO parties. Since I'm just illustrating here, the date
is today.

Next, fill in the information in the next few fields, denoting the class and category you intend to
enter in the contest. In each case, you have drop-down lists available. "Overlay category" refers to
contests like WPX, which have both regular classes and categories like Rookie or "Tri-bander plus
wires". In most cases, "N", for not applicable, is the answer you want there.

Next comes the most important part of this dialog, the Sent Exchange field.

Sent Exchange |5 Omit BST. E.g COWA: 05 55 A BB EMA

For many contests, the program guesses what you will want - for example, in this case, since the
CQWW contest uses CQ zones, it has already picked zone 5 for me. Note the "Omit RST" warning.
If the contest you choose has serial numbers, like WPX or the NA Sprint, then you need to put
"001" at the start of the Sent Exchange field, followed by a single space if there is more to the
exchange. Hence, for WPX, my Sent Exchange would read 001. An important exception is the
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ARRL Sweepstakes. The serial number is "assumed" for this contest only, so my Sent Exchange for
SS would read B 54 WV. More information on the Sent Exchange is in the Supported
Contestssection of the manual.

Once you have filled in the Sent Exchange, you're done for now. Just Click OK and hit Enter. Now
you're almost ready to operate in the contest, but first it's time to open a few more windows. Go
back to the Menu line in the Entry Window, and Click "Window". A sub-menu will open, like this:

im 14200.00 Manual - A 5
File Edit View Tools Config | Window Help
snt Rev  available Mult's & Q's

|| | r Bandmap
Chedk

%. Wipe | | Edit | M: CW Key Cirl+K

Digital Interface
EsciStop | OO E: Entry Window
[ Running  F5 His Call ';:t:. Gray Line
Fa MR F Info
Log Cirl+
o ) Multipliers Ctrl+]
Bearing information appears b Packst

Dueling CO= iz OIff Score Summary

To begin with, click on the "Log" window. That will open a Log window on the screen, like this:

i 6/27/2007 21:12:241 CO WW 55B - ham.mdb

B/Z7/2B07 E2@:S6:88 |EMSBH 14700.08/50° 50 yes B | =" : =

6/27/2007 20:56:08 |FMSEH  [14200.00[50 |58 [Yes [8 |Yes | |2 | =

First, you should notice that the title bar of the Log Window gives the current date and exact time,
the name of the contest, and the database in use. As you log QSOs, they will appear in the log. |
have logged one above just to indicate how it looks. The most recent last QSO is highlighted. You'll
note that each column has a fixed label - these labels do not change. CQWW is a 2-multiplier
contest, so the log shows columns for "Mult" which is the country, and "Mult2" which is the CQ
Zone. The "yes" in each simply means that it is the first of that multiplier on that band.
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If you click on any column heading, the entire log is sorted by that attribute - for example, if you
click on the Mult heading, the log will be sorted so that all of your first QSOs with a given kind of
multiplier (in this case, a new country) will be moved up to the front. Click on TS (for timestamp) to
switch back to the normal log order.

A further nice touch - if you click a second time on the column heading, for example the "Call", the
sort order switches from Ascending to Descending, so that all your "Z" QSOs come first, and your
"As" last. Same goes for the TS (TimeStamp) heading - normally, you'll want to leave the Log

Window in TS ascending, so that each QSO you log appears immediately at the bottom of the list.

The Log window has two "panes" the one above the dark-grey line is the normal log, while the one
below the line is to show you previous QSOs with a station, each time you type its call into the Entry
Window. You can resize the entire log window, or move the separator to make the previous QSO
pane bigger.

This makes it very easy to see, quickly, all the information about previous QSOs, for that special
someone who drops by and asks, "What was the serial number you gave me yesterday?"

Like all windows in NTMM Logger, the Log window is resizable, as are the individual log columns -
to resize the whole window, use your mouse to drag the lower right corner, and to resize a column
grab the between-column divider and drag it right or left. You can move any window around the
screen by dragging its title bar. Also, as | mentioned above, you can change the font in the Log
window by right-clicking in the window, and choosing your font as you did for the Entry window.

Check - Muk 160 8040201510  [¥X]

OK, another important window - the Check window. You open it the same way as you did the Log
window., and set the font the same way (with a right-click menu choice).

This window is used to display the results of checking a call-sign against your log and also against
a master list of calls, variously called the master.dta or Super Check Partial file. One is provided
when you install the program, and the process of updating is covered in the Entrywindow section of

the manual.
W1AW - Dupe!l

TWIAWH WI1AWE
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First things first, though. When you type a call-sign in the Entry Window, the Check window
displays whether a match was found or not. If the match is in your current log, it is shown in the first
line of the window, like this:

Note the program warns you that you have already worked that station, and can't do so again on
the current band (or maybe in the entire contest, like SS). Also note that two lines below are two
possible matches from the master database.

W1AWB |

Had the station you copied been W1AWB, when you entered the Check window would change to
reflect that, as follows:

Note that the station's call appears in blue, meaning that to work the station would not be a new
multiplier, but would be a valid non-dupe QSO. This color coding is consistent throughout the
program. Because it appears in the second row, you know that it is from the database and not from
your log (if for example, you had worked him on another band, the call would appear on the first
line, in blue).

OK, that's probably enough about the Check window for now. These are really the only windows
you need to operate your first contest with N1MM Logger. Now let's sit down and operate.

For the purpose of this guide, we'll assume that you're operating in the CQWW SSB contest. In that
case, the Entry Window will look like this:

= 14200.00 USE Manual - A

File: Edit View Topls Confio Window Help
Sht. Focw  Zone

[FM5BH 59 [59 '@—

S wips I Log It | Edit I Mk | Store |Sgcut|t| Buck |

EseStop | oo Exch | Fa | Fanazm
™ Funing FSHisCal | Fen | F77 | FBon
FIFpt | FIOGAL | F11Move | F12LONG |

Bearing =145% 1995 mi; 3211 km, LP = 325°

F - kartinigue; Zone 8, Ma, 04040 L0

I'm assuming that you're going to operate phone to start, so | have typed in USB in the call-sign
field, and hit Enter. | have left the default frequency (20M phone) in place, but if | wanted to show
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another band, | need only type a frequency (in KHz) in that band (like 21200, for example) in the
call-sign field and hit Enter to change bands.

When I've done these things, | then type a call-sign in the call-sign field. Even before | look at the
Check window, | see that the call sign is fcolor-coded green. This means that it is both a new
contact and a double multiplier (in this case, both the new country of Martinique and the new Zone
8). The beam heading is displayed below, as are the country, its zone and continent (which affects
points per QSO). If | have already worked Zone 8 on this band, then the call sign will be
color-coded red, signifying just a new country. If both the country and zone had been worked
before, but the station has not, then the color code will be blue. If it is a dupe, the call sign will be
coded grey, and the warning "Dupe!" appears to the right of the entry fields.

So, you call him, and he answers. At this point, just hit Space to fill in the expected signal reports
and move the cursor to the Zone field. NTMM Logger uses the Space bar as a "smart tab." The idea
is that it will skip fields you are unlikely to want to change and move immediately to the one you
may need to. Note, too, that the Zone is highlighted. This means that if you need to change it
AfA¢A¢a€sA~A¢a~A" for example, if FM5BH really was in Zone 9 (he isn't) - you would just type "9"
and the "8" would be replaced.

i= 14200.00 USB Manual - A T
File. Edit Wview Topls Confio Window Help
St Row  Zohe

FM5BH 59 (59 [§
E@® wipe | Lag It | Edit | bk | Store I Sgcutlti Buck |

Esc: Stop | Ca Euch Fa FAMNAZE
| Running  F5 His Call FE# FE F8 Aan

FIRpt FIoQRL | F11 Move | F1ZLONG

Beafing =145% 1995 mi. 3217 km, LF = 3257

Fr - kartinigue, Zone 8, Ma, (4040 |0

Ok, but suppose he's a wise-guy and gives you a "57" report instead. No problem - you just use the
Tab key twice, and the cursor will be on the second digit of the received signal report, ready for you
to type over. The Tab and Shift+Tab work just as you'd expect in Windows, moving forward or
backward one field. Here's how it looks:
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e= 14200.00 USE Manual - A
File' Edit View Tools Confio Window Help

- Gnt Row  Zone
|FMSBH JSQ EolC

Bl \wipe | Loglt { . Edit | Mark | Store |Sgcut|t1 Buck |

EsaStop | g | Ewch F3 F4N4ZR |
I Running F& His Call FG # Fr?  FBaagn
F3Rpt | FIDGARL | F11Move | FIZLONG

Bearing =145°, 1995 mi; 3211 km, LF = 325°
FM - Martinique, Zane 8, N&, 1414 4

If you need to correct the call-sign, use the Space bar to get you quickly there and edit as
necessary. Then, once everything is as you want it (and the QSO is done), all you do is hit Enter,
and the QSO will be logged.

One thing that trips everyone up at least once is that the program checks to make sure that you
have entered everything, and that everything is correctly formatted. For example, if you accidentally
fat-finger the zone number, like "89", the program won't let you enter the QSO. This can be
disconcerting at first - you get an error message in the status line, like this:

i= 14200.00 USB Manual - A =l
File: Edit Wiew Tools Confio. Window Help
—5nt Fow  Zone
|FM5BH [59 (59 ]39
5@ wipe [Togit] Edt | Mark | Store | Spotit| Buck |
EseStop | oo Exch P3| FanazR |
| Punning  F5HisCall | FG# F77 | FBAgn
F9 Fipt FIDORL | F11Move | F12LONG |
Bearing =145% 1995 mi; 3217 km, LF = 325°
@ Mizzinglnvalid Zone 114 4

If the program has blocked you from logging the QSO, just use the Space bar to move to the
appropriate field, correct it, and hit Enter to log. If you absolutely can't figure out what the correction
should be (for instance, with an ARRL section in Sweepstakes), you can hit Ctrl+Alt+Enter to
bypass the exchange checking and log the QSO "as is." Just in case you want to put a note in the
log, when you do this a note window opens. Type whatever note you want and Hit Enter, or just hit
Enter to skip it and get back to the contest.

Suppose you miscopied a call sign, or he didn't really come back to your call, so you now have a
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mistake in your log. If you need to delete the QSO altogether, just hit Ctrl+D. The program will ask
you if you really want to move the QSO to a Deleted QSOs file. Just hit Enter to do so, or type N for
No.

If you need to edit the QSO, hit Ctrl+Q, and put the program in QuickEdit mode.

i= 14200.00 USB Manual - A =3
File: Edit View Topls Confio: Window Help
QuickEdit Sht Row  Zone

FM5BH 59 [59 |8
{i’. Wipe | o | | | belarl: | Store |Sgcut|t| Buck: |
Eso:Stop | 0 Exch | Fa | Fenaze
™ Rurning FSHisCall | FE# | F77 | FBégn
FIFpt | FIOGAL | F11Move | F12LONG |

Beating =145% 1995 mi; 3217 km, LF = 325°
F - kartinigue, Zone 8, Ma, 114 4

You'll notice the words QuickEdit above the call-sign field, and that the background of all of the
entry fields is now blue. You can move through the fields as before and make your corrections.
Then hit Enter and the QSO will be corrected in the log, or else hit Esc to get back to normal
logging mode and cancel any changes. Be careful not to leave the program in QuickEdit mode for
your next QSO, or you'll screw up two QSOs at once!

As you log more QSOs, you'll note that the call-sign of your last previous QSO will appear in the
space right above the call-sign field. This area, called the Call-Frame, will be very important once
you have interfaced the program with your radio, but for the moment it is just a reminder of who that
last guy was.

¥ Remember

Remember, each time you change bands, you need to enter the frequency of that band in the
call-sign field, and, if you change modes, enter that there too. For example, if you switch to 40M
CW, you would need to enter 7000 and then enter CW (separately) before you begin logging
QSOs on that band.

So, you've logged a bunch of QSOs, the contest is over, and it's time to send in your log. Aimost all
contests these days accept Cabrillo-format logs, and that's what NTMM Logger usually provides
(check contest rules for any exceptions). To export your log in Cabrillo format, go to the File Menu in
the entry window and select "Export Cabrillo to file."
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™ 14200.00 USE Manual - A
File Edit View Tools Config Window Help

Mew Log in Database: C:\Program FilesMM Betatham.mdb
Open Log in Database: C:\Program Files\MM Betatham.mdb

Mew Database...

Open Database. ..

Copy (and Compact) Database...

Copy This Contest to Another Database. ..
Repairing a corrupted database (Internet)

Import

1IARU {5/18/2007)

2 QSOPARTY (5/18/2007)

3 QSOPARTY (5/165/2007)

4 GACW (5/9/2007)

5 COWPXCW {5/26,2007)

& SPRINTCW {5/29,2007)

7 55558 (11/18/2008)

B S5CW (11/4/2008)

9 COWPXCW (5/26/2007) in C:\Program Files\MM Beta'Test.mdb

Exit Alt+F4

3
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Export ADIF to file *
Export Cabrillo to file...

Export to File (Generic) r
Export REGITEST to file by band...

Print Score Summary to File...

Export Call History...

Export Packet/Telnet Buttons to file...
Export Telnet Clusters...

Export Function Keys to File »

The program will first check to be sure you have the Sent Exchange you want:

Check your sent exchange!

5

Mir) Your Cabrifla log will be generated using the following SENT EXCHANGE:

RET will be added if needed for this contest. Place a 001in the correct position if serial number is required far this.
contest (EXCEPT ARRL 5513, If the sent exchange is not correct, go to File [Choose Contest and correctit!

If it's OK, then click OK or Enter. Next you will see a standard Windows "Save-as" dialog. By
default, the program goes to the program directory, but | usually change that to Desktop for

convenience:
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Savein: | (&} Desktop lj & B2 of B
&
L{ﬁ [ j My Computer
My Recent ;‘_-_!My Metwork Places
D."F.””.‘?”.*? HEITS HF Propagation
9 |31 2007-06-17
— ilii‘lMisc files
Desktop 2] nazr.LOG
My Documents
Wy Computer
g File riame: [N4zR 2007 1ARU LOG | save |
My Metworde  Save as ype: 1LOG {Cabrilla) Files {*.LOG) LJ Cancel
Places

You can name the Cabrillo file as anything you want (Call sign.log is suggested), and then click
Save and your Cabrillo file is automatically produced and saved.

Next, and this is important, open your Cabrillo file in Notepad and check to be sure that the
information in the header is in accordance with the instructions for the contest. N1MM Logger tries
to keep up with Cabrillo file format changes, but nobody's perfect, so save yourself some hassle
and double-check. Contest categories seem to be a particularly tricky area. You also need to be
very sure that you specified the Sent Exchange correctly during contest setup - one common
mistake is to put the signal report in as part of the exchange.
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B N4ZR.LOG - Notepad

File' Edit Format WView Help

[ETART-OF-L0G: 2.0 ~
ARRL-SECTION: WV

CALLSIGN: N4ZR

CLUB: Potomac Valley Radio Club

CONTEST: CO-WW-S5B

CATEGORY: SINGLE-OP ALL HIGH S5B

CLATMED-SCORE: 4

OPERATORS: MN4IR

NAME: Pete Smith

ADDRESS: 96 Willow Well Lane

ADDRESS: Kearneyswille, WV 25430

ADDRESS: USA

CREATED-BY: NIMM Logger V7.7.1

0S0: 14208 PH 2007-07-18 2833 N4ZR 39 5 FM5EH 39 @3

END-OF -LOG: I

Lni, Col 1

Okay - that pretty well wraps up the first chapter. Don't hesitate to use the Google Help facility
(Search Help Using Google (Internet) ) to look up more information on any of these topics. It works
tremendously well for looking up more details on any of the windows, or exploring any other aspect
of the program. In the next chapter, you may need this capability a lot, because so much of
interfacing is specific to a particular radio, and you really need more detail than | can provide here.

Basic Radio Control Interfacing

Regardless of whether you want to operate phone, CW or digital modes, the most useful and
important interface is the one between your computer, NTMM Logger and your radio. Fortunately,
most radios now incorporate a serial port to enable them to swap information and commands with
the computer.

Afirst step is to look up your transceiver in the manual section titled Supported Radios. Assuming
you find your radio there, look for any specific settings or peculiarities that need to be addressed
and make a note of them.

Many modern laptops and a growing number of desktop computers lack both RS-232 serial ports
and an LPT parallel port, having replaced both with one or more USB ports. If your radio has a
standard RS-232 serial port, once you have purchased a USB-to-serial converter and installed the
drivers for it, MM can work with your radio just fine. If your radio uses either Icom's CI-V standard or
another non-RS-232 serial port, you'll need an appropriate converter cable to get from either USB or
RS-232 to your radio.
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Once you have the hardware hooked up between your computer and your radio, start N1MM Logger
and open the Config menu in the Entry window. Choose Configure Ports > Telnet Address, Other.

Ignore all the other stuff for now.

= 14200.00 USB Manual - A
File Edit View Tools Config Window Help

'I Change Your Station Data

Change Sub Bands
@.\Mpej G J g Clear INI file settings
Esc: Stop I cQ

[~ Running FSHisCal Enter sends messages (ESM mode)
FINR AutoSend Threshold

Spot all S&P QSO's

Bearing = 145°, 199 v Show non-workable spots
I Telnet port closed. Reset Rx freq when running split
v Dual Rx always on
CQ Repeat
Set CQ repeat time
v Call History Lookup
Record QSOs

Change CW/SSB Digital Message Buttons »

Multi-User Mode

Edit Station Computer Names
Change Operator

Change Exchange Abbreviations
SOR

Testing

WAE

Find all windows (move to within 800 x 600)

v QSYing wipes the call & spots QSO in bandmap (S&P)

I Configure Ports, Telnet Address, Other ‘

»

Ctri+M

Alt+R
Ctrl4R

Ctrl+0

v v v

That brings up the following, rather intimidating dialog. Don't worry, we'll walk you through the part

you need now.
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= Configurer

[ Wikey | ModeContiol |  Antenas |  Audo |
Hardware | Fies | FunctionKeys | DigtalModes |  Dther

Port Radio Digital Packet C\W/PTT Details " SOV ( SOV < SO2R

Com1 I I I |

I

Com2 | | T Gal DTR=Always OnATS=Always
I
i

<l

Com3 | FT-1000MP = Set 4800,N.8 2 DTR=blways

Set 4800,N.8.2 DTR=Always
DTR=Always OnRTS=PTTTx=1
DTR=Always OnRTS=PTTTx=2
DTR=Always On RTS=Always

Com4

B

Kerwood =

Comb v

Com?
Com8
LPT1
LPT2
LPT3

Teinet Cluster
KITTT.NET R

=
=

< 1G]

i

Comb | v
|
|

=

C o

You may want to select SO1V if this is your first experience with NTMM. SO1V allows N1MM to
control VFO Ain your transceiver. If you are an experienced contester and understand how to
operator in split mode (for example, working DX on 40 meter sideband) you may want to select
SO2V. It allows N1MM to simultaneously control both VFO A and VFO B in your transceiver. If you
are an advanced contester, whose station is configured with TWO transceivers (one for running
contacts and the other for searching for new multipliers), then you will want to select SO2R.

Now identify which port you have physically connected between your computer and the radio (or in
the case of USB, the virtual serial port it has created). Click the drop-down arrow under Radio, and
select your specific radio model. For this example, I've assumed COM3 and a Yaesu radio. Virtually
all Kenwood models use the one common radio configuration, while Yaesu and Icom radios are
generally designated by the specific model number - refer to the manual under "Supported Radios"
for more information. Icom radios require a Radio Address (Hex Code) - see the manual for more
information.

Now click the "Set" button next to the port you have chosen.
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w Com3 §|

Speed Panity DataBits Stop Bits
[EET - N e =2 =
DTR [pin 4) RTS [pin 7) RadioAFO Nr
|AwaysOn | |AwaysOn v 1 v

[ Radio PTT via command
[~ Allow ext interrupts  FootSwitch [pin €)

Nane _:_l Help

I MK2R

Suggested Settings:

lcom: 1200, N, 8. 1, Always on, Always on, Hex Code
Yaesu. 4800, N, B, 2, Aways on, Always on

Kenwood: 4800, N, 8, 2, Handshake, Handshake

TT Onore 57600, N, 8, 1, Handshake, Handshake

[O—K] CanoelJ

That will bring up this dialog, with connection details. Normally, NTMM Logger chooses the
parameters in the first two rows for you, and does a good job. You might want to verify them with
your radio manual, just in case. Radio/VFO number should be 1, so that your main VFO will be
displayed in the main (first) entry window. The rest of the stuff on this dialog is not important right

now, so just click OK to get back to the previous dialog, and then OK again to return to the Entry
Window.

If all is well (you did turn your radio on, right?), when that big multi-tabbed dialog closes and the
Entry Window reappears, the title bar of the Entry Window will display the radio's frequency and
mode. It's magic. The "+0.00" simply means that RIT is turned on, but set to zero (no offset)

i= 7040.20+0.00 CW FT-1000MP Al=1_J
File Edit View Tools Config Window Help
Snt Rcy Zone

|I | ]

SO wipe | | Edt | Mark | | spot It| Buck |

Esc:Stop |  c@ | F2Exch | F3TU | Fanazm |
" Rumning F5HisCal | FBExch | F7? | F8Agn |
29 = "SNP | FipQAL | rm2 |

Bearing = 145%, 1995 mi, 3211 km, LP = 325°
Cw Speed =29 4/4 40

Now that you have radio control, you can do a lot of neat things, but one of the most basic is that
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you will never again have to worry about accidentally logging QSOs on the wrong band or mode.

7031.70
70003 i1DAR 33
T~MDOCCE 47
™~ PY7XC 147

7005 ——WP4L 151
4 NEw7L0 39°

=t

R DS5USH 341
7010 -_§ JM2APP 330
1 NoKix) 47
~BK2AVL 98
7015 N BK2AVL 341
0203 e75p67
7025 4—
T— 11MMR 56
7030 5
»
7035
7040
7045

-4

=

7050 {— VE3CGC 346

With an interfaced radio, you will find it useful to open a Bandmap window. Click Window, then
select Bandmap, and the Bandmap corresponding to your entry window will be displayed.

In the example at left, | have filled the bandmap with spots from a packet cluster, just to illustrate
how spots are displayed. The stuff in the top bar is pretty self-explanatory. The SH/DX button, when
mouse-clicked, sends that request to the cluster (which you don't know how to set up yet). The
button labeled Wide toggles filters in your radio, though you may have to set it up first (the process
is explained in the manual). In any case, clicking on it switches TO the filter mode shown. The red
RIT means that RIT is on, and the number left of it is the amount of offset. The black XIT means
that XIT is not selected. Turn on XIT and you'll see it turn red.
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7035 94 ‘I1MMR 56°

[7026.40 [N4ZH @ -635 min] - Mauro, pretty strong! I]

045 3

The color-coding of spots in the Bandmap is the same as in the Entry Window, so each of those red
calls represents a new multiplier in the contest. If you want, you can mouse over a spot, and the
program will tell you more about it. The A¢a,~A“635 min tells you how long ago the spot was
posted. Generally, you won't want to keep spots displayed that long, and a little later I'll explain
how to clear spots after a certain amount of time has elapsed.

In a busy contest, certain parts of the band can get pretty crowded with spots. Pressing the numeric
keypad + key will zoom the bandmap in and spread the spots out, like this:

7005
— WAL 151
T—EW/7L0 39°
—DSSUSH 341°
S JIM2APP 330
pi— OK1X) 47
7010 4

Pressing the numeric keypad - key will have the opposite effect. You can also zoom the bandmap
using the scroll wheel on your mouse, if it has one.

Another useful thing about the bandmap. If you single -click on a spot, your radio will automatically
be sent to that spot. If, instead, you click on the frequency scale (anywhere within the width of the
frequency hash marks), the radio will go to that frequency. There are also keyboard shortcuts that
will move your radio from spot to spot up and down the band. More on this later.
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™= 7008.92 CW FT-1000MP
File Edit View Tools Config Window Help
0K1XJ Snt Rey Zone

ll | ]

50 wipe |

| SpotIt| Buck |
F3TU | FaNgZR

| Edt | Mark |
c@ | F2Exch

Esc: Stop ]
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F7?

™ Running F5HisCall | FBExch

r3 Hpt
Eveha

29 4 | Fi0GRL

Bearing = 47°, 4300 mi, 6919 km, LP = 227°
OK - Czech Republic, Zone 28, EU 4/4

When you single-click on a spot, something else useful happens - A¢a, A" the call sign of that
station is copied to the Call-Frame of the Entry Window, like this. This is done this way so that if you
discover that the station on that frequency isn't OK1XJ after all, you can just type in the correct call.

This does happen now and then with packet spots.

However, let's assume it's OK. In that case, all you have to do is call the station, get him to answer
you, and hit Space. Here's what happens - the call sign is pulled down into the Call-sign field, and
the QSO is all set for logging, once you complete the exchange.

™= 7037.20 CW FT-1000MP

EJ‘:F

X

File Edit View Tools Config Window Help

0K1X3 St  RBev  Zone

0K1XJ 1599 (599 B

SO Wie ] Loglt | Edit ] Mark l Store j Spot It] Buck I
Esc:Stop | CQ F2 Exch F3TU F4 NAZR

™ Running F5HisCal  FBExch F7? F8 Agn

237 4]  F9RptExchg F10GAL F12

Bearing =47, 4300 mi, 6319 km, LP = 227*
0K - Czech Republic, Zone 15, EU 4/4/4 88

Another good thing can happen on the band-map when you complete a QSO and tune off the
frequency - the spot's color code turns to grey, so that you know at a glance that you have worked
the station already, and won't waste time when you come back to that frequency again.

2/2/2011 4:54 PM



30 of 680

http://nlmmtw61.semdxa.org/tiki-print_multi _pages.php?printstructures...

| DSBUSH 341°
S\ JM24PP 330°

1

7010

To turn on this feature, click Config, and then, in the dropdown menu, click on the two items
checked (see below). You need them both because grey spots are regarded as non-workable, and
they will disappear unless Show non-workable spots is checked. If you don't work a station, and
tune off his frequency, his call sign will appear in the appropriate color to denote whether he's a
new multiplier or simply a valid QSO; either way you know to go back and work him later, if he's still
there.

™ 7010.51 CW FT-1000MP

File Edit View Tools | Config Window Help

¢ Configure Ports, Telnet Address, Other
| [- Change Your Station Data
Change Sub Bands »

S0 wipe | | g Clear INI file settings
Find all windows (move to within 800 x 600)
Esc: Stop ] cQ

I~ Running FS5HisCal Enter sends messages (ESM mode) Ctrl+M
29 ﬂ 3 Hpe AutoSend Threshold
~—Evcha  gpot all S&P QSO's
v QSYing wipes the call & spots QSO in bandmap (S&P)
Bearing = 47°, 4300 v Show non-workable spots

Tumn off Dual Rx Reset Rx freq when running split
Dual Rx always on
CQ Repeat Alt+R
Set CQ repeat time Ctri+R
Call History Lookup
Record QSOs

Change CW /SSB/Digital Message Buttons »
Multi-User Mode

Edit Station Computer Names
Change Operator Ctrl+0

Change Exchange Abbreviations
SO2R

Testing

WAE

v v v w

By the way, even if you never plan to use packet spots, the Bandmap is a very useful window. As
you S&P your way up and down the band, each station you've worked will be marked with a grey
self-spot, so you can skip by them the next time even if you have no packet spots.
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You may be wondering how to move quickly up and down the bandmap, hitting only the workable
spots, or those that represent multipliers. This might be a good time to introduce another very
useful section of the Manual. N1MM Logger makes extensive use of "hot-keys" to largely or entirely
eliminate the use of the mouse during contest operations. There is a very useful section in the
manual titled "Key Assignments" which explains each and every such key combination. For
example, under "Active Radio/Bandmap Key Assignments" it lists:

Jump to Spots Note: If you are operating single mode, your mode won't change when jumping
between spots.

e Ctrl+Down Arrow - Get next spot higher in frequency.

o Ctrl+Up Arrow - Get next spot lower in frequency.

o Alt+Ctrl+Down Arrow - Get next spot higher in frequency that is a multiplier.
o Alt+Ctrl+Up Arrow - Get next spot lower in frequency that is a multiplier

Try these and see - with a full bandmap and these keystrokes, it is easy to work 100+ search and
pounce QSOs per hour, something that used to be regarded as impossible.

As we're finishing up this introduction to the Bandmap, it might be a good idea to offer another
general hint when you're exploring the program. Be sure to right-click on each new window (other
than the Entry Window), to see what options involving that window might be available to you. Each
of these options is explained in the section of the manual dealing with that window.

If you do this with the Bandmap, you'll see this right-click menu:
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Manual -

|

1

7010 <

7015 —

£~

—

N

EW7L0 39°

DS5USH 34

™\ JM24PP 330

BK2&VL 38°
BK28VL 341

Of the choices here, Packet Spot Timeout is perhaps the most useful. Click there and set the
timeout interval in minutes - A¢a,~A" both self-spots and spots from packet will disappear after
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Zoom In (Numeric Pad +)
Zoom Out (Numeric Pad -)

Go to Bottom of Band
Go to Top of Band

Packet Spot Timeout

Remove Packet Spots, Leave Self Spots
Remove all spots

Turn Rotor

Set transceiver offset frequency

Set transceiver timeout time

Set transceiver filter codes 3
Bring to foreground when made active
Reset Radios

Help

however many minutes you choose.

Packet Spot Timeout

Enter packet spot timeout in minutes 0K

X

_Cancel |

3a

The Reset Radios command is also useful in case, for some reason, you lose control of your radio.
Click it, and the program resets the connection.
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Again, if you go to the manual, you'll find much more exhaustive discussion of each menu option,
but that's enough for us right now.

So really, that's all you need to operate contests with N1MM Logger controlling your radio - the
Entry Window, the Check Window, the Log Window and the Bandmap. Of course, there are a zillion
more capabilities you'll want to explore, beginning with the capability for sending stored messages,
but | have to stop somewhere, at least for now.

Interfacing for Phone, CW and PTT

Of course, controlling your radio through a serial port isn't the only way to interface N1MM Logger
and your radio - in fact, long before there were computer-controllable radios, the pioneering logging
software authors developed several standards for CW and PTT interfacing, using either serial or
LPT (printer) ports.

I'm going to start, though, with a discussion of phone interfacing, on the theory that this will be of
most interest to new users. What | mean here is setting the program up so that you can store voice
messages and play them back through your radio, to save your voice during phone contests.

Phone Interfacing

There are two levels to this - the physical interface and the software setup. Physically, you will need
to connect your microphone to the Microphone In jack on your sound card, and provide an interface
between your sound card's Line Out jack and the microphone jack on your rig. This can be as
simple as a 10:1 voltage divider (the Line Out signal level is much higher than your radio's
microphone jack is designed for) and isolation transformers (to avoid feeding AC hum into the
sensitive microphone jack on either your sound card or your rig). You can also use any of the
commercial interfaces (RigBlasters, for example) designed for digital modes using AFSK.

Here's a simple schematic
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Now, on to the software setup, which is where most people seem to have trouble. The following

Sourd pard line out

discussion is cribbed almost verbatim from audio trouble-shooting notes by Dave Robbins, K1TTT. If
any mistakes have crept in, blame me, not him.

To begin with, make sure you close Windows Media Player, RealPlayer, Audacity, or any other
sound playback/recording program you may have open. Start N1MM Logger and open the

Configure|Ports, Other tab.

§= Configurer

[ Wink ey T Mode Carral T

Anternes T Andia 1

Hardwaie T Files T Furchion He_l.isT Crigital Medes T [Ither
Part Fradio Digital Packet CWPTT Detals—  © SO1Y © 502¢ & SO2R
Coml I—_ [ [ S __|
Coma |—_ i e Caf OTR=hlways DR T S=bhay:
Cond [FroooMP = [ Ser | | 4800NE2DTR=tlways
Comd | Kerwand - IF Bl | Sef 4800, M 8 2 DT R=always
Coms |—_ W T T Set || DTR=Always OnATS=FT1Ts=]
Conb: [ore ¥ T I set || DTR=Always DrRTS=PTTTu=2
Com? [lee o] 7 T ¢ _Set || DTR-hlways OrATS=Akvay
0 (TP ] rof N i
LFTY W Get || Fini7=Cw Pin16=PTT Tx=Rah
LPT2 [t EEany|
LPT3 [~ | ) (Esat|
Terne:Cluster
wilplnet i Edi

|_IfI_K_i Cancel Heh

34 of 680

2/2/2011 4:54 PM



35 of 680

Now select the Audio tab. As shown here, select option 1 "zero or single sound card" from the
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drop-down list. Select "default" in the first "select device" list:

§= Configurer

[ Hardwazre T

File

kel

T Mode: Cantral T

T Funciion Keys. T Chigital Hade:tjj [ther

arkennas

| Budic

|1 - Zero or Single Card, One Radao, Mo Sound Card S[:J
TeSound Card and BS0- Becardirg Sehip

Salect Device | Deladl

Select tnput Line |

Select Ling fo Mite J

Recordng Bits | 24

Recoding Sample B ate | 11025

EARSREN{ERIEY

Radio Input Port |

4

Mate: |tz best to choose the defaultcard forthe T Soudnd card, This s because the CE inout iz nok
uged for Tk and can beused normall), 1F vou doouse the defaul card for B try connecting ong.of the
radicinputs to an unuz ed npk like A

Ehooze the input ling connected o
wanr iz far Thoul Ling® and 'Line to
Fduate!

tan Recarding Lenoth [#2c2): 30

Recodingcharnek |2 =

nE.

| Cancel ] Heln

Now OK out to save that setting, and close N1TMM Logger.

Plug your microphone directly into the microphone jack on your sound card. Plug your headset

directly into its speaker output. Open the Windows Volume Control. It should come up with a set of

sliders, like this:

Bl Volume Control

Opficnz Help
Volume Contral Wavs SW Syt 0 Payer Microphione Line In
Ealannf_' ..................... Balance: Balance: Balance: | Balance: Halance:
o LS| e ST
Volume Welume: Volume: Valume: Volume: Walume:
13 = L} L} " L_H
|
|
|
] Mute i [ ] Bate [ Mite (1 Mste [IMte [ aste
Abiraniad
SoundMAR Digital Audo
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Set all the sliders to mid range, and un-mute everything. You may have to go into

http://nlmmtw61.semdxa.org/tiki-print multi _pages.php?printstructures...

Options|Properties to check the box to let you see the microphone volume control and those for

other sound sources.

In Options|Properties, now , click the 'Recording' radio button, and make sure the microphone is

checked on the list of controls:

Properties

Mo devize: 5o namax Digital Audio |
Adus volume fon

() Playback

Show the foliowing volums controls:

I CD Player
Microphane
Line In
[] Phone
[#] Mo Out
Wave Ot Moo

| | 5

| ok || Concd |

Now OK out. Make sure the Microphone slider is at mid-range and that there is a check in the
Select box. If you are using a typical ham microphone, such as a Heil, and you have the

"Advanced" button, click on it and select Mic Boost if that option is available, because it provides a

20 dB preamp.
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Bl Recording Control E] EiE|
Optiens  Help

CD Flayer Michophone Lire: In Mono Dt Wave Ot Mix

Balance: Balance: Balance: Balarce: Balance:

B0 9| ¥ I A i S

Yolume Nhume: Walume: Wolume: Wolume:

5= | ._j_l L5) L]
L)

[ Select [“lhekd: [ Select [J5eect [ Sslect

SEIIL.IT'Id'I"'IA"x' Chgilai Add;J___ - B - I

Now, when you talk in the microphone, you should be able to hear yourself in the headset. If you
can't, then something is wrong with your settings, hardware or drivers. Try playing existing .wav files
using the Windows Control Panel's Sounds option. Recheck volume and mute settings, check that
the microphone is plugged into the right jack, try a different microphone, try a different headset. Get
your 8 year old kid to help. DO NOT PASS THIS POINT UNTIL YOU CAN HEAR YOURSELF!

Now open Windows Sound Recorder, which is usually found in the Accessories category in your
program list. DO NOT open Audacity, any of the audio tools that came with your sound card, or
your other favorite tool. Some of them play with the mixer settings and we don't want that now that
they are set.

¥ Sound - Sound Recorder E]§|E|
File Edt Effectz Help

Position Length:
LRE R <o (00 =ec.

il

Click the Record button in Windows Sound Recorder, and speak a few words into the microphone.
You should see the green trace deflect in time with your voice. Now press Stop. Press the Play
button and you should hear what you just said. If you don't there is something wrong with your
hardware or drivers. Check recording control settings, adjust volume, make sure the microphone is
selected as the recording source, and get that 8 year old back to help again! DO NOT PASS THIS
POINT UNTIL YOU CAN RECORD AND PLAY. If Windows Sound Recorder doesn't work, then
N1MM likely won't work and since N1MM is much more complicated it is harder to troubleshoot.

Now close the Windows Sound Recorder and start NTMM Logger. Put your radio in SSB mode, and
make sure that the Entry Window's title bar specifies either USB or LSB (if you don't have a radio
connected, type the appropriate mode in the callsign box and hit Enter.
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Right-click on any of the message buttons in the entry window. That will bring up this table:

i Change SSB Buttons - 1st 12 are for Run, 2nd 12 ara for sap (K|

Edit

Buton Caption WA File -
F1 LG wayhog. way — | 2t
F2 Exch wiavheichange. way =l S5t
F3 Tharies! wansthanks way aot
F4 (MY CALLY waymycall way _aet
— |FEHisCAl Sat
FE 050 R4 wanh DS 0E way _set]
F7 ORZ? wahORZ wa 35t
F& Again wiavhalldgan, way et
[ELGE waysHLmber way et
Fin Set
|F1 et
Fi2 _aet]
Set
* St
1=

Todekete &row, click on the ffmozst column and press
the-deletz key [The * row iz rota red row.] Lk

The filenames in the table are the default filenames that are put into the table when you first install

MM. Depending on how long ago you first loaded MM, the ones above may not be the same ones
you see.

The easiest way to visualize this is that rows 1-12 represent the 12 function keys in "Run" mode,
while rows 13-24 represent the 12 function keys in S&P ("Search and Pounce") mode. We'll get into
why there are two sets of function key definitions in a little while. But for the moment, let's
concentrate on programming the Run F1 function key. If you click in the first box under Button
Caption, you'll notice that the "pencil" icon moves to that row, and that the cursor will be in the box.
Now you can edit the button caption to whatever you want it to be. Then hit Tab, and the cursor
moves to the .WAV File column. In the example above, I'm assuming that you have a \WAV
subdirectory in the N1MM program directory, and that you want to name your CQ file as | have.

One last thing - if your SSB function keys have something in the 13th row (S&P F1), temporarily
use the Edit function to delete that row, because it will just confuse things right now.

All right - now OK out, and the definition is saved.

© Notice -
Unless you have something in both boxes in each row, the cursor will not move on to the next
row. You'll note that it looks like F5 violates that rule, but it really doesn't, because there is a
single empty space in that row, which | put there to meet the requirement.

Now watch the bottom of the Entry Window and press Ctrl+Shift+F1. You should see:
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= 1431968 USE ET-1000MP

File Edt Vew Tools Confg Wirdow Help
C0-Frequency | sn_ Rev  Zohe
DO wips | o] Edi | Mark | S |Spotlt] Buck |

Fam Stop | FiCH FiBech | F3Thanksl | Fabithim |
¥ FRurning  FSHiCal | F5OS0B4 | FPORZT | Fodgan |

Fa NR? Fi0 F11 Ft2 ]
Beanng information appeas hers

Fieu:u:urding Stared: wavhoo wav 0/0u0 i}

If you speak into the microphone at this point, whatever you say will be recorded in the file CQ.WAV.
Press Ctrl+Shift+F1 again to stop the recording, and look for this report in the same place:

= 14319.68 USE FT-1000MP

File Edt View Took Corfic Wndow Help
CQ-Frequency sn Foy  Zone

[

DO ipe | oo Edit | Mak | S | Spotlt] Buck |

EscStop | FIC@ | F2Esch | FaTharkd | Fanim |

¥ Furring FEHisCal | FROSORS | FTORZ? | FAdgan |
ey | Fio | Ful | k|

Bearrg irfomasticn appears here

Recording zaved-in wavhog. may 04040 n

Now press F1. You should hear what you just recorded in the speaker. If you don't, look for an error
message in the status bar. The most common problem affecting playback is that you recorded the
file with a different program, using a compression or other parameters that are not supported by
N1MM Logger. Another common one is to be looking for a filename that is different than the one
that appears in the key definition table. For both these reasons, we suggest using the Ctrl+Shift+Fx
process to record within N1MM Logger, at least until you get truly comfortable with audio files.

Now that you've got things working, you need to program at least the first few function keys. It's
best to follow the order in the example above, at least for F1-F8, because a little later, when we talk
about ESM (Enter Sends Messages) mode, the order is important.

OK, so now you have everything you need to play "canned" audio messages on the air. If you're
content to use VOX to switch your transmitter, and you're not interested in CW, then you can jump
ahead at this point to Chapter 4 (Using Stored Messages). However, you may want to have N1TMM
Logger control your radio's push-to-talk (PTT function). One good reason might be to ease wear
and tear on the relay in your amplifier by having it switch on before your transceiver starts sending it
RF. For this we need a PTT interface.
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CW and PTT Interfacing
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First, let's set it up in N1IMM Logger. Begin by opening the Config menu to the Ports, other dialog:

el 14029 05+0.00 CW FT-1000MP

- Canflgure Ports; Telret Address, Other
|

]| | Change Your Station Data
Il Change Sub Bands

ﬁi WipE'i A I_E Clear INL file seltirgs

= Find all windows {move to within 800 % 500)
Esese | g :

[~ Rurting  F5 HiaCa Entersends messzges E5M mode)
2=  EpEe R

spot all 58P 0S50S
v D5fing wipas the call B.spots S0 in bandmap (58F)
Beanng irfomation:; ¥ Shaw nen-workable spots
This database i for HAZE  Fort R TEQ WEn fLining spit
Dual R alwavs on
v CQ Repeal
Set CO repeat tme
W Cal Hetory Lookup
Record QS0s

AlLHR

Change CWi /558 Digial Message Buttons
Multi4Jzer Mode

Edit Station Computer Names
Change Operator

Cirl4M

Ctri4R

Change Exrhange Abbrevistors
SR,

Tesi

WAE

2/2/2011 4:54 PM



http://nlmmtw61.semdxa.org/tiki-print multi _pages.php?printstructures...

§= Configurer

[ Wik ey T Made Carfral T Anternzs T Audio 1

Hardware T Flles T Funiction keyz T [igital Modes T Other gy
Part R adio Digital Packet CW/PTT Detals— & SO1Y T 502 502K
Coml | ] W =
Comz B _J
Coma [ [ _J
Crirrid [ i St A900, M8, 2 BT Rtz
Comb B O _...._J
ComB W e RE
Com? micw BT
Comb B W 4
LFT1 g at |
LFT2 y - _J
LFT3 m _J
Tehet Cluster _ '
| AB5E wl | Ed
ITI Caricel Hely

Your dialog will show COM ports 1-8 and LPT ports 1-3, regardless of which ports are actually (or
virtually) there. For this example, let's choose COM1 as our CW/PTT port. Put a check in the
CWI/PTT box and you'll notice that the Set button is no longer greyed. Click on it, and open the
dialog for that port.

n Comi

DTR [p 4 RT3 (pin 7] FAadioAFD Nr
Iﬂi.-uays On = _J'-';.ll:l.lal.l_:;"-_ O I [‘I _:J
[ Allow est irtemupts  FootSwitch [pinE) CWPTT Pot Add

I Winkey Mona _:J I3FE Help
[~ MEZF

Cugnested Seltings
| o 1200, 05 8. T AlEe an, Alwaps an, Hed Code
Waseur  A800, M8, 2, Alwaps on, AlwEps o
Kerwwcod: 4200, M, 2.2, Handshake, Handshake
TT Cricr: B7E00, M, 2,1, Handshale, Handshaka

Caricel

You can configure the DTR pin as either CW or PTT. Click the down arrow and you'll see the list of
possibilities:
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DR [pin 4| I
Az O ﬂ

Handzhake

Highlight the one you want, depending on your interface. Now do the same with the RTS pin:

ATS (pin 7]

Handzhake

You'll note that the choices are different. This is because commercial interfaces generally do not
use RTS for CW, while many default to RTS for PTT. If you are building your own . Just make sure
you plug the correct one into the key jack.

DTFR [pircd) RTS [pin 7] AadioAFD Nr
(O ] T - i =
PTT Delay [mesc|
]1‘7

[ &llowe ext inkemupts  FootSwitch [pin 6] CwWAPTT Potadd

I winkisi [Mare | e belp

[ MEZF

Cugnested Seftings
| o T200, M. 8.1 Alwaps on, Always on; Hew Code
Waesur  ABDDCH, S 2 Alwans an, Alwap: on
K.ermood: 4800, K. 2. 2. Handshale, Handshake
TT Criere: 5TE00, R, 2.1, Handshale, Handskake

Caneel

Set the Radio/VFO Nr to 1. The PTT Delay setting is to protect the relays in an amplifier by making
sure that the T/R relay is closed before the program starts sending CW. The default value of 30 Ms.
is fine even if you don't have an amplifier.

Unless you know that you have your COM1 at a non-standard memory address, assume that N1MM
knows best and accept the default address it suggests. If it is a USB virtual port, this setting doesn't
matter anyway.

OK, now to interface to the rig. The very simplest interface imaginable will work just fine for either
the CW or PTT functions with any modern radio; again, there are many commercial options, but
here's the Radio Shack parts solution:
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CW Messages

From the Tools menu, select Change CW/SSB/Digital Message Buttons, and then Change CW

Buttons.

EMERERE pr ey

1% Cnm

To cw or plt out
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To Radio or relay
(+ voltage only)

Serial port cw or pll interface

™= 14700.00 CW Manual - A

I
ﬁ.ﬂiu&i -.-_-ill E

Esc: Stoo |
I Bunhing .
[3 =

Fle Edit View Toos Corfig Window Hep

Corfigure Forts, Telmet Address, Other
Change Your Station Data

Chenge sub Bands

Clear IMI filz settings
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Enter cands messages {ESM mode)

AutoSend Thrashold

Spot &l S&PF C50's

015Ying wipes the call & spots 50 In bandmap (SEF)
Show non-workable spots

Reszt Rx freq when running split

Cua Rx always on

CO Repest Al
=et O repeat tine

Call History Lockup

Record QS0s

Change CW/SSBDigital Message Butiors

Multi-User Mode

Edit Station Computer Mames
Chenge Operator

Chenge Exchange Abbreviations
S0IR

Tesfing
WAE

Ctrl+HM

CiriHR

Cirl+0

v W v ¥

Change Tl Buttons

Change 558 Buttons
Change Cigital Buttons

Now this dialog appears:
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= Change CW Buttons - 1st 122.are for Run, ind 13 are for 5&l E|
Edit

Euton Caption ! Meszage

S

To dekete a o, click on the leftmost column and press
the defetz key, [The = row iz nat 3 rzal row.| Ok

Again, depending on when you downloaded N1MM Logger, your table may have various messages
already in it. No matter - just click on Edit and delete rows until you get all the way back to the
empty table above.

As you discovered with voice messages, the database table editor is a little quirky, so let's walk
through the process for F1. Click in the first box under "Button Caption", next to the cute little
drawing of a pencil. Type a caption, for example F1, and hit Tab. Instead of jumping to the next box,
the program highlights what you just entered, to give you a chance to change it. Hit Tab again and
the cursor finally moves to the first box under "CW Message". Now type a message that you want to
send frequently, such as a CQ, like this:
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#® Change CW Buttons - 1st 12 are for Run, Znd 12 are for &P [X|

Euton Caption Chf Mezzage

F|F CO TEST * * TEGT]

To delete a row, click on the leftmest ol and press
the deletz ey [The * row iz not a rzal o]

Ok

OK, what's that asterisk (*)? This is the first and one of the most useful Macros. It denotes your
callsign. There are two types of macros, text macros and action macros - text macros substitute a
string of text for the macro, while action macros perform some program action. Both are often used
in combination with regular text in a message, as shown here - when you press the function key or
click the on-screen F1 button, the program will send CQ TEST N4ZR N4ZR TEST (substituting my

call for the asterisk).

There's a table of the various sorts of Macros in the chapter by that name in the manual, but for
now let's go on. Hit [Tab} twice again, and this happens:

i Change CW Buttons - 1st 12.are for Run, Znd 12 are for 5&P [X|

Buton Caption Chf Meszage

Fi CO TEST **TEST

To dekete arow, click on the lefimest coumneand press
the delete key, [The * rowiz paka rzal row,]

Ok
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The "pencil" icon has moved to the second row, and your cursor is there. Conventionally, F2 is used

for your contest exchange, so let's fill one in:

i® Change CW Bittons - 15t 12.are for Run, Znd 134 are for S&¢ E|
Edit

Euton Captian ! Mezzage

F1 CO TEST *=TEST
£ |FZ Exch [GMM {E=CH]
* |

To delete a row, click of the lefimost column and press

the deletz key [The * row iz not'a-r2al row, | Ok

{EXCH} is a text macro that substitutes whatever you put in the Sent Exchange part of your contest
setup. Say, for example, we were setting up for a contest where the exchange is signal report, your
name and your state. When | set up the contest, | put PETE WV in the Sent Exchange. Now when |

press or click F2, the program will send 5NN PETE WV.

A couple of fine points - you might think of putting the 5NN in your sent exchange - after all,

everyone's 599, right? Well, don't, because it will screw up your Cabrillo log. Just resign yourself to
putting 5NN (or 599, if you insist) anywhere you want it sent. Also, most macros are in the form of
{WORDY}, where "word" is the macro. The curly brackets are necessary so that the program knows

it's time to substitute something or take some action.

Two messages will do for right now, so OK out, and get back to the Entry window.

g 14200.00 OW Manual - A
File Edit Niew Togs Confis Window Help
—5r Roy  Mame  Comment

| L I & ]

5@ wipe | | Edi | Mak | o | spotn] Buek |
EseSton | M1 | FaEuen | |
I Aunning | J |
Eles
/0 o
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From now on, if you want to change the content of any message buttons, there's a shortcut - just
right-click in the area of the buttons, and the table we just left will reappear.

OK - you've hooked up your interface, so now you're ready to send some canned CW. As | said
above, you can either hit the function key F1, or click on the F1 button. Either way, the program will
switch your radio from Receive to Transmit (assuming you have PTT connected - you can also use
VOX or break-in, of course) send the message, and then go back to Receive again.

There are two easy ways to adjust the speed of your CW - either click the up and down arrows next
to the CW speed box (where it says "30" in the picture above), or press [Page Up] or [Page Down],
to increase or decrease speed in 2 word per minute increments. If you hit the wrong key or button,
no problem - hit the [Esc] key to stop sending immediately.

If you want to send CW manually, the easiest way is to
I' parallel a keyer with the computer CW at the transceiver's key
jack. Alternatively, hit [Ctrl + K], and a CW window appears:

Type the CW you want, and hit Enter when you're done. As soon as you begin typing, the program
begins sending; you can type ahead, and the program will finish sending the CW before the
window closes.

Using Stored Messages in Contests

Now the real fun begins. You have interfaced your radio to the program, so MM knows what band
and mode you're using. You can send "canned" voice messages to your radio, as well as CW, and
you can control its PTT.

So now it's time to put all these bells and whistles to work. There are several ways to do this,
depending on how much you want to automate the process. The details are the same for either
phone or CW messages, so let's look at the possibilities.

First, let's reopen the voice message table, by right-clicking on the message buttons while in USB
or LSB.
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If you don't already have all of these messages, use the Ctrl+Shift+Fx process to record them, and

then OK out.

Now open the CW message table.

™ Change CW Buttons - 15t 12.are for Run, Ind 14 are for 5&F rg]

Edit
Euton Caption ! Meszage <
F1 CO TEST *=TEST

£ |FZ Exch SMM {EXCHY

#*

To deete a row. click on the [effmest colunin and press
the deletz key, [The * row iz nat 3 rzal row| Ok

You need to load CW messages corresponding to the phone list above For Function keys 1-8.
Here's what it should look like when you finish.
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i® Changa CW Buttons - 1st 12 are for Run, Z2nd 12... [
Edil

Bukon Eaption Chad Mesiaos -
FiCo COTEST * * test {CLEARRIT}
F2 Exch FHMIEACH]
FaTL T * {CLEARRIT}
Fd b CaLL}
_|FAHiLCal |
FE Rpk Excn sIERCHY
F7 2 ?
Fa Agn AGHN
E3 I

To deiete arow, click onthe Bftmcet coumtand press
the deletz key, [The * row iz mota real row,] Hk

There are 4 main ways you can use the stored messages, listed here in ascending order of speed
and convenience.

1. One key at a time - press a function key when you want to send the associated message. Use
the Space bar to move your cursor. When you have everything filled in, press Enter, and the QSO
will be logged. Done this way, a typical Run (CQ) QSO would look like this:

F1(CQ)

Station answers - copy call in callsign box

Say his callsign (phone) or press F5 to send it (CW)

Press F2 to send the exchange (either a stored voice message or CW)
Press <Space> to move the cursor to the exchange field

Type in the received exchange

Press F3 to send your acknowledgment

Press <Enter> to log the QSO

NGO RAWN =

2. Semi-CT Style - Enter the callsign of the station calling you. Press the Ins key to send his call
and your exchange (CW), or speak his call and then press Ins. Once you have copied his
exchange, press F3 (TU) and <Enter> to Log. If you are calling other stations (Search and Pounce,
or S&P), you would first press F4 to send your call, and when the station responds follow the
sequence as above.

3. Early NTMM style - Enter the callsign of the station calling you. Press the ; key to send his call
and your exchange. Copy his exchange and press the ' key (right next to it on US keyboards). The
program sends the F3 (TU) message and logs the QSO. In S&P, you would hit F4 first, then " ; ",
and then "' ".

This saves some keystrokes, but there's an easier way. A decade ago, N6TR developed the idea of
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making TR Log "modal." By that, he meant that the program would behave differently depending on

whether you were in Run or S&P mode. Making this distinction let him massively simplify and
shorten the sequence of keystrokes required to complete a QSO.

4. Enter Sends Messages - N1MM Logger has now evolved N6TR's invention into what is called

Enter Sends Messages, or ESM for short.

More on ESM (Enter Sends Messages)

The first step is to turn it on. Open the Config menu in the Entry Window, and select ESM

14070042 CW FT-1000MP
Fie Edit View Tools | Config Window Heb

] Configure Ports, Tanet Address, Other
| [ Chanrge Your Staton Data
Change Sub Bands

aﬁ. wipe | Lo £ Clear INI file setings

Find all windows fmove to within 200 x 600)
Essstop | FiCo

T O A v W Enier serids messaces (ESM mode)
12? j FiNR :utcEm? Thre::'lh:ld
1o pot all S&F Qs0's
o Q5¥ing wines the call & spots QS0 in banomap (S3F)
Beaing = 57,3518 ¥ Show mon-workable spots
Reset Fx freq when running split
Dial Ry aways on
COQ Repeak Ali+R
Set CQ repeat ime
 Call History Lockup
Record Q50s

L Ertar zands mezsagas ma

Change CW S58 Cugital Message Butions
Multi-Uszer Mods

Edt Siztion Computer Names
Change Cperator

Change Exchange Abbreviations
SOZR

Testng

WAE

Chl4M

Chl4R

Cirl+0

T v ¥ wr

Now close the menu and enter any call in the entry window. We're assuming that you are doing

S&P.
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= 14020.44 CW ET-1000MP

Fle Edt Mew Toos Corfig Window Help
Snk Hey:  Zone—

|FGAAA — 0
el ] "ipe J Lagh | Edit | Mank | Store |Sgat|t1 Buick, |

Fsc Stop | F1CH F25 | matu || FandzR
[ Funning FECall FEESOBY ! F%:7 Fa Ag_n
27 FINR |

Bearno =58, 3518 mi; 6661 km. LFP = 2357
F - Frarce, Zone 14, E1 444 (24

What's different? Take a look at the F4 button. The highlight means that if you press Enter at this
point, the F4 message will be sent (which is what you want - your call). Press <Enter>, your call is
sent, but the cursor remains in the callsign field, and F4 is still highlighted. If he doesn't answer the
first time, just press <Enter> again. If he answers you, hit <Space>, and look!

= T4020.44 CW FT-1000MP
File Edf Vew Toos Corfic Wnoow Help
~5nk Aey! Zone

[FGAAA 599 [599 [

%’. fipe 1 Liog [t | Edit | Maik J Store iSEDtltJ Bucle |

Far Stop | F1C0 FiEech | F3TU Fa MAZR
[ Funning FaZall FEESOEBY | FE? Fa Agn
PR [

41 = FINR |

Beaing =557 3518 mi. 5651 km, LP=235"
414 24

The cursor has moved to the Exchange box, and now F2 is highlighted. That means that the next
time you hit <Enter>, the program sends F2 and logs the QSO.

So instead of an 8 step process to work an S&P QSO, you have either 3 or 4:

1. Enter the callsign

2. Press <Enter>

3. (optional) If he doesn't answer, press <Enter> when it's time to call him again; if he does,
press <Space> and copy his exchange

4. Press <Enter> again to send your exchange to him and log the QSO.

But suppose you're Running (Calling CQ)? The first thing to do is tell the program. You do that by
checking the box next to the word "Running", either with your mouse or by hitting <Alt>+U. Now
your Entry Window looks a bit different:
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14020, 42 €W FT-1000MP

Ele Edt VMiew Toos Config Wndow Help
CO-Frequency  Snt Aoy Zone

ll |

bl ipe I ] Edit | Hailk ] St JSEatItJ Bl I

Esc: Stip | FiC F2Exch | F3TU | FaNgZR
W Furning  FSCal | FEQSOBY | Fi7 Fa Agn
[ FANR |

Bearrg =55 3518 mi; BBET km: LP = 2357
CEAN a0

Note the highlight is now on F1, because the first thing in most Run QSOs is a CQ. Press <Enter>
and the program will send F1.

Now someone answers. Type in his callsign and the window changes.

= 14020.47 CW FT-1000MP

File  Edt Mew Tooe Confio Whncow Help
CQ-Frequency | =0t Aoy Zones

|FSAAA | 1 1

i ipe # Lu:uull] Edit ] ﬂalk] E@EJSE]Htj Buck, |
EscSiop | Fice || FRExch | FaTu | Fangzm |
V Furing  FS5Cal | FEOSOBS | FT? | FBaon |
[ 4 FINA | | |

Bearng =55, 3618 mi, BB61 ke, LP = 2357
F - France, Zone 14.E0 54/ 130

You're starting to get the hang of this - the highlights mean that when you hit <Enter> the program

will send F5 followed by F2 (on CW - on phone you would speak the callsign and then press
<Enter> to send your exchange).

Once you have done that, the window changes again.
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|FSAAA 599 [599 [
DO wire | Logit| Edit | Mak | Sters | Spotit| Buck |
Fsc Stap | F1CH F2Euch | FATH | FLN4ZR
W Furring  F5Cal | FEESOES | Fi7 | Fam
[417 = FaNR |
Beaiing = 55°, 3518 ri, 5651 km; LP = 235°
S A

Now the highlights tell you that you have copied a legitimate exchange (in this case the program
has supplied it from the callsign, and that the next <Enter> will send your F3 message and log the
QSO.

So, type a callsign, hit <Enter> 3 times, and you've logged a QSO. Pretty slick!

Now suppose you're like me and you fat-finger copying the exchange, so that you have nonsense in
the Exchange box, like this. In that case, the program reminds you:

= 1402043 CW ET-T000MP
File Edt Mew Toos Corfig Window Help

CQ-Fregquency  Snt  Hey  Zope—
[F5AAA 1599 (599 |89
Ful ] "ipe J Lagh | .Edit | Mank | Store |Sgat|t1 Buick, |
Ese Ston | Ficm F2Eech | F3TU | F4N4ZR

¥ Furning  FSCal | FEOSOBS | FP7 | FBAge
[+ FaNR |

Beaing =557, 3518 mi, 5651 km: LF =235°
T 130

If you hit <Enter> with an incorrect exchange, the program will send the F8 message and request a
repeat. Alternatively, if you see your mistake and correct it, the screen changes again to show the
"F3 and Log It" highlights. Just press <Enter>, the program sends the F3 message, logs the QSO,
and you're done.

Once you've used ESM, | predict you'll never go back to the old way again.
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= Configurer
[ Wink.ey T Mode Cariral T Anbernzs T Audio 1
Hardyiare T Filez ther
it : Send leadinig 2erosih
bl onterua H Gipe det ¥ zefal umbers [eoa. TT7]
o =end Comecled Call o Stop Sendng C8 when
|Betare End of D50 kM:g) Z&llzign changed

ESM orly send: yowr call orice in 587,

[ Send paalcdls - then ready to copy received sxchange
. Ii Strira b uze on ow between
e ik O dpes iz call ey and exchangs key
o Dbttt Bt [detauk iz ohe zpacs]
S8 LR arag-aoacing 3 :
S o IZ'I.':-.-’ 186 Keycode of [ng Kay S obatitute
[~ Send Cut Mumbers [222 Kaucade of T /Log Key Substitute
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Contig!Chargs W buttan:, Conhig/Change 552 Bultons and Config/Charigs Digiks B attons

L3 Kep: Ernd of G50 Eey My Cal ke ~Apan ey q
'K = || ] ~| | |ra R ~|
Exchangs Koy His Call Ky 050 B4 ey Cut Humber Style

R s = (il 3 »| || (Dol x|

OE. | Caticel ] Heb

Two further refinements, and then this chapter is done. Open the Config menu again, and then
open the "Configure Ports, Telnet Address, Other" sub-menu. Click on the Function Keys tab:

In the left-hand column, note that | have checked "Send Corrected Call." This neat feature, in Run
mode, keeps track of whether you have changed the callsign in the callsign box. For example, say
you only copied "DL6A" at first, and filled in the rest later. Eventually, you copy DL6ABC, and when
you press <Enter> to send the F3 (TU message), on CW the program sends "DL6ABC TU ..." On
phone, you'll need to supply the correction.

In the right-hand column, the third checkbox is cumbersomely titled "ESM only sends your call once
in S&P, then ready to copy received exchange." In shorthand, we call this the "Big Gun switch." If
you nearly always get stations you call the first time, you can save a keystroke by having the cursor
advance automatically to the exchange box after the first time you call. If you often need to call
again, don't check it. If you have checked it, and need to call a station more than once, you just
press F4, regardless of where the cursor is.

<@ Caution -

Don't change the "key mappings" (below the red type) unless you absolutely know what you're
doing - it can make a horrible hash out of ESM.

N1MM Logger Manual
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7.3 Troubleshooting

Overview and Installation

Table of Contents:

1 Quick Tour

2 Overview

3 Features

4 PC Requirements

5 Installation

6 Setting up the Program
7 Basic Functions

8 Advanced Functions

9 Two Monitor Support

Idea & overall design: Tom Wagner N1MM
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Overall programming: Tom Wagner N1MM

Programming: Rick Ellison N2AMG

Terry Gerdes AB5K

Documentation/Help: Thomas Tinge PA1M

Testing and proposals: Members Yahoo groups Thanks!!!

Copyright 1998-2006, Tom Wagner (N1MM), Rick Ellison (N2AMG), Thomas Tinge (PA1M), Terry
Gerdes (AB5K)
CRC32 portion of this program Copyright (C) 2001 DI Management Services Pty Ltd.
DLPORTIO is copyright 1996, Scientific Software Tools, Inc.

Quick Tour (a must read!)

or

(and no, Tom wasn't drinking when he wrote this, many years ago. It's been updated to the current
state of the program, but the jokes are all his)

Ten Easy Steps to Successful Logging

Quick Tour (a must read!)
Step 1. Setup
Step 2. Adjust Window Positions
Step 3. Connect the Sound Card and the CW interface
Step 4. Entering a Call
Step 5. Using the Space Bar to Tab
Step 6. Using the Tab Key
Step 7. Bandmaps, Spots and Other Cool Stuff
Step 8. Spots are Fun
Step 9. Actually Logging Contacts
Step 10. The Exciting Finale
Step 11. CW and WAV Recordings
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[ Winkey T tode Control T Antennaz T Budio 1
Hardware Filez T Function Keys T Drigital Modes T Other
Pt Fadio Digital Packet Cw!/Other Details  © 501V & 502 O S02R
Com1 |E|e.:raft e | [ El & Set 38400,M.8.1, DTR=Always
Com2 [foe o] I W [ Get || 4800NB2DTR=Aluays
Com3 [Nane =] [ [ W  Get || DTR=CW.RTS=PTTTx=]
Comd Im I - W i] HandshakeT«=1

Com5 [Nore | [ [~ W  Set | DTR=Always OnRTS=Always
v e (Sl

Coarn? ﬁm [ | [ []] _J

Com@ [More = [ [ W Set | | DTR=Always OnRTS=Always
LPT1 [ _J

LPTZ [ _J

LFT3 [ _J
i~ Telnet Ijluster

PI4CC || _Edi|

ITI Cancel I Help

Get your radio, packet and telnet connections set up (Config > Configure Ports, Telnet address,
other). You really won't be impressed without the radio connected. The program really shines when

you have a spotting connection (packet or Telnet).

Step 2. Adjust Window Positions

Adjust the window positions as desired by opening every window separately from the 'Window'

menu.

Step 3. Connect the Sound Card and the CW interface

Connect your sound card to the radio so that you can play wave files or record contacts. Connect
your CW interface to the parallel, serial or USB port for CW keying. See the Interfacing section for

possibilities.

Step 4. Entering a Cal
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OK, now we are ready to log. By default, you should be in the DX (General) log - look at the Log
Window caption.

= 4/2/2010 12:48:287 General Logging - Test.mdb =13
15 [Call [ Fieqg [Mode[SHT [RCY [Prefix [Hame  [Comment -]
|

So you want to log a gso? Type in the callsign field of the Entry Window part or all of the call of the
station you want to log. Let's say you type 'N1M'. Notice that the Check window shows calls with N1
in it, later N1M.... This will happen with any call or partial call that is 2 or more characters long.

i= 21012.90+0.00 CW FT-1000MP VFO A Eo|X]

File Edit View Tools Config Window Help
Snt Aoy Mame Cormment

M BE

S wipe | Lu:uglt| Edit | Mark | Store |Sgutlt| Buck |

Esc:Stop | Cm F2 Exch F3 F4
[ Running F5 F& Fr¥ F&
30 = F3 F10 Fi1 F12 LONG

Bearing = 57°, 399 mi, 642 km, LP = 238"
K. - United States, Zone 5, M 040 1]

JNIMSO  NIMD NIMEO  NIMGO
NIMIW  NIMIJF  NIMM NIMQ
WN1M

Use the mouse and click on N1MM in the Check window. Notice that N1MM will be transferred to
the Entry Window callsign field. Hit

Space once. Defaults will be set for fields that can have defaults (in this case the RST fields) and
the cursor will be placed in the next field to be filled in — the name field.
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Step 5. Using the Space Bar to Tab

Ok, that's cool, lets try it another way. Click on the Wipe button to clear the Entry Window fields.
Your cursor will be positioned on the callsign field again. This time Type 'N1MM' and press
**SPACE**. Notice that the RST fields are again filled automatically and you are positioned to the
next field to be filled in. Enter "Tom' and press SPACE. In this case, you will not tab to the next field,
since space is a legitimate character in a name. This is atypical behavior. Most contest fields do not
allow any spaces in them, so the space bar will jump from field to field. You'll like this, dammit!
Really, I think you will like it - particularly in contests.

Step 6. Using the Tab Key

So if SPACE tabs, what does Tab do? It tabs as well! But it doesn't tab like space. The Tab
character (and Shift+Tab) behave like they do in most programs. They jump from field to field,
without trying to be smart. So if you need to change the RST, you'll use the Tab key to get there.

Step 7. Bandmaps, Spots and Other Cool Stuff

14062,76
0.00 RIT XIT Cw

14015 S73AG 1287
14020

14025 o
14050 106G 113
14035

14040

14045

14050

14055

14060 o
1405 45740 100
14070 SP40Z 92°
14075 [Z3GHL 1587
14080 ITIBLE/IHS 158°
14085 CQ-Frequency

14030 AME/GE00E B3 MEW
14035

14100

Ok now the really cool part. We need to get some spots onto the bandmaps. If you have set up a
radio, and you have selected SO2V in the Configurer, you should have two bandmaps, and they
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should be displaying the frequencies of your A and B VFOs at the top. So how do we get spots on
there? We need to connect to packet or Telnet, of course. If you have an Internet connection, try
Telnet, if a packet connection, well | guess you'll try packet. To pick, click on the appropriate tab in
the Packet/Telnet Window. To connect to packet, just type a command in the one-line text box at the
top, like "C KITTT" and press enter. Just do your usual stuff. Then type sh/dx/100 (we want a lot of
spots) if it's a weekend, otherwise just type sh/dx/30 (Why the difference? The logger won't show
old spots - the default is 60 minutes).

To use Telnet, you must choose a Telnet server. The easiest way to do this is to select the Telnet tab
in the Packet/Telnet Window, then choose one from the drop-down list. Type your call in the input
line at the top, or click the button with your call on it. Answer any questions the node asks you, and
then, if it's a weekend, type sh/dx/100 (we want a lot of spots), otherwise just type sh/dx/30. (Why
the difference? The logger won't show old spots - the default is 60 minutes.

Step 8. Spots are Fun

Spots should start appearing. Don't be afraid, there is no leopard. (Get it, spots?) Enough dumb
jokes. Anyway, that's what people always tell me. So, what can we do with the spots? Lots of stuff.
First note that each spot (except US and VE spots and spots from your own country) has its beam
heading next to it. (Well it has the beam heading from my house, too bad if it isn't the beam
heading from your house. If you really want to fix that, go to the station dialog in Config/Change
Your Station Data - you'll need to enter your latitude and longitude. If you don't know your latitude
and longitude, tough - this isn't geography class, kid.)

Are we ever going to get to the good stuff? Sigh. OK. You have spots in your bandmaps. Try
SINGLE clicking on one. Notice how the radio tunes to the frequency of the spot? Also notice that
the call appears in the frame around the callsign textbox in the Entry Window. Now press that
magic space bar again. The spot jumps into the call textbox! Let's try this another way. Click on the
Wipe button (or press Ctrl+W). Now tune the radio to a frequency within 300 Hz of another spot.
Notice that the call again appears in the frame, and again the space bar will enter the call into the
call textbox.

Ok, try Wiping again (either way). Now double click on a spot. Notice that again, you jump to the
frequency of the spot, but this time the call is entered in the callsign field and the default fields are
filled in, and you are ready to copy the next empty field (in this case name).

Wipe just one more time. Let's try jumping around the spots without using the mouse. Your cursor
should be in the callsign field. If it isn't put it there. Now press Ctrl+Up arrow or Ctrl+Down arrow.
You should jump from spot to spot on the same band. Pick one of the spots where you can hear the
station. Use the up and down arrow keys (no Citrl this time) to tune the station in. Each press of the
key will go jump 100 Hz on SSB and 20 Hz on CW (configurable). You're smiling, aren't you? There
is a lot more. Go look here for more keyboard tricks: Key Assignments and Key Assignments
Short List

Step 9. Actually Logging Contacts
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We need to shift attention to actually logging contacts. Enter a call in the call textbox, press Space
and then type a name, well any name except 'Arthur' in the name textbox. (I'm sorry, | really cannot
be responsible if you type Arthur.) You typed Arthur, and nothing happened, didn't you? Now you're
angry. Here's a quarter.... Ok. Back on task. You have enough to log a contact now. Press Enter,
and notice that the contact will appear in the Log Window.

Now the fun part. Enter the same callsign again and press Space. Looky, looky! The usual stuff
happens, but two more things happen as well. The first contact shows up in the lower part of the
Log Window, and the name from the first contact appears in the name field. If you were logging a
contest, like ARRL DX, the power would be filled in from the first contact. If the first contact was on
the same band as this contact, then the word "DUPE" in BIG RED LETTERS would appear. | was
going to put the word "Dope", but then | thought that no one would want to use the program.
Really, you should probably work the dope, | mean dupe, since you might not be in his log. It's
actually easier to just work him than explain "You're a dupe, dope!"

Ok, press Enter and log the dupe. You don't agree with me about logging dupes? Then
RIGHT-click on the Log Window entry for the dupe, and choose delete contact. No, I'm not going to
tell you what to do with the dialog box that pops up. | trust you. | feel like we are already friends.

Step 10. The Exciting Finale

Now for the exciting finale, if | called it the boring finale, you wouldn't read it now, would you? It is
kind of boring, but I really couldn't trust you to get this far, now could 1? This step is about all the
wonderful things you can change about this program. If | tried to explain them all, you wouldn't read
it, so here is just a little bit.

Look at the View menu in the Entry Window. Here you can look at your current log (or any past log
that you open) in a lot of different ways, including a really flexible Statistics function. The Tools
menu lets you rescore the contest, download various files from the Internet (like master.dta and .cty
files, for example), and a lot of other useful things. The Config menu lets you change all the
exciting Configuration options that we all know and love by now.

Step 11. CW and WAV Recordings

"Hey wait," you say, "You said there were 10 easy steps - what's this number 11 business?" There is
a very simple answer. | lied. | wanted to write only 10, but | forgot to tell you about the CW and SSB
buttons. They are preset at the factory (ok, at my house), to be very useful to only me. Try them
anyway. If you have a CW interface, the CW buttons will send pretty damn good CW, even when
you are doing other things like moving windows around. You had better appreciate this, because it
was very hard to code, and | am very proud of it.

The same buttons are used in SSB to send WAV files. While this seems much harder, it was
actually quite easy, but it's ok if you are impressed. | don't care, so long as you are impressed. You
don't need to hook up your radio to enjoy this wonderful feature, just hook some speakers to your
sound card and listen to my melodious voice call CQ as you click on the CQ button. In a real
contest, however, you'll want to hook up the output of the sound card to your microphone input
through a Radio Shack audio transformer and resistor setup. The high impedance side (with a 100k
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series resistor) goes to the microphone input, the low impedance side goes to the sound card
speaker out. Of course you'll need to adjust the levels using the software that comes with your
operating system or sound card. See the interface section for more info.

This thing will record QSOs as well, but I'll let you find that in the Manual.

| hope you have enjoyed this quick tour as much as | have enjoyed writing it. And for the second
time, no, | was not drinking when | wrote this.

1. NIMM Logger Discussion Groups

These groups discuss features, bugs, and ideas for the N1MM Free Contest Logger.

e General group: Messages dealing with general program issues (including CW and SSB
contest) will be posted to the General Group @

¢ Digital group: Messages dealing solely with digital mode issues (including digital contests) will
be posted to the Digital Group #

In general messages should not be cross-posted, either by users or by the development team. This
is important, both to get the benefit of the subdivision and to encourage users to subscribe to both.
Users are asked please to separate digital and general/non-digital issues into individual messages
and post them in the right places — on the receiving side, all e-mail software has tools to sort e-mail
into folders by origin, so nothing should get lost.

The development team will continue to track both forums and respond on the one that seems
appropriate.

So if your interest is primarily digital, for example, you may want to subscribe to the general group
in one of the digest formats available. If it is primarily non-digital, then you might do the same thing,
in reverse.

L Digital Operators

Digital operators are well advised to subscribe to the general Yahoo group and the digital Yahoo
group, even if not interested in CW or SSB, because general things about the program that
affect them (font changes in various windows, for example), are likely to be discussed there
rather than in both lists.

General program issues Digital program issues
(including CW and SSB contests) (including digital contests)
Post N1MMLogger@yahoogroups.com N1MMLogger-Digital@yahoogroups.com
message
Subscribe N1MMLogger- N1MMLogger-Digital-
subscribe@yahoogroups.com subscribe@yahoogroups.com
Unsubscribe |N1MMLogger- N1MMLogger-Digital-
unsubscribe@yahoogroups.com unsubscribe@yahoogroups.com
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N1MMLogger-Digital-
owner@yahoogroups.com

Everybody is allowed to read the messages from the support groups. To send messages you have
to join the group. Your first post must be approved by the moderator. This prevents spammers from
using the list. Over 3000 users have already joined.

N1MM Logger Features
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General

¢ All major and many minor HF Contests are supported

o Including General DX logging, DXpedition, DXSatellite and VHF DX.

SSB, CW and Digital support
Multi-user support

Rover support for QSO parties and other contests which support this.

VHF and up contesting

o Transverter support (SHF bands supported up to 10, 24, 47, 76, 142 and 241 GHz).

Dxpedition mode (Stay in Run or S&P)

Key features

e ESM- Enter Send Message Mode - just press the Enter key to make a gso.
Uses sound card for DVK but also DVK interface for WOXT and other DVK interfaces.

Automatic CW generation (LPT and via USB to serial converter).

Rotator control (Using N1MM Rotor, LP-Rotor or ARSWIN).

Grayline program
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¢ Two VFO support when using one radio, with one VFO per Bandmap.
e SO2R/S02V support including $5 SO2R supporting SO2R with just sound cards.
e Telnet and packet support - spots from both automatically update the bandmaps.
e Winkey support (Serial CW keyer by K1EL).
¢ Automatic beam heading and sunrise/sunset calculations.
e Contact recording to wav files. Right-click on log entry to play back.
o Record level indicator for recording QSOs.
e Spot all S&P calls locally (QSYing wipes the call and spots QSO in bandmap).

Digital support

¢ All major and most smaller RTTY and Digital contests

¢ AFSK and FSK with use of soundcards and terminal units (DXP-38, PK-232, Kam, etc.)

¢ Interfaces with MMTTY, MMVARI, and Fldigi

SO1V, SO2V and SO2R

Up to 4 parallel RX decoding windows using either MMTTY or a TU, all interacting with the

Entry Window

Multiplier/Dupe color coding of calls on the fly in any RX window

Ability to find calls in Master.dta file in long strings of text in the RX windows (e.g., in

ASDFGHJKLN1MMAS#$%WERT, N1MM would be highlighted)

e Multiple call Grab window that displays last 7 callsigns received in the RX window.

¢ Point and click capture of callsigns and exchanges to Entry Window

¢ Ability to complete entire QSO with mouse and never leave the RX window (With ESM turned
on)

e Up to 24 additional macro buttons

¢ Ability to stack incoming calls and work them off the stack by using a TU/Now macro

Windows

Entry Window, Log, ((Packet/Telnet)), Score Summary,Info, Available Mults and Qs and the
Digital Interfaces

Multiplier window.

Call check function , including N+1 matching

Dual graphical bandmaps click to tune radio to the spot selected. The bandmap can be
zoomed in or out depending on number of spots shown.

Available Window keeps track of needed spots and mults on each band for easy band-change
decisions. **Color-coded buttons indicate on which bands the current contact is needed.

e The program retains the size and position of windows as specified by the user.

e Click on packet spot in Packet/Telnet window, Bandmap or Available window to tune to that
frequency/mode.

Advanced features
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SOZ2R including Dueling CQ and selectable advanced SO2R modes

Serial number server for SO2R and multi-user modes - coordinates serial numbers between
radios.

S&P callsign stacking.

Multi user support with automatic resync on reconnect.

Rotator control

e Antenna mapping.

Radio support

e Radio interface to support radios from Kenwood, many Yaesu (for example: FT-1000,
FT-1000MP, FT-990, FT-920 and more), Icom, Tentec Orion and Elecraft.

Hardware Support

e LPT port functionality to control antenna switches, radio selection, and PTT (95/98/ME/NT
/2000/XP).
e Support for microHAM and OTRSP SO2R protocols.

Import/Export features

e Cabrillo export support.

e ADIF import/export support.

e Transaction log, which keeps all QSOs to facilitate recovery of log.
o Statistical reports.

Many more..

PC Requirements

Minimum Hardware Requirements

The logging program has been designed to work within the minimum configuration required by
various versions of Windows - each of which differs with regard to the minimum processor model,
CPU speed and RAM. You may encounter performance problems when running minimum
configurations and operating CW or RTTY modes, when receiving a high volume of cluster spots, or
when your PC is simultaneously running several other applications. It has not been and won't be a
priority to make N1MM Logger run on clunkers.
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The recommended minimum graphical resolution is 1024 by 768, with many hams running higher
resolutions and dual screens. Although N1MM Logger will operate at 800 by 600, you will be unable
to fit all of the windows on the screen.

Radio control, CW keying and PTT can be done through a free serial or parallel port, or through
Winkey (highly recommended). For PTT with MMTTY an extra serial port is needed.

USB-to-serial converters and USB interface devices are supported through virtual serial ports
provided by their associated driver software. SO2R "boxes" may be controlled through a hardware
LPT port under 32-bit operating systems; alternatively, the MicroHam USB SO2R Control Protocol
and the K1XM Open Two Radio Support Protocol are both supported, for use with devices that

accommodate them. USB-to-LPT converters cannot be used for either SO2R control or CW/PTT
functions.

For more information see the Interfacing section.

Supported Operating Systems

e Windows NT

¢ Windows 2000

¢ Windows XP

¢ Windows Vista 32/64
e Windows 7 32/64

Linux and other Operating Systems will not be supported.

Installing and Upgrading NTMM Logger
In this Section...

Installing and Upgrading N1TMM Logger
1. First-Time Installation Instructions
2. Using the Program the First Time
3. Subsequent Install Instructions / Upgrading to a New Program Version
4. Uninstalling the Program

1. First-Time Installation Instructions

© Not your first time?
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These instructions apply both for first-time users and for users who are jumping from one base
version to another. That is, if you previously installed Version 9.x.x (or earlier) and want now to
update to Version 10.x.x, then you need to go through this process with the Version 10 Base
Install before you install the latest and greatest. In particular, this is needed to update the files
used for recording and playback of .wav files.

© Installing under Vista or Windows 7

By design, version 10's default installation location is C:\N1MM Logger. If you are installing the
program under Windows Vista or Windows 7, and wish to place it in the Program Files directory,
you will need to take some special steps. This is because these operating systems do not
approve of writing to the Program Files directory, which is how N1MM Logger works. You have
three choices:

¢ Run the Base Install, the N1TMM Logger program itself and any subsequent upgrades the
first time as Administrator. If you have not set up individual user accounts on your computer
(if you do not have to log in as a particular user) then both operating systems default to
running as Administrator. If you have individual user accounts, then you will need to
right-click on the program icon, and select "Run as Administrator." After you have done this
once for each upgrade, it is not required in normal operation.

e Log in to Windows as Administrator whenever you install or run N1MM Logger. If your PC
has USER or OWNER Icons upon startup and NO ADMINISTRATOR Icon, you need to
enable the ADMINISTRATOR account in order to run the N1TMM Logger program.

e Open the command prompt with Administrative privileges by opening the Start Menu,
and typing cmd in the search box, and then press Ctrl+Shift+Enter or click the Start
orb, All Programs, Accessories, right-click Command Prompt and select Run as
administrator. Type the following in the command prompt and press Enter: net user
administrator /active:yes . Restart your computer and login as Administrator. Note: You
might want to set a password for the administrator's account for at least a little
protection.

¢ Disable the operating system feature that normally prevents writing to the program folder.
This is called User Access Control (UAC), and disabling it is not recommended.

L Installing on 64-bit systems
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If you are installing on a 64-bit computer, and you are planning to use the machine's LPT port
for CW or control functions, then you will need to replace the standard DLPortio driver with a
64-bit equivalent. The following explanation was provided by W4TV, and is reproduced here
intact except for very minor editorial changes. Thanks, Joe!

Making It Work ...
1) Download the binary distribution of InpOut32 here: &

2) DO NOT allow the N1MM base installer to install DIPortlO (it will by default, unless you
uncheck the box (see below). If DIPortlO has been installed, go into both Windows/System32
and Windows/SysWOW64 and delete any copy of DIPortlO.dll found there.

3) DO NOT use "InstallDriver.exe" from the "InpOutBinaries_1500.zip" package.

4) Extract only Win32\inpout32.dIl from the distribution package and copy it to your computer's
Windows\SysWOW®64 directory. Rename it as DIPortlO.dll

5) Reboot after copying the DLL to Windows\SysWOW®64 (may not be necessary)

Download the Base Install here. Run the Base Installer

im N1MM logger 10.0.0 Full Installer Setup g@@

Welcome to the N1TMM logger 10.0.0
Full Installer Setup Wizard

This wizard will guide you through the installation of N1MM
logger 10.0.0 Full Installer,

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Mext to continue,

uext:b | [ Cancel

L Full = Base
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Wherever you see the terms Base Install or Base Installer and Full Install or Full Installer
anywhere in this manual, they are referring to the same things. With Version 10.0.0, for the first
time the Base Install will not run by itself, but rather must be immediately updated to a later
incremenetal version (such as 10.2.5, for example). For that reason some felt it was no longer

correct to call it a "Full" Install. That led to the term being changed in some places but not yet in
others. Please bear with us!

Next, you will be asked to agree to a straightforward, freeware license.

i® N1MM logger 10.0.0 Full Installer Setup

User Information / Dizclaimer =
Please read this information if you are installing M 1MM logager for the first time, EI
Press Page Down to see the rest of the information
T
Jhl!-!-l Free Contest Logger b
The N1MM Logger is & freeware progrem designed to do contest
logging and some general logging. It is not a general
logging progrem with award tracking etc. but is mainly &
contest logging program.

Idea & overall design: Tom Wagner 1M
Crrerall programming: Tom Wagner N1MHM
Programming: Rick Ellison NZAME W

When you have read this information, did: the ‘Mext’ button below.

This information can be found as ‘ReadMe.rtf located in the program directory.

[ < Badk ” Mext = l [ Cancel J

Next, you will be given a choice of files to install, which looks like this.
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i® N1MM logger 10.0.0 Full Installer Setup

Choose Components

L=
Choose which features of M1MM logger 10.0.0 Full Installer you want to install, EI

Check the components you want to install and unchedk the components you don't want to
install, Click Mext to continue.

Select components to install: -Inggm I Descriptian
Grayline program i T
Desktop Shortouts
QuickLaunch Shortcut
DLPORTIO port driver

Space required: 25, 5MB

[ < Back ” Mext = l[ Cancel J

Unless you have a good reason not to, just go ahead and leave everything checked. If you plan to
use parallel port(s) for CW, PTT, or SO2R control, and you are running a 32-bit operating system,
be sure to install the DLPORTIO port driver. If you are running a 64-bit computer, refer back to the
note above and don't install DLPORTIO

In the next screen, note that the default location for installation of the program is C:\N1MM Logger.
This is new, and was done in order to work around operating system restrictions that caused
problems for users with Vista or Windows 7. If you have previously installed NTMM Logger, for
instance in C:\Program Files, the default location will not be used; instead, the last previous
program directory will appear here.
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i®m N1MM logger 10.0.0 Full Installer Setup

Choose Install Location =
Choose the folder in which to install M 1MM logger 10.0.0 Full Installer, EI

Setup will install M1MM logger 10.0.0 Full Installer in the following folder, Toinstall in a
different folder, dick Browse and select another folder, Clidk Install to start the installation,

Destination Folder

'(E-‘l}ﬂlMM Lugge-r-'l.. | Browse... |

Space required: 25, 5MB
Space available: 2,3GB

[ < Back ” Inztall l [ Cancel J

When you click Install, the Full Installer will

¢ Install all needed files on your computer to run N1MM logger
e Update your system files where needed

You will find that certain parts of the Full Installer installation routine take quite a long time. The

installation program has not failed, so just let it run to completion. Subsequent updates are orders
of magnitude faster.

Microsoft Visual C++ 2005 Redistributable

T T T T T ] Cancel

¥ Do Not Overwrite Newer System Files

When running the Full Installer your computer may report that certain system files are already
installed on your system and are newer than the ones you are trying to install. It asks if you
want to replace a newer, existing file with an older file in the Full Installer. Select 'No'. You do
not want to overwrite newer system files.

72 of 680 2/2/2011 4:54 PM



http://nlmmtw61.semdxa.org/tiki-print_multi _pages.php?printstructures...

After the installation process is complete, if you have opted to install DLPORTIO, you will be invited
to install it as a separate process. just follow the on-screen instructions.

The first time you try to run the Full Install version of the program, you will be prompted to update to
the latest version.

[ Where is the program installed? O

For version 9 and before, the default installation location was in C:\Program Files\N1MM Logger.
Because this caused inconvenience for users of Vista and Windows 7, beginning with Version
10, the default location is C:\N1MM Logger.

If you are making a first-time installation of the Version 10 Base Install, the installer will
automatically choose this location. Thereafter, the update installer should point to the same
place. However, some experienced users have chosen to continue to install to Program Files,
and a few of them have reported that the update installer insists on pointing to C:\ regardless.
As you can imagine, putting the Base Install in one place and updates in another can cause all
sorts of problems. It's worth a double-check.

= "\ )

= N1MM Logger Base Install |._||E||5|

Show Download Pag

Click the button at the bottom of the window to go to the web page, and download the latest version
you find there. Run the version installer, and follow its simple steps to get fully up to date. Each
update will take literally 2 minutes to install.

If you are installing N1MM Logger on a computer that does not have internet access, you will need
to download the latest version from a computer that has internet access. This procedure is
described in the section "Subsequent Install Instructions / Upgrading to a New Program Version".
After downloading the latest version, copy and install it on the non-internet computer.
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2. Using the Program the First Time

¢ The first thing to do after starting the program is setting up the station information
o This can be done in the 'Change Your Station data' dialog
o The first time the program starts automatically with this dialog
o This dialog can also be found under >Config >Change Your Station Data
o After that configure the radio and packet and/or telnet connection
o Choose >Config >Configure ports, Telnet Address, Other
e The packet buttons and main window function buttons can be changed
o See the Config menu
o Alt+H is help
e Space is the preferred Tab character (see Help)
e Read the Quick Start Guide
e Read the Manual, particularly the following key sections.
o Quick Tour
Setting up the Program
Entry Window
Key Assignments
Basic Functions
Key Assignments Short List
= This one should be printed and placed near the radio

(¢}

O O O O

3. Subsequent Install Instructions / Upgrading to a New Program Version

An e-mail will be send out periodically to announce new versions (updates) of the program to the
Yahoo reflector members.

L File Naming Conventions

The Base Install for each year is named: NTMM-Fullinstaller.exe. The update files will be
named: NTMM-newexe with a suffix that denotes the date. The annual release of the Full
Installer will be given this name and replace the previous one.

¢ Download only the N1MM-newexeVx.x.xxx upgrade file (Example: N1MM-newexeV9.12.0.exe
is the first update of December 2009). Use the link contained in the announcement e-mail to
the Yahoo group, or open this web page i and select the update you want
o This file contains the latest .exes and other necessary files
o Run this file and let it copy all the program files into the N1MM Logger program
directory, replacing any old versions.
o When a new cty.dat file is added to the program directory, import it by selecting >Tools
>|lmport country list from downloaded file
o The version number Vx.x.x is also shown in the description of the file
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o Only the most recent update file is necessary, not all updates in between...

Ld Update philosophy

Many of us are used to always being "one version behind" in our software use, in order to avoid
bugs that may have been introduced in the latest version. But because N1MM Logger is
updated so frequently (typically, at least 50 updates per year), the opposite is true. You are
always encouraged to use the latest version — in general, bug reports and feature requests
should always be made after checking to make sure the latest version does not already include
the bug fix or feature that you want.

4. Uninstalling the Program

If you are thinking of uninstalling and reinstalling the program in order to fix a problem you have
encountered, you should know that this is rarely the solution. Try looking at the Troubleshooting
section before you do that.

However ... if you want to uninstall N1TMM Logger entirely, including any registry entries, the best
way is to navigate to the program directory and find the program cleverly titled UninstalINTMM.exe.
Run the uninstaller and follow any prompts you see.

Setting up the Program
In this Section...

Setting up the Program
1. Setup Station Information
2. Setup Radio Control
3. Setup Packet/Telnet
4. Setup PTT-ing the Rig/Sending CW
5. Setup WAV Files (SSB)
6. Sending Messages in CW
7. Setup 'Sent Exchange'
8. Setup the Exchanges
9. Setup Function Keys for Enter Sends Message (ESM) mode
10. Command Line Parameters

When you want to use the program you need to know how to connect the radio(s), packet or Telnet
etc. to the program. Also the Exchanges need to be set up for the contest. Below some information
how this could be done. In addition to reading this chapter also read Basic Functions, the Key
Assignments and the Quick Tour for basic program information.

© The Configurer
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You will read the term The Configurer throughout this document. What is this beast? The
Configurer is the uber-configuration dialog reached by selecting >Config >Configure Ports,
Telnet Address, Other

1. Setup Station Information

The Configurer information in >Change Your Station Data is self-explanatory. Make sure that you
enter your call as the station call sign. Many of the fields in this dialog are used in creating contest
entries, so do update them with their correct values. Like calculating beam headings, distances,
sending a bug report via e-mail etc.

2. Setup Radio Control

The program really shines when a radio is connected so that is what we have to do.

e Check if the radio is supported by the program in the Supported Radios chapter.
e So it is supported
o It is connected right (cable from radio to a serial port from the computer)
= Sometimes a serial interface is needed, see the manual of the radio and the
Interfacing chapter
o Go to the Configurer and fill in the information under the >Hardware tab
o Select the serial port the radio is connected to and choose the radio behind it
o Select the 'Set' button and choose the right setting. (baudrate, databits etc)
= These can be found in the manual of the radio
= There is also some information in the Supported Radios chapter
o Press OK, select VFO A and the frequency from the radio should appear in bandmap A

3. Setup Packet/Telnet

We need spots to fill the bandmap so the next thing to do is connect to a DX cluster. This can be
done under Configurer >Hardware for telnet and packet. For Telnet an Internet connection is
required. The Telnet cluster can also be selected under Configurer >Hardware.

¢ Go to Configurer >Hardware
e Select at the bottom a Telnet Cluster. AB5K is the default cluster and should work fine
¢ Close the Configurer, and open >Window >Packet/Telnet >Telnet in the Packet Window
o Cluster commands can be given here, the information from the cluster is shown in the
window
o See the Packet window for commands, info etc
o Connecting to a Telnet cluster is usually done by sending your callsign
o When everything works fine, spots should appear in the bandmap

76 of 680 2/2/2011 4:54 PM



http://nlmmtw61.semdxa.org/tiki-print multi _pages.php?printstructures...

The hardware tab in the configurer is also the place to select the right parameters for setting up a
packet TNC.

e The TNC should be connected to a serial port from the computer
o The TNC could be checked with Hyperterminal to see if it responds fine
Go to Configurer >Hardware
Select the serial port the TNC is connected to and select the < Packet > box
Press the < Set > button and choose the right settings (baudrate, databits etc) for this serial
port
Close the Configurer, and open >Window >Packet/Telnet >Telnet in the Packet Window
o Cluster and TNC commands can be given here, the information from TNC and cluster is
shown in the window
o See the Packet window for commands, info, how to connect a cluster using a TNC with
TAPR/TF or WA8BDED software etc
o When everything works fine, spots should appear in the bandmap

4. Setup PTT-ing the Rig/Sending CW

Sending CW and PTT-ing the radio can be done three different ways.

¢ Using the Parallel port
o Add an interface to the parallel port, this can be a simple one transistor circuit (for each
pin one) but also a bought interface. More on this in the Interfacing chapter. Pin 16 is
used for PTT and pin 17 for CW. These are fixed values and cannot be changed
o Go to Configurer >Hardware
= Select behind the LPT port to use the "CW/Other" selection box.
= Select the 'Set' button and choose the right settings (CW-speed, PTT-delay and
the CW/Other port address).
= The CW/Other Port Address should be the same as used in you Windows
configuration.
= Select the correct Radio/VFO setting (1, 2 or Both)
» Press < OK >
o PTT and CW should work now.
e Using the Serial port
o Add an interface to the serial port, this can be a simple one transistor circuit (for each pin
one) but also a bought interface . More on this in the interfacing chapter. Mostly the RTS
is used for PTT and DTR for CW
o Go to the Configurer and select the hardware tab.
= Select behind the serial port to use the "CW/Other" selection box.
= Select the 'Set' button and choose the right settings (CW-speed, PTT-delay and
the CW/Other port address).
= Select the pin to use to PTT and CW.
= The CW/Other Port Address should be the same as used in you Windows
configuration.
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= Select the correct Radio/VFO setting (1, 2 or Both)
= When Winkey is used also select this setting. The baudrate etc. for Winkey is fixed
and set by the program.
= Press < OK >
o PTT and CW should work now
¢ Using a USB port
o PTT via a USB port can not be done direct, a USB-to-serial converter is needed
o Not every Serial-to-USB can change the status of the RTS (and DTR) pins . So check
before you buy
o When this device is setup in Windows select the serial port used by it
o Follow the steps for a serial port to set up for PTT-ing

5. Setup WAV Files (SSB)

The sound (wav) files which have to be made have some standard texts, some are contest
dependent. There are two kind of sound files used by the program.

o Files used by the function keys
¢ Sound files used to send the callsign or numbers (in number contests)
o by sending single sound files for each letter and number
o Or by sending the full callsign or numbers when found in the wav directory

6. Sending Messages in CW

You need to do two things:

e Set the message properly in >Config >Change Packet/CW/SSB/Digital Message Buttons
>Change CW Buttons. The first 12 rows are the run messages for F1 - F12. The second 12
rows are the S&P messages for F1 - F12. If you have less than 9 messages, the S&P
messages will just repeat the Run messages
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. Change CW Buttons ; x|
Button Caption Chf Meszage =
IR CO g hestTde ™
F2 5NN {EXCH} << <Gnn >3 ERCH) e
FaTU + call TU de*
F4 MY CALLY *
F5 Hiz Call I
FE QS0 B4 LSO Bdde~
F7 % ?
FaTU TU
F1 MY CALL *
F2 5NN {EXCH} << <Grns > EXCH)
¥ -
Ok

¢ Make sure that the Configurer >Function Keys has each button set to its correct meaning. For
example, if F1 is your CQ key as set in the messages (#1 above), then make sure that the
"CQ Key" box is set to F1

™ Configurer

[ Wik ey T tode Control T Antennaz T Audio ]

Hardware T Filez T """""" T Drigital Modes T [thier

w3 kanitar via PC Speaker
[ inI3MME only)

7 Send Carrected Call 3 StDp_Sending CO when
[Eefore End of Q50 Mag] Callzigh changed

[ Send leading zeros in senal numbers

ESHk only zends vour call once in S&F,

W' Send partial calls then ready to copy received exchange

: Ii String to uze on cw bebween
¥ sk Duposiaiien Filueing hiz zall key and exchange key
e Cotesr st B [default iz ohe zpace]
ze Contest "Word Spacing
v far Chw 186 Keycode of Ins Key Substitute
I~ Send Cut Murmbers 222 K.epcode of TU/Log Fey Substitute

bd ake zure that the kew mappings defined below match the contents of the keyz as defined in
Canfig/Change Oy buttans, Config/Change SSB Buttans and Config/Change Digital Buttons,

CO Key End of GBS0 Kep— My Call Key “Again Fey Mext Call Key
|F-I ﬂ |F3 ﬂ 1F4 :J JFB _TJ |Disabledﬂ
Exchange Key — - His Call Key @50 B4 Key Cut Murber Style [if enabled)

[F2 ~| || [rs ] | |[re | || | 71234567890 (leading T) |

(] 4 I Cancel I Help

To send the serial number in any message, put the character # as part of the CW message in CW
buttons above. There is a list of other characters which can be used to substitute. The macros and
some examples can be found on the Macros page
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7. Setup 'Sent Exchange'

What you put in the >File >Open Log in Database >Contest tab "Sent Exchange" field of the
contest setup is what goes in the cabrillo log. It is also what will be sent if you use the {EXCH}
macro (don't). For the sent exchange, simply program F2 by typing in exactly what you want sent
(For example, 5NN 4 or whatever your zone is for CQWW CW) on the F-key setup window.

8. Setup the Exchanges

By Jamie, WW3S

¢ I'm assuming you want to set up for a RTTY contest.
e Go to the Configurer >Function Keys
o If you plan to use Enter Sends Message swap F5 and F3
= 'End of Qso Key' to F5
= 'His call' to F3
o Now go to >Config >Change Packet/CW/SSB/Digital Message Buttons >Change CW
Buttons
= The buttons/messages are displayed in order starting with F1
= Change the F4 key to read &WW3S in the one column and WW3S in the other.
The & just tells the button what caption to display
o Now change the F2 to read 599-599 and your CQ zone.
o Mine reads 599-599 PA PA 05 05 BK.

Starting to make sense? Whatever you change here is what will be sent.

o If you use Enter Sends Message (ESM) the corresponding F-key also needs to be set in
Configurer >Function Keys tab
o These keys need to match or ESM will not work!
e Set your F3 key for however you want your "End of gqso' to be sent
o Mine reads TU QRZ DE WW3S WW3S TEST
e F1 reads CQ CQWW TEST DE WW3S WW3S TEST.

These all get changed in change digital buttons. BTW, the same logic applies in CW contests
9. Setup Function Keys for Enter Sends Message (ESM) mode

Below is an example of a possible ESM setup from Jose, CT1AOZ.

Setup the Function Keys in Configurer >Function Keys tab

Default Function Keys
F1/CQ key F5 His Call Key F9
F2 Exchange key F6 QSO B4 Key F10

2/2/2011 4:54 PM



81 of 680

F3 End of QSO Key F7

F4 My Call Key

F8 Again Key

http://nlmmtw61.semdxa.org/tiki-print multi _pages.php?printstructures...

Enable all check box options except Monitor via PC speaker (but you may if you want to. NB only

when using Windows 95, 98 or ME).

Now set the macros in >Config >Change Packet/CW/SSB/Digital Message Buttons >Change CW
Buttons. The same settings are used for the SSB and the RTTY buttons.

Button
Caption

F1CQ
F2 Exch
F3TU

F4 My

F5 His

F6 QSOB4
F7 His/TU
F8 Again
F9

F10

F11

F12

Running mode
CW message / .WAV file /Text to

Send
caQcQ*

<<< ENN >>>#

TU*

*

I QSOB4 TU * QRZ

' TU

' AGN PSE *

Button
Caption

F1 QSY
F2 Exch
F3

F4

F5 His
F6 QSOB4
F7 Corr
F8 Again
F9

F10

F11

F12

S&P mode

CW message / .WAV file /Text to
Send

PSE QSY QRL *
<<< ENN >>>#
TU *

My *

!

I QSOB4 DE *

' TU

' AGN PSE *

Jose writes: Try this and I'm sure you will be happy with the performance of the program and the

Enter Sends Message mode...

10. Command Line Parameters

The program has a command line parameter to select the used 'N1MM logger.ini' file.
Example: "C:\Program Files\N1MM Logger\N1MM Logger.exe" SO2R.ini

Basic Functions

In this Section...

Basic Functions
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. Help
. Going Through the Entry Window Fields
. Resizing Windows
. Select New Contest
. Delete Contest
. Select Country file
. Select Master.dta file
. Changing Frequency
9. Changing Band
10. Changing Mode
11. Changing Operator
12. Setting CW Speed
13. Split Operation
13.1. Setting Spit Frequencies Manually
13.2. Setting Split Frequencies Automatically by Packet Spots
13.3. Resetting to non-split mode
13.4. Split Operation Key Assignments
14. Running Mode
15. Search and Pounce Mode (S&P)
15.1. How to check if you are in Running mode or in S&P mode?
16. CQ Key
17. Set up the Sent exchange message(s)
18. Function Key Conventions
19. Set Up N1MM to Record and Playback Voice Recordings (recording on the fly)
19.1. Playing WAV Files
19.2. Recording WAV Files
19.3. Soundcard Control in Configurer
20. Quick Edit
21. Meaning of Colors
22. Multipliers and QSOs
23. Connecting to a Telnet Cluster
24. How to Save the Log
25. Function Key Macros
26. Save and Restore Window Positions
27. Editing Lookup Tables
28. Backup and Restore
28.1. Method 1: Full backup/restore on same computer - backup and restore
the whole N1MM logger subdirectory
28.2. Method 2: Partial backup/restore on same computer - make a partial
backup and restore.
28.3. Installing on a Different Computer
29. Basic Functions for RTTY

00N O, WN -

When using the program there are some standard routines like changing frequency, band and
mode. Next to reading this chapter also read the Key Assignments, Setting up the Program,
Entry Window and the Quick Tour to have basic program information. There are also some
features which will be explained in this chapter like 'Running' mode, Search and Pounce' mode and
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'Enter Sends message' mode etc. Operating tips and tricks can be found in the Tips and Tricks
chapter.

1. Help

Almost every window has a Help function. To get to the help, right click on a window and select
'Help', or click on the Help button. The Entry window help can be accessed from the Help menu at
the top, or by pressing Alt+H. Also note that the Key Assignments help can be accessed directly
from the Help menu on the Entry Window. Note that you can print any help topic from the help
system by clicking the Print button. Most of the help files displayed will be for window in which you
select the help. This makes it easier to find the topic you are interested in.

Searching through the Help can be done most easily using the Find function using the PDF version
of the Help file.

There is a very useful facility on the Help menu if your computer is connected to the Internet called
'Searching Help using Google', you can search the latest version of the manual on the website
using Google. This will give by far the quickest results and will include the most recent changes to
the Help/Manual.

2. Going Through the Entry Window Fields

Space is preferred, rather than the Tab key, for advancing through fields in the Entry window.
Space avoids fields (like RST) that don't normally need to be changed and prefills other fields.
Spacebar operation is described in detail in the Key Assignments portion of the help. Using the
Tab and Shift+Tab keys moves the cursor to rarely used fields.

3. Resizing Windows

Logger's windows can be located where ever the user chooses and most can be made any size.
The Bandmap has a minimum width. The new dimensions and positions of the windows are stored
when the program is closed. Closing the Entry window will close the application. All QSOs are
saved permanently to the hard drive as they are logged.

4. Select New Contest

To select a new contest go to the Contest selection dialog ( >File >Open Log in Database ). On the
upper left of the screen a contest can be selected by clicking on it. Fill in the details for your specific
situation. Which contests are supported can be found in the chapter Supported Contests. Check
the website for the latest rules and check the contest setup information in chapter Contest Setup
Instructions.

The preferred procedure is to start with a new database for each major contest where you expect
very large logs or you're running on very slow PCs.

5. Delete Contest
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Go to the Contest selection dialog ( >File >Open Log in Database ) and highlight the contest in the
Contest pane. Then press < Delete >.

6. Select Country file

Selecting a new country file requires not only downloading a country file to your PC but also
importing it into the current database. If a new database is selected you may have to import the
latest country file in the new selected database again! The country file is stored per each database.

¢ Download the latest country file under >Tools >Download latest country file (wl_cty.dat)
(Internet)
o Choose the file named wl_cty.dat because it has extra country info
¢ Import this country file by selecting >Tools >Import country list from downloaded file
o Until you perform the import, the new country file is not being used by N1MM

7. Select Master.dta file

Selecting a new master.dta file with many regular contest callsigns requires that you download the
new file to your PC. No importing is needed but you have to select which master.dta file wil be used
for each contest.

e Download a master.dta file for the selected contest under >Tools >Download Latest Check
Partial file (Master.DTA) (Internet)
o N1MM Logger supports the CT-format master.dta file
e Select which master.dta file to use under >File >Open Log in Database >Associated Files tab
o Press the < Change > button beside 'Master.DTA filename' to select the appropriate file

8. Changing Frequency

Changing frequency can be done in many ways. Here is a short list with some alternatives

e Just turn the dial or change band on your radio, the program will follow if connected

e Enter a frequency in the Entry window < Callsign > field. For example, 14200,5 will jump to
14.200,5 MHz. The mode will be changed when needed following the bandmap rules
(depending on the Configurer >Mode Control >Settings tab)

e Enter an offset in the Entry window < Callsign > field. For example, if current frequency =
14200 Enter +3, frequency will jump to 14.203 MHz

e Enter an offset from the beginning of the MHz in the Entry window < Callsign > field. For
Example: Current frequency = 14200 Enter 123 and the frequency will jump to 14.123 MHz

o Placing a/ in front of the frequency or offset will set the second VFO (B). For example,
/12200,5 /+3 /123
¢ Click on a spot in one of the bandmap windows

2/2/2011 4:54 PM



http://nlmmtw61.semdxa.org/tiki-print multi _pages.php?printstructures...

¢ Click on a spot in the Packet/Telnet window

In the Log window, right click and select 'Jump to this frequency' to go to the logged QRG

Click on one of the callsigns in the last multipliers below the 'Available Mult's and Qs' window

Push one of the buttons in the 'Available Mult's and Qs' window to change band

Enter an offset in the Entry window < Callsign > field to go 'split'. See the Split Operation

section of this chapter

¢ Use one of the many keys below to change frequency, band or vfo/radio. Go look in the Key
Assignments section to read what they all do!

Ctrl+Alt+Down Arrow | Ctrl+Shift+Page Down Ctrl+Down Ctrl+Alt+Q | Ctrl+Left |AIt+Q

Arrow
Ctrl+Alt+Up Arrow Ctrl+Shift+Page Up Ctrl+Page Up Page Up | Ctrl+Right Alt+F8
Ctrl+Shift+Up Arrow | Ctrl+Shift+Down Arrow  Ctrl+Page Page Dn |Alt+F10 | Alt+F11
Down
Ctrl+Shift+Alt+Up Ctrl+Shift+Alt+Down Ctrl+Up Arrow | Shift+Alt+Q Alt+F11 | Up
Arrow Arrow Arrow

¢ Need any more?

When no radio is attached and PgUp/PgDn is pressed nothing will happen. l.e. if the frequency is
inaccurate, don't allow the operator to move out of band by inadvertently pressing PgUp/PgDn.

When a frequency is chosen outside an amateur band a warning dialog will be shown when trying
to enter information. This could happen making a typo when entering the frequency or when no
radio is connected, so a kind of "radio is not working" message.

eror

@ The frequency 20000, 10 is out of band. The radio may not be connected.

9. Changing Band

Below some of the possibilities how to change band.

e Change the band on your radio, the program will follow if connected

e Ctrl+PgUp - Go up one band. WARC bands are being skipped while logging for a contest

e Ctrl+PgDn - Go down one band. WARC bands are being skipped when logging a contest

¢ Enter a frequency in the Entry window 'callsign’ field on another band. FOr example: 14200,5
will jump to 14.200,5 MHz

e Push one of the band buttons in the 'Available Mult's and Qs' window to change band

¢ Click on one of the callsigns in the last multipliers below the 'Available Mult's and Qs' window
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on another band
¢ Click on a spot in the Packet/Telnet window on another band

10. Changing Mode

e Change the mode on your radio, the program will follow if connected

e Change the mode in the top part of the Bandmaps windows by clicking on the mode 'field’

e Change the mode by typing CW, LSB, USB, RTTY, AM, FM, PSK or SSTV in the 'Entry

window' callsign field
o When a radio is connected it could become a problem to enter PSK, RTTY or SSTV

because most transceivers do not have these modes as a selectable mode on the radio.
Mostly LSB should be chosen on the radio. To have the program log the right mode you
have to go to >Config >Config Ports, Telnet Address, Other >Mode Control tab. Under
'Mode recorded in log' check 'Always:' and also select PSK31 (for example). See also
note below

© Setting Mode Control
How the mode will be controlled on the radio and how contacts will be logged needs to be set in
Configurer >Mode Control

11. Changing Operator

e Ctrl+0O changes the callsign of the operator. If you are multi-user, you will be prompted for the
operator at startup. The default is the callsign in the station information dialog. A callsign is
required to be entered

e Entering "OPON" in the callsign field will also prompt for an operator callsign

12. Setting CW Speed
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= 3507.97 CW IC-
File Edit Yiew Tc
@ wipe | Log It

Ezc: Stop |

Elnning

Setting CW speed can be done using the Entry window speed control (only shown when CW is
selected) for each radio or VFO. Use PgUP and PgDn or click on the arrows beside the speed box
to change CW speed.

13. Split Operation

Split operation is when you transmit on another frequency then you receive. This is being used
when stations have huge pileups like some DXpedition's or the bandplan does not allow people
making contact on the same frequency. An example is 40 meter SSB between Europe and the USA.
In Europe the highest SSB frequency is 7.1 MHz while US stations may not go that low in
frequency.

Split operation can be recognized in the bandmaps and in the Entry window. In the bandmaps the
big blue marker will indicate your receive frequency. A red marker will indicate your transmit
frequency. The frequency set will become the transmit frequency! Normally only one frequency is
shown in the top portion of the bandmap, when working split the transmit frequency is added and
shown just below the receive frequency. In the Entry window in big gray letters Split will be shown.

The entered split frequency is validated if it is within band limits before setting the VFO. If not a
message is shown in the Entry Window statusbar and the split will not be set.

Cliicking on the receive frequency in the top part of the bandmap will toggle split operation.
©@ split in Running Mode

When you are working split and you are in 'Running' mode moving around will not change
'Running' mode into 'Search and Pounce' mode

13.1. Setting Spit Frequencies Manually

Set in the Split dialog with Alt+F7 or type directly into the Callsign textbox in the Entry Window
entering it with Ctrl+Enter. Decimal points and commas are allowed in split frequencies in the
callsign pane. Which one to use depends on the selected preferences in Windows. The split
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frequency has to be entered or an offset from the current frequency for the active radio/vfo.

Enter Split Frequency or

Enter offset from band bottom (the full MHz) or

Enter offset from current frequency as +5, +4, 3, 6, -2, -5 etc.
For examples

[+]

13.2. Setting Split Frequencies Automatically by Packet Spots

When a station is selected in the bandmap it can happen that the program puts the radio into split
automatically. This station has been entered on the packet cluster including a split offset frequency
which will be used by the program.

13.3. Resetting to non-split mode

Resetting to non-split mode is done by moving to another frequency or band. There are many ways
to do this an some are mentioned below.

¢ Click on a spot/frequency in the Bandmap

Click on a spot in the Packet/Telnet window

Click on a band button in the Available Mult's & Q's

Press Ctrl+PgUp or Ctrl+PgDn

¢ Click on the transmit frequency in the top part of the bandmap just below the receive
frequency

¢ Click on the receive frequency in the top part of the bandmap

13.4. Split Operation Key Assignments

2 Split with lcom Radios
Icom radios can't report VFO B without being set to VFO B. The program polls VFO A, but not
VFO B. You can only set VFO B from the computer. To set split, press Alt+F7 and enter +3 or
215 or 7215. You can also enter those from the call textbox by pressing Ctrl+Enter. Only turn
Split on/off from the keyboard/program and not on the radio so it stays in sync with the
program.

AlIt+F7 - Set split frequency or offset from current frequency for the active radio. When hitting Enter
or click OK with nothing on the line split will be cleared. Press ESC or click Cancel to exit.
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Alt+S - When your rig is in the split mode, Alt+S will reset the receive frequency back to your
transmit frequency, but the split mode is preserved. Application: Many operators will run a pileup
with the rig in split mode. With a radio which has VFO A/B they use the 2nd VFO as an RIT. This is
done since many RIT knobs are small or hard to get at, while some find it more natural to use the
main VFO to tune in a caller rather than use the RIT. By running split, you can use the main knob
to tune in the caller, while your TX frequency doesn't change. The Alt+S acts like an
AfA¢A¢a€SA-A.. a€eRIT clearAfA¢A¢a€SA-A A when you are running split. Operates on VFO-A
only! With a Main/Sub radios like the lcom 756/7800 series you can not RX on SUB without
receiving on both VFOAfA¢A¢a€sSA-A¢a€zA¢s. In this case put RX on Main and TX on SUB for
Alt+S to work.

AfA¢A¢a€sA-A.. a€ceReset RX freq when running split" is an associated feature to the Alt+S
function (found in the CONFIG menu). When invoked, the program will automatically do an Alt+S
as you log each QSO. This gives you an automated AfA¢A¢a€SA-A.. . 4€eRIT
clearAfA¢A¢a€sA-AA after every QSO when you are running split. The exact logging sequence
when you hit the Enter key is: move RX frequency to TX frequency, log QSO, and then send the TU
message. For additional background, see the Alt+S feature

Ctrl+S - When not in split mode it will first put the radio in split mode after that Ctrl+S will toggle the
RX frequency between the split RX frequency and the RX/TX frequency while maintaining split
mode. Application: This was designed primarily to help SSB operators run on 40 or 80m, where split
operation is widely used. For example, "CQ CQ de N1MM listening on this frequency (7183) and
7068". Use the Ctrl+S key to toggle between 7183 and 7068 to check for both USA or DX callers.

Ctrl+Alt+S - Toggle Split mode on the radio. 'Split' will be shown in the Entry window.

Ctrl+Enter - Entering a frequency or offset in the callsign field and entered with Ctrl+Enter will set a
split frequency.

Toggle split operation - Click on the receive frequency in the top part of the bandmap and it will
toggle split operation.

When in split please check out the @ macro (which will voice the receive frequency).

& A Split Example

Don't click on spots in the packet window. Click on spots in the bandmap or available window.
Then look at the bandmap or the Entrywindow title bar to see if you are going to transmit
out-of-band. | presume we are talking about 40 or 80 meters. If you SINGLE-click on a spot, and
don't see split indication, then wait for the station to announce their frequency. If they say
"listening 214.5" type 214.5 in the callsign and press control enter. You are ready to call them.
Good typists can do this and call them by the time they finish their CQ.

14. Running Mode

Running mode means that you are calling CQ and stations are coming back to you. The frequency
you are on is 'fixed' and you are not searching for stations. The program marks this frequency with
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the text CQ-frequency in the Bandmap window and the 'Running' indicator is marked on the 'Entry
Window'. A part of this feature is that 'Running' mode has it's own set of Function keys. They will be
automatically placed under the keys F1 to F12. There is also a set of function keys for Search and
Pounce' mode, these function keys will swap to Shift+F1 until Shift+F12 so they are still available.

The "Running" switch is automatically marked when:

e The operator clicks on CQ-frequency in the Bandmap window

e The frequency of the radio is in tuning range of your CQ-frequency (on that band)

¢ Pressing Shift+Function key when in Search and Pounce mode (this can be changed on the
Function Keys tab from the Configurer dialog

e CQ-key (as set in Configurer) is pressed

When leaving the 'Running’ frequency the indicator on the 'Entry Window' will be unmarked and the
Function keys will be swapped for F1 to F12 in the 'Search and Pounce' keys.

When moving away from the 'Running' frequency the program will place you automatically in
Search and Pounce mode. Going back to the 'Running' frequency will automatically select
'Running' mode (the 'Running' indicator is selected again). Clicking on 'CQ-frequency' in the
bandmap will also place the program in 'Running' mode. An exception is when working split i.e.
transmit on one VFO and receive on the other. Moving around will not change 'Running' mode into
Search and Pounce mode.

There is only one CQ-Frequency per band. If swapping VFOs, it is possible to swap between
'Running' and Search & Pounce mode.
Often used keys in Running mode (CW)

¢ Insert or ; - Sends His Call key followed by the Exchange key
¢ ' - Sends TU message and enter in log
e F4 - Sends my call

15. Search and Pounce Mode (S&P)

'Search and Pounce' mode (S&P) is the opposite of 'Running' mode. The program is always in one
or in the other. S&P mode means searching for stations on the bands and not calling CQ. The
frequency used is not 'fixed'. The 'Running' indicator is not marked on the 'Entry Window'. The
function keys under F1 until F12 are the keys programmed for Search and Pounce' mode, the
'Running' mode function keys are swapped to Shift+F1 until Shift+F12 so they are still available.

© Function Keys Change for Run vs S&P
If "Running" is checked, the Run messages are shown on the Function Keys. Otherwise, the
Search and Pounce messages are shown on the Function Keys.

When pressing Shift, the labels will change (when made different) and the text from the "Running"
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keys become the text from the "Search & Pounce" keys and vice versa. SHIFT REVERSES THE
MEANING OF THE ABOVE RULE.

When in Search and Pounce mode, to call CQ, the CQ-key as configured is used, usually F1. No
need to press Shift+F1. Pressing F1 will send CQ and place the program in Run mode. From that
point on F1 will call CQ (in Running mode). If you want to sent CQ without shifting to Run mode,
use the S&P CQ macro to stay in S&P mode.

When entering a call in the S&P mode and the call is a dupe, changing frequency (QSY)) will
automatically enter the dupe callsign into the band map and clear the Entry Window..

L Tip

When a frequency is busy it can be marked with Mark (Alt+M). This could be used when the
station on that frequency is not in the contest, may not be worked in the contest or seldom says
his callsign to have the frequency marked in the bandmap. Press Alt+M, and move on. That
frequency is busy, so you won't want to stop there again.

15.1. How to check if you are in Running mode or in S&P mode?

* Running checkbox checked/unchecked.

* Textboxes are white in running, yellow in S&P and blue in quickedit.

* The green ball shows "Ru" for running, "SP" for S&P.

* You can put different labels on the textboxes for Running & S&P.

* "CQ-Frequency" will show on the callframe if you are Running.

* "CQ-Frequency" appears next to the frequency arrow on the bandmap when going into Running
mode.

Another possibilitiy is to is give F1 Running and F1 S&P a more meaningful name. So in the F1 title
put the caption "F1 - RUN", and in the F1 for S&P (F13..) put the caption "F1 - S/P". This way the
first macro location will tell which set of macros are enabled. Because F1 is always the CQ key
(when defined) there is no need for CQ in the title to make that clear.

16. CQ Key

The program uses the CQ Key as defined in Configurer >Function Key tab. This means that when
F1 is pushed it will send a CQ as defined in the CQ-key (most often F1). This happens both when
in Run and in S&P mode. N.B. So when pressing F1 in S&P mode would give CQ and change to
Run mode. When using F1 in S&P mode to call a station (so the content of the S&P F1 key holds
your own callsign) and you want to stay in S&P then use the {S&P} macro to not change to Run
mode and stay in S&P mode.

* In cases where users desire more than one CQ F-key, include the new {CQ} macro which
identifies the F-key as an additional CQ F-key
* Use the {S&P} macro to stay in S&P mode
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17. Set up the Sent exchange message(s)

Every contest has it's own specific exchange. The sent exchange could be fixed (CQWW - zone), a
serial number (001 etc.) a combination and sometimes very exotic.

What to set up in the 'Sent exchange' can be found in the manual in the chapter Setup Contests.
Sometimes some creativity is needed to get it all working and more than one solution is often
possible. For some contest a special sent exchange macro has been added (like TIME2 for some
digital contests).

Below an example how to set up a serial number exchange followed by a fixed exchange (in the
same exchange). Example 599 023 40 (serial number 023 and zone 40).

There's more than one way to do this. In your exchange message (usually F2), you can use 599
{EXCH}, which will send what you have entered into the "Sent exchange" box (001 will be converted
into a serial number and the rest will be sent literally), OR you can instead program F2 to include
the individual elements of the exchange, e.g. 599 # # 04 (e.qg. if you wanted to send the serial
number twice and the zone only once).

Some things to watch for:

1. The {EXCH} macro does not include the 599, so you need to program that into your exchange
message(s). The "Sent exchange" box is used to generate the Cabrillo file regardless of whether
you use the {EXCH} macro. Therefore you can't put the 599 in the "Sent exchange" box because
that will screw up your Cabrillo file. In stead of hard coding 599 in the exchange message(s) also
the macro {SENTRST} or {SENTRSTCUT} could be used.

2. If you like to send a slightly different message when S&Ping than when you are running, then
you will need to program the Run F2 (2nd message in the list) and the S&P F2 (14th message in
the list) with separate messages. For example, you might program the Run F2 with: {TX} 599 # # 04
{RX} and the S&P F2 with: {TX{ENTER} ! TU 599 # # # 04 {RX}

Note that in Run mode, the exchange is actually sent as F5 and F2 in succession; F5 normally
contains the other station's call sign (!) and F2 normally contains just the exchange. In S&P mode,
the exchange is sent only as F2, so if you want your S&P exchange to include the other station's
call sign (some people do, some don't) you have to include a! in the S&P message.

3. If you want to always send three-digit serial numbers, go to >Config >Configure Port, Telnet
Address, Other >Function Keys and check the box "Send leading zeros in serial numbers (e.g.
TT7)"

18. Function Key Conventions

There is a function key "convention" used by N1MM logger and most other logging programs. That
is: F1=CQ, F2=exchange, F3=TU/QSL/QRZ, F4=your call and F5=his call. ESM is built around this
convention.

If you are already using ESM on CW it probably is wise to stay with the same keystroke pattern
when you are on SSB. For example:
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ESM mode: S&P - CW or SSB ESM mode: Run - CW or SSB
1. <enter> sends F4, your call 1. <enter> sends F1, "CQ"

2. <enter> sends F2, your exchange and logs | 2. type call, <enter> sends F5(his
the QSO call)+F2(exchange)

*NOTE™* - for SSB, put a single blank space in the F5 message - speak the callsign instead -
because of the blank, N1TMM will skip F5 and send the F2 message

3. type his exchange, <enter> sends F3 3. type his exchange, <enter> sends F3
(QSL/QRZ/TU) and logs QSO (QSL/QRZ/TU) and logs QSO

"...This whole business of hitting F1 automatically (and unwantedly) putting you in Run mode
seems extremely awkward..." - When you understand that F1 is almost universally the "CQ" key in
contest logging programs, it becomes very logical. And by definition, when you are "CQing" you are
"Running". In other words, if you don't want to be in the "Run" mode, don't call "CQ" (don't hit F1!)
"...is it possible to have DIFFERENT macros in CW? There | do need "agn" and "hiscall" whereas in
phone | don't..."

Macros are MODE-specific, not CONTEST-specific. So, yes, you must have different macros on CW
and SSB. However, just because you might use 8 or 9 F-keys on CW doesn't mean you have to use
8 or 9 on SSB. Use only what you need for that particular mode (and contest).

73, Ted W4NZ

19. Set Up N1MM to Record and Playback Voice Recordings (recording on the fly)

The usual way is to route your microphone through the sound card to the radio. Most sound cards
support this, as well as a selectable 20 dB pre-amp for Heil and similar mikes.
To set up the program to record and playback voice recordings do the step below:

Plug your microphone into the sound card mic input

Plug your headset into the sound card speaker output

Select default devices on the Configurer Audio setup Tab

Open the windows volume control on the playback controls, set mic audio so you can hear

yourself talking through the sound card.

5. Change the windows volume control to select the recording controls.

1. Select the microphone as the recording source.

6. In NTMM logger make sure you are set for SSB, and in Run mode, and have a file name in the
F1 key definition

7. Do Ctrl+Shift+F1, immediately say something, like a short CQ, then immediately do
Ctrl+Shift+F1 again. The bottom status line of the entry window should have said 'recording
started' then 'recording saved'

8. Press F1 and the recording should play back in your headset

9. Adjust audio level on the volume control so when you record it has the same volume as the

mic audio when you aren't recording

Pobd=
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OK, now you are on your own. the program records and plays back through the sound card. Now
you have to figure out how to get that audio to and from your radio via your rigblaster, some other
adapter, and whatever plugs on your radio that you choose to use. but the program is set up and
working at this point.

19.1. Playing WAV Files

The program can play wav files in SSB for giving CQ, sending default reports etc. For this to work
wav files have to be made with the text to send. These wav files could be placed anywere on your
disk but easy would be to use the waw\ directory under the program directory. To call a wav file edit
the SSB function keys as in the examples below. It is also possible to send a callsign by sending
it's letters and numbers. NB. The full file path is needed before the wav file.

Use the SSB function keys to send wav files. For example:

e Play CQ: C:\Program Files\N1MM logger\wav\cg.wav
Play default exchange: C:\Program Files\N1MM logger\wav\5905.wav
Play the callsign entered in the callsign entry field will be send by the soundcard: !
o This example uses the macro: ! (Send his call)
Play the serial number to sent from Entry window by the soundcard: #
Don't play call from station in callsign field: Use a single space (mostly used in F5)
Possible are strings like: ##!C:\Program Files\N1MM logger\wav\{operatorj\thanks.wav
o With or without leading zeros specified
o Only one wav file can be played per string and only at the end of the string

Some examples using the macro {OPERATORY}, let each operator have his own wav files. You can
specify wav files like: wawwOPERATOR}\cqg.wav As you change operators in a multi operator
contest, the wav files will change as well. You will have to name them consistently. Note that wav
directory syntax indicates a subdirectory under the Install directory. You can also fully qualify, like:
"C:\wavfiles\cq.wav". {OPERATORY} is a string substitution only implemented for SSB buttons.

¢ Play CQ with operators voice: C:\Program Files\N1MM logger\waw{OPERATOR}\cq.wav

¢ Play call with operators voice: {OPERATOR}\! (The wave file should be put it in the directory
set in the Files tab for the letters directory in the Configurer)

¢ Play default exchange with operators voice: C:\Program Files\N1MM logger\wav\{OPERATOR}
\5905.wav

It is possible to play more .wav files right after the other by separating the wav files with a comma.
For example: C:\Program Files\N1MM logger\wav\{operator}\blank.wav,C:\Program Files\N1MM
logger\wav\{operatorj\number.wav#

More examples can be found in the Macros chapter under {OPERATOR} macro examples and in
the Sweepstakes contest setup.

For those with problems with wav files playing from the Function keys... Make sure that under the
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tab 'Contest' in the >File >Open Log in Database >Mode Category has been set to SSB (or Mixed)
and not set to CW. Check out the Audio tab in the Configurer.
When in split please check out the @ macro (which will voice the receive frequency).

19.2. Recording WAV Files

The first thing to try is to plug the microphone (mic) directly into the sound card. Then open the
sound playback control panel, make sure the mic channel is displayed and see if you can get the
mic to come out the speakers. Once you do that then plug the mic into the rigblaster and the
rigblaster into the mic input on the sound card and make sure it still comes out. Then go from the
sound card to the rigblaster and make sure you can hear it in the speakers connected to the
rigblaster, then go from the rigblaster to the mic on the radio. That all verifies the audio paths. Note
that none of this uses the logger yet.

Now change the volume control to show the recording controls. Make sure the mic input is
displayed and select it as the recording source. Open the windows 'sound recorder'. Yes, | know it
is a dumb program, but its main advantage is that it is simple. Try to record using the sound
recorder and then play it back, the trace should show if audio is getting into the recording.

Now you are ready to try the logger. Watch the status line on the bottom of the entry window when
pressing Ctrl+Shift+Fx, make sure it says that recording is started and then that the file is saved.
Pressing the same keys again (Ctrl+Shift+Fx) to stop recording. Note the confirmation start/saved
messages on the status line at the bottom of the Call Entry window.

If the above steps verified the audio paths then the only thing left is to make sure the PTT keys the
radio when you send the file. Note, that you can key manually or turn on the VOX just to make sure
that the audio is getting to the rig even if the PTT doesn't work.

N1MM logger only supports standard PCM format files. Some editors use ADPCM instead and you
have to convert them to standard PCM to have them played.
More info on recording in the chapter Before the contest.

L Use NTMM Logger to Record Your WAV Files

Record with N1MM logger because it will put the file in the same place it expects to play them
from, and it records only with the formats that it can also play back.

© Realtek HD Soundcards

If the soundcard is a Realtek HD, you won't be able to do on-the-fly recording with NTMM
Logger. You'll need to use an external application, such as Windows Sound Recorder or
Audacity.

19.3. Soundcard Control in Configurer
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The soundcard has to be set up when playing wav files. This is done in >Config >Configure Port,
Telnet Address, Other >Audio tab. Check out the settings for it in the Configurer chapter.

IJ Common Soundcard Problems

The most common problem occurs when no sound is heard when playing wav files. Check for a
non existing wav file and the correct path in the program. Always check the wav file in a media
player so see if it can be heard from the speakers!

When play SSB wav files, the play volume can be adjusted by the Windows play control sliders.

20. Quick Edit

Do you ever log a contact with a mistake in the callsign? Want to bring it back, so you can change
it? You can do it with "Edit last contact (Ctrl+Y)", but that dialog is complicated and not the right tool
for the heat of a contest.

There is an alternative called "Quick Edit" (Ctrl+Q). Quick edit will return the last entered gso to the
entry window to allow you to change it. Pressing enter will log the changes, ESC will abandon
them. The Entry window text boxes change to blue to let you know you are in quick edit.

Was the mistake three QSOs ago? Then just press Ctrl+Q three times to get to it. The same rules
about saving/abandoning apply here as well.

I Quick Edit 'Feature
There is no check to ensure that the Quick Edit entered contents are valid like is done when a
QSO is entered normally. So check thoroughly what you type.

21. Meaning of Colors

The meaning of the colors is where possible consistent across all windows. The table below will
give the meaning per window.

Entry Window Available Mult’s and 0's window Check

Mults window

Bandmaps
Color

Call | Dupe | Callframe Buttons Calls \ Frequencies

Dupe | Dupe | Dupe

Gray
Black

|

|

| Dupe Non workable ‘
|

Blue [ 0so

|

|

|

\ |
\ | |
\ | | |
[ | CQ Freq. [ [ [ CQ Freq. I oW
[ 050 I 0s0 [ 0s0 [ oso | Qs0 I 558
| Multiplier ‘ | | | Multiplier ‘ Dut of band
| \ | | | \
| \ | | | \

Dupe

Red

Green

Multiplier Multiplier Multiplier

= 1 Multiplier = 1 Multiplier = 1 Multiplier = 1 Multiplier = 1 Multiplier

Magenta RTTY

22. Multipliers and QSOs

The program shows at many place if a callsign is a multiplier, a qso or a dupe. Please study the
table with the meaning of colors above.
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e The windows
o Entry Window
= Callsign in callsign field : the color of the entered call will tell Qso, Dupe or
Multiplier(s)
= Callsign on the call-frame: the color of the entered call will tell Qso, Dupe or
Multiplier(s)
o Available Mults and Qs window - the button colors will tell Qso, Dupe or Multiplier(s)
o Check window - the callsign colors will tell Qso or Dupe status
= Mul: - multiplier on this band
= Q: - gso on this band
= Example: Mul: 1520 Q: 160 80 40 10 - multiplier on 15 and 20 meter and a
gso on the other bands
o Bandmap - the callsign colors will tell Qso, Dupe or Multiplier(s)
e The colors
o Blue: QSO
o Red: Single Multiplier Example: CQWW - gso is either zone or country multiplier (one
multiplier)
o Green: Double or better Multiplier Example: CQWW - gso is a zone and a country
multiplier (two multipliers)
o Gray: Dupe

23. Connecting to a Telnet Cluster

e Select the tab: Telnet in the packet window.
e Select a telnet cluster from the list in the upper right corner
o This list can be changed in Configurer at >Config >Configure Ports, Telnet Address,
Other >Hardware tab, Select < Edit > next to Telnet Cluster
¢ Click the button marked with your callsign, on the far lower right, or type your callsign in the
left field at the top of the telnet tab. Do not click the CONN button, that's solely for RF packet

24. How to Save the Log

Well, there isn't a 'save' function because it is not necessary. Every change you make to the
database is stored 'on the fly', hence the absence of a 'save log' function. The ham.mdb file (default
name) on your hard disk is the database where every contest is stored, along with lots of other
information used by the program. Also there is no need to make a new file for each contest. Each
new contest is stored in one and the same file. Just go to >File >New Log in Database and pick one
out of the list, and you're all set to go. After a couple of years, there are dozens of contests in the
database, for a total of a couple of thousand QSOs.

Now, you can make new databases, as many as you want. You can have separate databases for
separate calls, separate contests etc. Most users however, only need 1 database. You can copy it to
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backup etc. Just be sure what you're doing when messing with files...
25. Function Key Macros

You can't skip function key numbers. It is the position of the macro, not the number you identify it
with.

The first 12 macros are RUN macros. If you then only fill in 7 S&P macros then 8 thru 12 will be the
same macros as the ones you filled in for RUN. So in your example if you set up your {WIPE} macro
for F11 in RUN and your S&P F11 was blank then the {WIPE} F11 key would work in both RUN and
S&P.

If you want to fill in a blank macro enter the function key comma and a space. You have to put the
space as you cannot create a blank macro.

If you want to go from S&P to RUN is a single keystroke then set the first S&P macro to CQ (without
F1 in the description) and put the

command QRL? in the macro (Pete's trick). CQ,QRL? So hitting F1 would send QRL? and put you
in RUN and start your auto CQ if turned on.

26. Save and Restore Window Positions

Save and Restore window positions is under >Tools >Save Window Positions' and >Tools >Restore
Window Positions

For example:

New operator PA1M: Hit Ctrl+O and enter: PA1M and after this he presses 'Save Window Positions'
in the Tools menu. The window positions for PA1TM are now saved.

Next operator comes in and does the same for his call.

PA1M is again the operator and wants his window positions back: PA1M does Ctrl+O and enters:
PA1M and after that selects 'Restore Window Positions'. The window positions will immediately
change to the saved positions. PA1M has his window positions back!

L Substituting Mode for Callsign

Instead of inserting your callsign, enter the mode - RTTY, CW, or SSB. This will save / restore
window positions based on your preferences for each mode. This obviously won't work in a
Multi-op environment but very usable in the single operator multi mode shack.

27. Editing Lookup Tables

Lookup tables are used widely throughout the program. Example tables are the function keys,
telnet stations, exchange abbreviations etc. These tables can be updated by the user and mostly
lines can be added at the bottom of the list or deleted where needed.
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¢ To Delete a row, click on the row "handle" - the gray arrowhead - the 'pensil' will move to it and
the row will be selected, press Delete
¢ To Insert/Add a row, click on the icon with the 'star', a new row will be added. A row can only
be added if all columns are filled
o The column values will automatically be assigned a space so directly adding a new row
is possible
¢ To edit an entry select the field to update and enter the new information.

28. Backup and Restore

Information used by the program is partly stored in the database, partly in ini files and in some
additional subdirectories. Examples are the WAV files (for the function keys) but also in the Letters
directory. So when making a backup not only backup the MDB files but also some text files / or
sub-directories. The best solution is to backup and restore the whole N1MM logger subdirectory.
Backup/restore proposal 2 is a partial backup/restore.

28.1. Method 1: Full backup/restore on same computer - backup and restore the whole
N1MM logger subdirectory

e Backup the whole N1MM logger subdirectory
¢ Restore the data is more or less the other way around. Restore the whole N1MM logger
subdirectory

28.2. Method 2: Partial backup/restore on same computer - make a partial backup and
restore.

Storing all these settings (exported text files, wav files etc) next to all databases (mdb files) on a
diskette, CD/RW or USB-pen in case of a computer crash would not be a bad idea &

¢ Backup all database (*.mdb) files
o In the database files are all contests with QSOs but also the function keys content,
Station information etc. Compress the database to get them small
o N1MM Logger.ini
= Windows Settings, radio settings, port settings, RTTY settings etc. i.e. everything
in Configurer but also last contest used are are stored in the N1MM Logger.ini file
o Wav files
= Which can be used by the program (SSB mode). They are in the WAV directory (for
the function keys) and and in the Letters directory (sending callsigns etc)
» Recorded QSOs are stored in subdirectories under the N1MM logger program
directory (and can become very big)
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o More?

* Restoring on the same computer - Restoring the data is more or less the other way around.
o Restore All database (*.mdb) files

+ Restore the database file(s) back in the program directory (which is the default place but not
necessary).

o N1MM Logger.ini

+ Copy the saved file in the Program directory.

o Wav files

+ Create the directories WAV and Letters directory and other directories needed.

+ Copy the wav files in them.

o More?

2 Backup and Restore is not a Copy Function
Backup / Restore will not move the program to a new computer. You must always start with a
Full Install on a new or different computer

28.3. Installing on a Different Computer

With a new / different computer you first have to perform a Full Install to get all dll , ocx files etc.
copied and registered. After that you may overwrite/add all *.mdb files, settings etc. in the N1MM
logger program directory by copying and importing settings. See the restore procedure above.

You have to watch out if the settings like serial ports, directory structure, screen resolution etc. are
different on the second computer. This could/will give trouble.

Copy, zip, cd/rw etc.

Compressing the database files for backup/restore with a program like WinZip really helps, these
databases (but also Word files, Excel files etc.) compress a lot, mostly down to 10-25 percent of it's
original size. This means that a 4 MB database fits easily on a diskette.

The database can be also compressed with File/Copy and compact database. This is not a zip
compression. It recovers space from deleted rows. Most database engines do not recover deleted
rows until a reorganization is done. They just mark them deleted. This is not the same compression
as mentioned above when using zip compression. When doing a compact database the database
can still be used afterwards by the program. Using zip compression is only for backup/restore
purposes.

It is wise to make a regular backup of the whole NTMM logger subdirectory including all
subdirectories to a CD recordable. Copying it to another hard disk (in the same computer but better
on another computer when you have a network) is also a good idea.

29. Basic Functions for RTTY
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Here are 4 RTTY Operating tips from Rick, N2AMG

1. Use your mouse to grab everything just click on the call sign and it will get passed on to the
entry window and click on the exchange it will get sent to the exchange field. Or use the Insert
key to grab a call from the grab window and send your call that saves time also

1. When you click on a callsign do you still need to press the space bar to advance things? You
don't! Go to >Window >Digital Interface, then in the digital screen select >Setup >Settings
>Send space after callsign click. Turn that setting on and you will be all set. Also select
>Setup >'Rt click= Return NOT Menu'

1. Try turning on >Setup >Rt click= Return NOT Menu. What this does is makes the right click
of the mouse button while the mouse pointer is in the RX window act like the ENTER key and
will step thru the ESM keys without hitting the keyboard. Your hand never leaves the mouse
for the whole Q

1. Hover mode: Let's you grab the callsign just by pointing your mouse on the callsign, no
click... this way. It's faster then to click right to reply. Hover mode can be found in the Digital
window >Setup >'Turn Hover Mode On/Off'

Advanced Functions

In this Section...

Advanced Functions
1. Mobile/Rover Support
1.1. How Mobile/Rover Works
2. Call History Lookup
2.1. The Call History Text File
2.1.1. Menu options
3. Spot Filtering
4. Transmit on same band with two radios
5. Big Gun versus Little Pistol switch
5.1. So you are a big station
5.2. So you are a little pistol
6. Staying in Run Mode (great for Dxpeditions) or in S&P mode
7. Auto Send
8. Enter Sends Messages (ESM) Mode
8.1. Basic ESM Functionality
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8.2. How to Prevent the Cursor from Moving to the Next Exchange Field
8.3. How to Skip Sending the Callsign or Exchange Field (SSB)?
9. QSYing Wipes the Call & Spots QSO in Bandmap
10. Single Operator Call Stacking
10.1. Additional SOCALLSTACK Information
10.2. Digital Call Stacking
10.3. How to Tell Visually Which Call Will be Put in Next
11. Call Stacking (same or different bands) - Multi-User Mode
12. Serial Number Server
13. Contest Reporting Application
14. Starting a Contest with a Number Other Than 001
15. Single Operator 2 Radios (SO2R)
16. Footswitch Support

In the 'Basic Functions' section the more standard routines like changing frequency, band and
mode can be found. In this section the more advanced features are addressed. Not needed for
everybody but nice when you think you need them

1. Mobile/Rover Support

N1MM logger supports Rover operation in at least the ARRL VHF contests and all QSO parties. For
this to work the "Rover" category has be selected and the "RoverQTH" set. This gives a mobile/rover
in a QSO party/VHF contest a quick, easy way of changing counties and re-programming F-key
messages in one step. You will also have a complete, composite log. No cutting and pasting
Cabrillo files anymore.

1.1. How Mobile/Rover Works

First, set File > Open Log in Database > Contest tab > Mode Category = "Rover"
Your initial or subsequent RoverQTH can be set

¢ in the Station Data window. This box will automatically update when you use any of the other
methods of setting RoverQTH

e by right clicking on the county or grid in the Multiplier window

e by typing CTRL+H

e or by typing ROVERQTH in the Entry Window callsign box and hitting Enter. This pops up a
window for you to input the county designator, typically 3 or 4 characters, and then hit Enter
again. This sets or resets the current RoverQTH, which is displayed in the top border of the
Entry window, beside the frequency display.

The {ROVERQTH} macro, when placed in your F-key messages will always send the current county
designator or RoverQTH. If, for example, your F2 key is defined as "S5SNN{ROVERQTH}", then the
"RoverQTH" column in the log window will reflect your current QTH for each QSO..
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RoverQTH can be 10 characters long but most Cabrillo output is five or six characters long.

When a new ROVERQTH is set in the Entry window, the program checks with the list of accepted
county designators for the current QSO party or contest. If for some reason an unlisted county
designator is required, it can be entered in Config > Change Your Station Data

2. Call History Lookup

Please note - this section is work in progress, and WILL be changing repeatedly in the
coming weeks

L Big Improvements in Version 10.8.3

Beginning with Version 10.8.3, the Call History Lookup function is much improved. This is a very
good reason to update, if you haven't done so already. The following user instructions assume
that you are running 10.8.3 or later.

As far as we can tell, the idea of storing information about a station from past contests, for recall
during the current running, began with N6TR's TRLog, which used an extension of the Super check
Partial master.dta file to capture and display a variety of information, such as name, Sweepstakes
check, and ARRL section or state.

Since its early days, NTMM Logger has used Call History text files to store contest-specific
information. To use Call History Lookup, you must load the text file into the current database and
enable the Lookup (on the pull-down Config menu).

© Only One Call History Table at a Time

There can be only one call history table actually present in a given database at a time, and it
remains active regardless of the contest unless replaced with another or unless you turn off the
lookup function.

When a callsign is typed into the Entry window and the Space bar is pressed (or Enter, in the ESM
case), the database table is searched and if the callsign is found, the associated call history is
displayed. If the information is relevant to the current contest, it is pre-filled in the appropriate
exchange field in the Entry window. Otherwise, it is displayed as text in the "beam heading" line of
the Entry window. Here are two examples:
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i= 14029.39+0.00 CW Elecraft K3 VFO A Eox

File Edit View Tools Config Window Help
Snt Ry State

IN4ZR 599 (599 (MY

Gl wipe | Log It | Edit | (S | Store |Sgcut|t| Buck |

Esc: Stop | F15&PCO | FZ5&F Exch | F35&F g Fd N2IC
[ Running  F5 his call FE ty MR F7 Prec FBCk
lfj F3 F10 nr? F11 prec? F12 ck?

Bearing = 344°, 7283 mi, 11720 km, LF = 165° PETE CK 54 WM
K. - United States, Zone &, NA, 040 1]

i= 14029.39+0.00 CW Elecraft K3 VFO A =3
File Edit View Tools Config Window Help
Skt Mr O MAZR 54w

INAZR | 1|54WV|

5@ wipe | Loglt| Edt | Mark | Store | Spetit] Buck |

Ezc: Stop | F1 5&P CQ F2 S&P Exch F3S&P g F4 N2IC
[ Rurning F5 hiz call FE ky MR F¥ Prec F& Ck
lﬁj F3han F10 nr? F11 prec? F12 ck?

Bearing = 220°, 530 mi, 353 km, LP = 417 PETE Ck. 54 WA
Call hiztory, 2 callzignz imported 0/0 1]

In VHF contests, the grid square from the Call History table is used to calculate the beam heading
reported in the Bandmap.

2.1. The Call History Text File

The first few lines of the text file (shown below in bold type) are comments, denoted by the #
character at the start of each line. None of these lines are required, but they are a helpful reminder
when you are working with a text file. They are automatically added when exporting a Call History
file.

#Comment lines do not have to be removed for import.

#Field names and size: Call(15), Name(20), Loc1(6), Loc2(6), Sect(8), State(8), CK(#),
Birthdate(date), Exch1(12), Misc(15), LastUpdateNote(Optional,40)

#Current contest: YOHFDX

The next line gives the order in which fields in the text file are read into the database. Surrounding
the word "Order" with two "!!" characters tells the program to treat it as an instruction, not as data
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0Order!!, Call, Name, Loc1, Loc2, Sect, State, CK, BirthDate, Exch1, Misc, LastUpdateNote
Finally, we get down to the data.
N2YO,,,,,,,1900-01-01,364,,Log update no change

As you can see, each comma denotes a field. Successive commas mean empty fields. In this case,
we have the Call, a whole flock of empty fields, the default Birthdate (provided by the program, for
technical reasons), and then Exch1, which is the number N2YO gave me in the contest.

As you can imagine, making sure you have the right number of commas between actual data in the
text file can be a problem. Fortunately, the !'Order!! command offers a simple solution. For
example, you create a text file that looks like this:

"Order!!, Call, Name, CK, Sect
N4ZR, Pete ,54 WV
N30C, Brian, 67, MDC

When you load it into the current database, the data will be put in their proper places in the Call
History table, and when you operate in Sweepstakes, for example, with Call History Lookup
enabled, the program will pre-fill the check and section in the Exchange field, and will display the
name and all the other data in the Bearing line of the Exchange Window. This redundancy is
deliberate, because if you set out to edit the Exchange and then realize that the pre-filled data were
correct, they are there for ready reference.

What this change has done is to make it much easier to generate Call History text files for loading
into NTMM. For example, you could generate a file that contains calls, names, checks and sections
for everyone you worked last year in Sweepstakes, and by writing the correct !'Order!! line, like this:

I'1Order!!,Call,Name,CK, Sect

you can make sure the information loads into the correct places in the database. The only thing you
have to be careful about is to use the database field names exactly as shown above. For example,
you must use Sect, not sect or sec or Sec, and CK, not Check.

2.1.1. Menu options

e >Config >Call History Lookup
o Check to enable Call History Lookup.

¢ >File >Import >Import Call History
o Select the file to be imported. All information in the Call History table in the database is
erased, and the imported information substituted.
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e >Tools >Update Call History with Current Log
o Update the Call History table with the QSOs from the current log. Callsigns and contact
data will be added, when new, or updated when already in the Call History table. Note
that nothing is erased from the table other than data associated with a callsign in the
log, and then only when different.

For the 2 grid fields the behavior is a bit different. When both grid fields are filled and a new grid
has been logged, the second grid (oldest) will be removed, and replaced by the contents of the first
field. The new grid will be added to the first position. The same change in position will happen when
only the first grid is filled and a new grid has to be added from the log. A 4 digit grid will be
overwritten by a 6 digit grid when the first 4 characters are the same. move to VHF section

e >File >Export >Export Call History
o Exports the information in the Call History table. It is very important, particularly if you
have changed the Call History table, to re-export the data as a Call History text file.
Otherwise, any changes will be lost. You are given the opportunity to rename the text file
so that, for example, a 2008 SS file can be renamed 2009 SS, to indicate that it has
been updated.

You can import any Call History file that you formerly used, without the need for the !'Order!!
directive. When you export a Call History text file, the program fills in the commas that are
necessary to fit the default order, as well as -1 for each empty CK and 1900-01-01 for each empty
Birthdate. This is necessary to ensure compatibility with your old Call History files.

3. Spot Filtering

There are three levels of spot filtering available. The first of these is at the DX cluster node, using
whatever filtering capabilities are built into the node. Because N1MM Logger stops processing telnet
messages when CW is being sent, users who are connected to a very high volume node, such as
the Reverse Beacon Network's Telnet node, may find it advantageous to block some of the less
useful spots (for US users, you might not want spots from VK, for example).

The second level of spot filtering is accessible from the right-click menu of the Packet/Telnet
window, and decides which spots received from the cluster node should be forwarded to the
Bandmap and the Available window. If too many spots are forwarded, depending on how fast your
computer is, you may encounter brief delays in execution of commands (such as sending of CW
messages) while the program catches up,. See the section on the Packet and Telnet window for
specifics.

The third level of filtering is set in the right-click menu of the Available Mults and Qs window, and it
only governs which spots are shown in that window's lower pane. For example, if you decide only to
list CW spots, the bandmaps will continue to display all spots, and the top pane of the Available
window will continue to display overall spot numbers for each band, but the lower pane's list of
spots will contain only CW spots. You can quickly switch back and forth between showing all spots,
just those on the current band, only CW or SSB or digital spots, or any other band/mode
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combination.

4. Transmit on same band with two radios

In some contests (like IARU contest) it is allowed to transmit on CW/SSB at the same time on the
same band. To set this up make sure that Operator Category is set to Multi-Multi and Mode
Category to Mixed. Both can call CQ at the same time without blocking each other. Also Config >
Multi User Tools > Force Other Station to Stop Transmitting when | Transmit should not be checked!

Interlock method works fine with packet delays up to 400 ms. If two operators push F1 at the same
time both stations will begin transmitting but in less then 100 ms they both will check if any other
station transmits on the same band/mode and if this is the case station with higher number will stop
transmitting and display a message to the operator "Another station is already sending". Obviously
the higher the packet delay is, the longer both stations will be transmitting at the same time but in
reality it is never longer then 100-200 ms (PTT delay should be subtracted). And this only happens
when there are two or more stations on the same band/mode (Run and Mult stations) and two
operators managed to hit F1 (or any other Fx button) at the same time.

5. Big Gun versus Little Pistol switch

One of the settings in Configurer >Function Keys tab is 'ESM only sends your call once in S&P,
then ready to copy received exchange'. When selected and in Enter Sends Message mode, the
cursor moves to the Exchange field when there is something in the Callsign field and Enter is
pressed and does not keep the cursor in the callsign field. If you don't usually get a station on the
first call then deselect this option.

5.1. So you are a big station

* Stations normally come back to you on the first call
* In >Configurer >Function Keys tab, check 'ESM only sends your call once in S&P, then ready to
copy received exchange'.

5.2. So you are a little pistol

* You have to call mostly several times to get through to being answered
* In >Configurer >Function Keys tab, uncheck 'ESM only sends your call once in S&P, then ready
to copy received exchange'.

L4 Big Gun Tip
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One little trick to use with the Big Gun switch on is to program my call in F8 instead of "again".
This way, when you don't get the guy on the first call, hit Enter again to repeatedly send my call
until he answers (and the cursor is always in the right place when he does answer). 73 de Ted
WA4NZ

6. Staying in Run Mode (great for Dxpeditions) or in S&P mode

During DXpeditions it could be very useful to stay in Run mode all the time and not jump
inadvertently to S&P mode. Or stay in S&P mode if you choose. This behavior can be toggled using
the Alt+F11 key. The following message will be given in the statusbar when DXpedition mode i.e.
S&P mode is disabled "Run/S&P auto-toggle disabled" = Dxpedition mode. Back to normal show
the message 'S&P and Run Mode enabled'.

7. Auto Send

Autosend ( Ctrl+Shift+M ) will start sending the callsign before you have finished copying a full
callsign. i.e. starting after a certain number of characters has been typed AFTER the last number in
the callsign. The minimum threshold is 1. Zero will turn off the feature. Only when in RUN mode.

The rules are:

1. Find the first letter in the call
2. Find the last number after the first letter
3. Find the Nth letter after step 2

For example: Threshold set to 2

e WAWYP would start sending at Y

e S57AD would start sending at D

o KH6/WA4WYP would start sending at Y (using the "/" rule as well)
o WA4WYP/4 would start at Y (/4 will not be looked at)

WYP, WWYP and WAWYP do not meet the criteria for autosend to begin.
Prefixes like KH6/ are ignored and do not themselves trigger the autosend threshold.

8. Enter Sends Messages (ESM) Mode

Setting the option "Enter Sends Messages" in the Config dialog will enable a mode that allows you
to make entire QSOs without using the function keys. ESM works for both running and S&P mode,
but the messages are different for each mode. To set ESM, go to Config, and check Enter Sends
Messages (ESM mode), or use the shortcut Ctrl+M.
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8.1. Basic ESM Functionality

When running, pressing Enter with the callsign textbox empty will send CQ. If someone answers
you, type in his callsign. Hit Enter again, and the program will send the exchange. After entering
the other stations info, hitting Enter again will send the end of QSO message (TU/QRZ) and
automatically log the contact. See the chart below for a detailed list of what is sent at various states
of the QSO.

Here's a typical scenario where N1MM is calling CQ in the CQ WW CW Contest:

¢ Hit Enter - sends CQ N1MM

PA1M calls in - type "PA1M"

Hit Enter - sends "PAT1M 5NN T5", note that PA1M's zone is filled in for you.
PA1M sends "599 14" (zone matches what program filled in)

¢ Hit Enter - logs QSO & sends "TU de N1MM"

That's 3 keystrokes + typing PA1M's callsign. Slick!
On the other end, the S&P station (PA1M) can also use ESM. During the same QSO:

¢ You hear N1MM calling CQ - type "N1MM"

Hit Enter - sends "PATM", note that NTMM's zone is filled in for you
N1MM sends "PA1M 5NN T5" (zone matches what program filled in)
Hit Enter - sends "599 14"

N1MM sends "TU de N1MM", completing the QSO and logging it

Once again, that's 3 keystrokes + typing N1MM's callsign. In some other contests, like CQ WPX,
you will also have to type in the exchange, but in any contest ESM cuts the effort required to
complete a QSO to a minimum.

Keeping track of which ESM "state" you are in can be confusing when things get hectic. To help you
understand which state you are in, the function keys on the Entry Window will change color (aqua
blue) to alert you which message will be sent next. The goal here is that it should always be
obvious what will happen next.

There will be times when you get out of sync, or where you need to send something different than
what the next Enter will send. Don't panic. Just press the correct function key(s) (F2, F4, etc as
needed). If you finished out the QSO with the F-keys, just hit Alt+Enter, which will log the QSO
without sending anything, and you are ready for the next QSO (and ESM is reset to the beginning
state).

The cursor is kept in the callsign if you have entered a callsign that does:

¢ not have a prefix and at least one characters suffix
e prefix is a letter followed by a number
e prefix is a letter followed by a number, letter, number combo.

When ESM is on, the Space bar is used only when you need intelligent tabbing mostly between the
callsign and the exchange field for instance to correct a call.
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© Interrupting a CQ

If a CQ is being sent, typing a character in the callsign field while in ESM will stop sending a
CQ message being transmitted (this can be set in >Configurer >Function Keys >ESM only
sends your call once in S&P, then ready to copy received exchange

When the copy is solid, and no copying mistakes are made, ESM will just send the basic messages
in the previous example. Depending on what information is in the Call window and Exchange
window and what state the QSO is in, different messages can be sent. The chart below outlines the
possible combinations of information in the Entry window, and what will be sent in each situation.

unchecked

Dupe, Work Dupes checked

Dupe, Work Dupes checked

© Again? (F8)

Valid (before sending
exchange)

Valid (after sending
exchange)

His Call + Exch (F5 +
F2)

End QSO + Log (F3 +
Log It)

Running mode S&P mode
Callsign field Exchange field Enter sends Enter sends
Empty Empty CQ (F1) My Call (F4)
New Call (1st time) Empty or invalid His Call + Exch (F5 + My Call (F4)
F2)
New Call (repeat) Empty or invalid Again? (F8) My Call (F4)
New Call Valid (before sending His Call + Exch (F5 + Exchange (F2) +
exchange) F2) Log It
New Call Valid (after sending End QSO + Log (F3 + Send Nothing +
exchange) Log It) Log It
Duplicate Call Empty or invalid QSO B4 (F6) nothing
Duplicate Call Valid (before sending QSO B4 (F6) Exchange (F2) +
exchange) Log It
Duplicate Call Valid (after sending End QSO + Log (F3 + nothing
exchange) Log It)
Dupe (1st time), Work Dupes | Empty or invalid His Call + Exch (F5 + QSO B4 (F6)
unchecked F2)
Dupe (repeat), Work Dupes  Empty or invalid Again? (F8) QSO B4 (F6)

Exchange (F2) +
Log It

Send Nothing

When in ESM and in S&P, If the cursor is not in the call textbox and the Exchange is not
finished, the program will send " Again? (F8)"}

When a dupe callsign is in the callframe, the call is put in the call textbox and highlighted.
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The actual messages sent by each of those function keys (e.g. CQ Key, Exchange Key, My Call
Key, etc.) are set in the configuration dialog (‘Config | Change Packet/CW/SSB Digital Message
Buttons'). There are 24 messages that can be set: the first 12 messages are for Running mode, and
the second 12 for S&P mode. Each mode (CW, SSB, Digital) can have a separate set of messages,
which are saved by the program. If the program is sending the wrong message, check here first! In
the middle of the contest, you can also change the messages for the current mode by right-clicking
on (one of) the message buttons in the Entry window.

8.2. How to Prevent the Cursor from Moving to the Next Exchange Field

In ESM mode when running and trying to send a partial call entered in the callsign field, the cursor
jumps to the report field before you can finish typing the call...

Solution 1 - When you press Enter in ESM mode while running, the cursor will be placed
highlighting the ?. If you type a letter, say "J", the ? will be changed, and you will have G4UJS in
the callsign. Whenever you press the space bar, and the cursor is placed in the callsign, the ? will
be highlighted, ready to be replaced without typing Del or Backspace.

© Entering ? as a Callsign
When you are Running with ESM enabled and while entering you place a ? in the callsign field
the cursor will not move to the exchange field but stay in the callsign field highlighting the ?

8.3. How to Skip Sending the Callsign or Exchange Field (SSB)?

To avoid PTT when setting up ESM on SSB without sending a callsign or exchange put in SSB a
single space or the path to Empty.wav as the wav file for the callsign and/or the exchange buttons.
The program will not assert PTT and immediately simulate the space bar being pressed.

& Watch that Turquoise Button

The next button to be sent when pressing Enter shows in turquoise. If you don't like what ESM
will send, you may choose another.

9. QSYing Wipes the Call & Spots QSO in Bandmap

If you set >Config >QSYing Wipes the Call & Spots QSO in Bandmap, it will spot stations in the
bandmap which you haven't worked yet or don't want to work all. These stations are not spotted on
packet/telnet but only locally. Any call greater or equal to 3 characters that you don't work but have
entered in the callsign field will be automatically spotted in the bandmaps when you turn the VFO
to another frequency. This way you can place stations on the bandmap which you can't work direct
(big pileup?) so want to store them somewhere. Also useful when you want to add stations to the
bandmap who you don't want to (or may not) work but like to have the callsign in the bandmap so
when searching for stations you know who is on that frequency so you can turn on.
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All bandmap features work on these 'spotted' stations so they are easy accessible if needed. Self
spotted stations are easy recognized because they are shown in bold. This feature is also very
useful in a M/S or M/M environment. Often there is a MULT station that is tuning the bands, but may
not want to post the spot until the QSO has been worked by their own RUNNING station. (I do not
wish to get into an ethics discussion, but this is done quite often) This feature allows the MULT
station to build a band map full of calls for the RUNNING station to work when it gets a chance.

That means you can do the following:

e Tune to 21200.

e Enter VU2PTT.

e Tune off.

e VU2PTT is "spotted" at 21200, and the Entry Window is cleared.

e Tune to 21208.

e Enter G4UJS.

e Tune off.

G4UJS is "spotted" at 21208, and the Entry Window is cleared.
Repeat as long as desired.

e Go back and work all of them using Ctrl+Up and Ctrl+Dn to navigate.

© spot All S&P QSOs
There is also a >Config >Spot all S&P QSOs option. It has a number of rules, but will spot
everything you WORK on packet, if it has not already been spotted on the same frequency.

10. Single Operator Call Stacking

Macros and keystrokes used for call stacking are {SOCALLSTACK]}, {STACKANOTHER},
CTRL+ALT+G, {LOGTHENPOP}, and ALT+D. The first three are used to place calls onto the stack
and the last two are used to take calls off the stack. The macros only operate in RUN mode and
stacked callsigns appear in the Bandmap on your RUN frequency. SOCallstacking is functional in
CW, phone, and digital modes and is compatible with manual key operation or ESM. It can also be
used in SO1V, SO2V and SO2R modes and in multi-station environments.

{SOCALLSTACK} or {STACKANOTHER} or CTRL+ALT+G

The operator can stack a full callsign or a partial callsign that may include a "?" and it will be
highlighted when that callsign is removed from the stack. The operation of the {SOCALLSTACK}
and {STACKANOTHER} macros differ slightly.

{STACKANOTHERY} or the keystroke short cut, CTRL+ALT+G, simply pushes callsigns onto the
stack and clears the Entry Window callsign box.

{SOCALLSTACK]} functions as a single level stack macro. The first execution of {SOCALLSTACK]},
stacks the first callsign and clears the Entry Window callsign line. When a second callsign is
entered and {SOCALLSTACK]} is executed again, the two callsigns are exchanged. If the callsign
window is empty when {SOCALLSTACK} is executed, the callsign is removed from the stack and
placed into the callsign Entry Window.
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{LOGTHENPOP}, ALT+D

The stacked callsigns can be removed from the stack with several methods. Logging the current
call, unstacking the next callsign with {LOGTHENPOP?} or manually removing the stacked callsign
with the keystroke ALT+D. The ALT+D keystroke is useful if a callsign appears on the stack via a
telnet spot. The next callsign on the stack is displayed on the callframe when the CQ-Literal is not
present. Pressing Space will move a stacked call from the Callframe to the callsign box and remove
it from Bandmap.

ESM Automation

The Configurer, Function Key tab, Next Call Key is used to select the function key that contains the
{LOGTHENPOP} macro along with the message string for ESM automation. If a Next Call Key has
been specified, then when Enter is pressed to finish a QSO and there is another call sign on the
callsign stack, the Next Call Key will be sent instead of the TU(F3) Key. The last option in the drop
down menu for the Next Call Key allows the ESM SOCallstacking automation to be disabled.

SOCALLSTACK ESM Example

Program F9 key to: {STACKANOTHER} or {SOCALLSTACK}

Program F10 key to: {LOGTHENPOP}TU NW {F5} {F2}

The appropriate SSB wave file can be inserted into the F10 message in place of the " TU NW"
letters above.

For example: {LOGTHENPOP}C:\Program Files\N1MM logger\wav\{operator\TnxNow.wav {F5} {F2}
Set >Config >Function Key tab >"Next Call Key" to F10

Select RUN mode and turn ESM on. For this example two stations are calling, N2IC and K3CT
Type K3CT, press F9, type N2IC and press Enter

Copy N2IC's report and press Enter. This will log N2IC, send the TU, unstack K3CT, and send the
exchange

SOCALLSTACK Non-ESM Example

Program the function keys as listed above.

Select RUN mode.

Type K3CT, press F9, type N2IC and press the exchange key programmed in Configurer, usually
".". This key is programmed to F5 & F2.

Copy N2IC's report and press F10. This will log N2IC, unstack K3CT, and send the exchange

If multiple callsigns are stacked, ESM will continue to unstack the callsigns. The same is true in
non-ESM mode as F10 is pressed. Should a logging error occur such as a bad call, the sequence
will be interrupted until the error is corrected. When no calls remain on the stack, the TU message
is sent. If there are multiple callsigns on the stack, the order that they are removed or exchanged
with {SOCALLSTACK} depends on the internal sorting order and not the order they were stacked.

10.1. Additional SOCALLSTACK Information

It is important that the contest callsign is entered in the Config, Station Information window. That
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way, the station callsign will not appear in the Bandmap via a telnet spot and the SOCALLSTACK
code will not place the station callsign or the Busy literal (ALT+M) into the callsign box.

If a callsign appears on the callsign stack via a telnet spot that you want to remove, use the ALT+D
keystroke to remove it without popping it off the stack.

SOCallstacking does overlap slightly with multi-operator call stacking. Multi-operator call stacking is
the program feature that allows a second operator to listen to the run radio and send calls to the
run operatorAfA¢A¢a€sA~A¢a€zA¢s Entry Window.

10.2. Digital Call Stacking

To turn this off or on there is a menu selection in the Setup dropdown menu in the Digital Interface.

o With it turned off everything operates the way it is before Call Stacking was added.

Only works in RUN Mode and only with a valid callsign.

Single Click on Call in Digital RX window or Alt+G when grabbing a call

If there is no callsign in the call box of Entry Window it will function just like it normally does
by placing the callsign in the call box.

If there is a call already in the call box then clicking on another call orhitting ALT+G to use the
grab window will move the call that is currentlythere up to the bandmap and call frame of the
entry window and place thecurrently clicked or grabbed call into the call box.

The usage here is if a two stations call you can then stack one call and work the other. Then
instead of hitting enter if in ESM to send F3 or LOG. You would then hit the F-Key that contains :
{TXH{ENTER}! {LOGTHENPOP} TU NW {F5}F2KRX}

Alt+Single Click on Call in Digital RX window or Ctrl+Alt+G when grabbing a call. This will take the
clicked on callsign and place it directly to the stack in the bandmap. Any number of calls can be
placed here for working one after another.

The usage is 3 or 4 stations call you at the same time do a single click or Alt+G on the first call to
place it in Entry window. Then do and ALT+Click or Ctrl+Alt+G (to pull from grab window) to place
the others on the stack. Then use the F-key that contains: {TX{ENTER}! {LOGTHENPOP} TU NW
{F5K{F2}{RX} to work them all in a row until the last call is off the stack then you would use F3 or hit
enter in ESM to log the final one.

{LOGTHENPOP} will not function if CQ-Frequency is in the Call Frame.

Double Click on Call in Digital RX window: The function of the Double click does not change and
will over ride whatever callsign is in the Entrywindow Call Box with the clicked on callsign.

Macro Substitution: {LOGTHENGRAB} This will log the current contact and Grab the top callsign
that is in the grab window of the DI. Will only work in Run Mode Digital use of macro Substitution:
{STACKANOTHER} This acts just as Ctrl+Alt+G for the grab window but allows it to be called by a
macro. If you hit the F-key that contains {TX{ENTER}! {LOGTHENPOP} TU NW {F5F2}{RX} while
there are no calls stacked it will send your TU key.
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10.3. How to Tell Visually Which Call Will be Put in Next

If "CQ Frequency" is on the call frame, then look at the Bandmap.

The {LOGTHENPOP} calls the {SOCALLSTACK} routine. {SOCALLSTACK?} will remove the
CQ-Literal ("CQ Frequency") and take the next callsign listed on the Bandmap's run frequency.
There are cases where the CQ-Literal string will replace the callsign on the call frame. The stacked
callsign isn't lost, look at the Bandmap.

The same is true when you are spotted. Your callsign will appear in the call frame but the routine
will not pop it into the callsign box. If you find that it does, you don't have "your callsign" entered
into Station Data window. When you use {LOGTHENPOP}or {SOCALLSTACK} they remove the
station callsign and discard the callsign, then grab the next call on the stack.

If you have {SOCALLSTACK} programmed to an F-key, pressing it once at any time will exchange
the current callsign with the next callsign on the stack. If there is no callsign on the stack, then it
stacks the call and gives you an empty callsign window to enter one. Pressing the F-key again will
reverse them again.

11. Call Stacking (same or different bands) - Multi-User Mode

A callsign can be stacked from one radio to another when in 'Multi-User Mode'. It does not matter
if the target station is on a different band or the same band. A second operator can stack a call
on your PC, and he could find stations and stack them for you to work.

¢ To indicate which station you want to stack for, right click on it's "cue-ball" in the info window,
and select the option "Target for call stacking"

e A maximum of one callsign can be stacked. If the stack is empty another one may be stacked

o After the target station pops the call into the entry window callsign area, the partner station
needs to manually wipe his entry line before entering another call. It doesn't automatically
clear

Stacking within same band but not on the same frequency - Use the bandmap by tuning off a
station whose callsign you copied.

Additional functionality when on the same CQ frequency (within tuning tolerance) then you will see
the other station keystrokes in your callframe and vice-versa.

12. Serial Number Server

N1MM logger supports a single sequence of serial numbers for SO2R, MS, M2 and MM.
The serial number is reserved in

e S&P mode when the cursor leaves the callsign field or the Exchange key (F2 default) is sent
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o Either through spacing, tabbing, or hitting Enter in ESM or pressing the Exchange key

o This is needed so you can enter calls to check for dupes while not reserving a serial
number

e RUN mode as soon as you enter a letter in the call-sign field

o This because on SSB people frequently talk before they type, and they need to see the
serial number displayed earlier. A serial number is not assigned in S&P mode until the
space bar is pressed, so you can do dupe and check multipliers without committing a
serial number to it, by entering it in the callsign field without pressing Enter or Space

In SO2R and SO2V, typing Alt+W (wipe) after a serial number has been reserved or wipe through
QSY will "un-reserve" that number.

Because of the way the serial number server works, there are a few cautions:

e Serial numbers issued by the second radio may be out of time sequence with those issued by
the main one. This occurs because certain program actions cause a serial number to be
reserved for the use of a station, and if that station does not use that number until after the
other station has made several QSOs, when the log is viewed in chronological order the serial
number will appear to be out of order. | don't think there is anything to be done about this

e For similar reasons, depending on operator actions at one or the other station, such as
shutting down the program while a number is reserved, there may be some gaps (numbers
not issued) when reviewing the final log

e The most important aspects of serial numbering are that the serial sent to a station be
correctly logged, and that there be no duplicate serial numbers sent; N1TMM logger seems to
meet both these criteria

e Sometimes it's possible a number will be skipped when given out but not used (example:
QSO not made after all or deleted). Contest committees do accept this behavior!

e The maximum sent number to give is 32767. The maximum receive number is 99999

© What Do Sponsors Look For?

Most sponsors are more interested in serial number accuracy than in serial number time order.
If you think about it, it is impossible to guarantee the order of serial numbers in a two radio
situation. This assumes that you always log the time when the QSO is added to the log, which
is the right time from a rules point of view. i.e. end of contact.

Addendum by Steve, N2IC&&&
Let me say a few words about the way serial numbers are "reserved" in NTMM Logger. For the sake
of this discussion, I'll assume that ESM is being used.

When you enter a callsign in the Entry Window, and hit the Enter or Space key, a serial number is
reserved and locked-in to that QSO. If it turns out that the QSO is not completed and logged, that
serial number is "lost", and will be not used for a subsequent QSO.

This gets to be especially interesting with SO2R and SO2V. Let's say you are running on Radio 1,
and search-and-pouncing on Radio 2. You enter a call on Radio 2, and hit the Enter key, reserving
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a serial number on Radio 2. You get beaten out on Radio 2, and go back to running stations on
Radio 1, advancing the serial number beyond the number reserved on Radio 2. A few minutes pass,
and you finally work the station on Radio 2. Your log now appears to have non-sequential serial
numbers. If you never work that station on Radio 2, the reserved serial number on Radio 2 is lost,
and will not be used for any subsequent QSO.

| can't speak for all contest sponsors, but for Sweepstakes and CW/SSB WPX, this is not an issue.
There is no problem for these log adjudicators if your serial numbers are out-of-sequence, or if
there are missing serial numbers in your log. Your log will be correctly processed. In addition, the
N1MM Logger Summary window reports the correct number of successfully completed QSO's.

In summary, stop fretting about out-of-sequence or missing serial numbers. The software is working
as designed &

13. Contest Reporting Application

The Contest Reporting Application (Realtime score reporting) can be started by checking "Start
Contest Reporting Application" on the Other tab of the configurer. With this application you can
show your contest efforts in real time during a contest to the world. Next to this contest reporting
application a website is needed where everyone can see the scores. This application does
automatically upload your scores from the current selected contest to the configured website. These
websites are published on the several reflectors.

© stop Score Reporting

Note that this will keep reporting everything until you uncheck it. Doesn't matter if you are
testing, or operating in a contest. It will be reported. So either close it or click "Stop Send" if you
don't want that.

When the application has been started the dialog below will be shown.

i™ Realtime Score Reporting E@@
Stop Send 273 Rezponze Received

Ver 11

Get Scores

In the middle a countdown counter in seconds will be shown which can be set in the Setup (see
below). When the counter reaches 0 your score will be sent to the configured website.

The status field next to it will give status information (like error messages). A small button to right of
status field shows response from last upload and creates a file with sent and received data for
debugging problems. Version information is shown in the middle of the dialog.

e Stop Send / Send Score - Stop the sending of scores to the configured website.
e Get Scores - Clicking this button will open the configured website in your browser so you can
view your and other stations scores.
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e Setup - will open the Setup dialog below.

Note that the score will be send to the website for the first time at program startup.

Realtime Score Reporting Setup
Score Posgt Time [min] -

Seare Posting URL |htt|:u:.-".-"www.w'l e, comdpostscore. asp

Scare Reading URL |http:.-".-"Iive.getsu:u:ures.u:urg.-"

Ligtening [P | Set by MMM Logger
Liztening Part | Set by M1k Logger
Defaults Cancel ]

The setup dialog configures the realtime scoring application.

e Score Post Time (min) - Set the timer how often your score will be uploaded to the
configured website. The possible times to set are: 2, 5, 10,15,30 and 60 minutes. Also a
manual mode possibility can be selected. To send the score the 'Send Score' button has to be
pressed.

e Score Posting URL - The url of the website to post your scores to.

e Score Reading URL - The url where the scores are displayed.

e Listening IP - Shows the IP address on which N1TMM logger is running. By default this is the
same computer as where the real time scoring application is running on. This setting is set by
N1MM logger.

¢ Listening Port - Shows the port from which N1MM logger will send the information to the real
time scoring program. This setting is set by N1MM logger.

e Defaults - Fill the dialog with default values.
e Cancel - Cancel the entered values and close the dialog.
e OK - Save the values and close the dialog.

During major contests several real time score reporting web sites will be up and running. An
example website from Gerry, W1VE below.
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Live Amateur Radio ContestScores

& 5ite by WAVE, Last Updabed 19-0ct-2006 20:57 UTC

Crispiane Fiter and Cphions
Contest: Ml Coneit b #hook: | 25B b Entr: | 40 Cluosss W Power:| HiGH hd
Banis: 1 Bk - b | Yankes Crpsst Con ™ oHae: | b LT T v
Grd vy bt 1ARLEZE| 40 Zares b Localia: | &l Leedie W Ffrosh Crispiany: | Ewery inute o
Drsplay Option: | Basic Scares and Breakdowns | | Hid= Options SSid=bar Apply and Sove Filter

Current Fitter: Yarkes Crpper Conbess Club 558 HIGH K 18 sooreis) pooted from 18-Oct-2008 20: 57 to 20-Cer-2006 20:570TC)

Conlest [t 'ir_uu_ Jank lc.l Ih.nm-n _asos [TolalMults Band 60 Zone IRl Eone StatefProvitiher Last Update
CO-WYC-SEE WIVE  HMMHP 1 19 5 m | 11,200,884 5452 T ALL 5 A [10-18-05 22:12
O WYE-SSE HMEHP [ [TTe] | 497309 BEY{ALL 5 BT [1-1%-0 10254

u:_il.dupd..tu |
® @1 10-16-04 T3:13
167 10-15-06 10: 54

Who  [Clas [Rankc]can |m:_u_._:_ Q505 Tolsl Mults |3
WIYE Pl tﬂn 11,200,804 5452 vl

MP1 MIMH | 4373301 299

By Gerry, W1VE:

Through the encouragement of many, | decided to take on the project of creating a usable web
portal for realtime score reporting. The result is now ready.You can view the portal at:
http://live.getscores.org

The scoring upload to the site is based on work by Bruce, WA7BMN, with his Contest XML schema,
and scoring trials last year by Tom, N1IMM and the N1MM logger.

The latest version of N1TMM fully supports score posting. If any other contest software vendor
supports the HTTP POST method of score reporting, it is immediately compatible with
getscores.org. Additionally, getscores.org supports a SOAP-based Web Service API. The success
of the site will depend on participation and the support of software vendors. There are links on the
live.getscores.org site for FAQs.

The viewing site supports many filters, so that you can look at only what you want to look at. Filter
by Class, Power, CQ Zone, IARU Zone, State/Prov and lots more. Your filter preferences are saved
as a cookie by your browser for up to 7 days. The page automatically refreshes every 60 seconds
with score information.

the website will support many contests as listed on the site.

The window is by Score with the highest score first within the operating class, Power Class and
mode. The general idea here is not to look at everything: apply a filter and you'll get a more
representative view of you are looking for.

A scoring period is a rolling window of 72 hours. If you post for a particular contest during the 72
hour period, any time you post an update, you will simply update your score for that contest. This
way, if there are two supported contests over a weekend, you can submit to both. The unique key is
the name of the contest and the callsign.

By the way, | want everyone to know that getscores.org is not an "N1MM" effort. In fact, | want to
ensure it is not. I'm sure that Tom would agree. We must get as many of the contest authors to
participate, otherwise, this type of site is useless. We need to see lots of scores, not just those from
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the NTMM logger. That said, BIG KUDOS to K1TTT and N1MM for getting the posting software in
great shape quickly, and to all of you users for testing — that's a great way to get the site in good
shape for CQWW.

If you have any questions or suggestions about the site, please send them to me at the email
addresses provided on the site, or via gerry@w1ve.com.

The ethics
Tom, N1TMM: | don't see any issue with reporting your score. You are not "spotting" yourself, there is
not a frequency specified other than the bands you have operated on.

14. Starting a Contest with a Number Other Than 001

Some contests which have more parts/sessions there is the need to start a next session with the
next number given in the previous part. So how not to start with 0017?

There are two workarounds:

1. Start second part as a separate contest and make the first QSO with number 001 and log it,
then correct (Ctrl+Y) to proper sent number

2. Start second part as a separate contest, enter fake QSO, open QSO in EDIT window, change
SENT number from 001 to last number you sent in the previous part of the contest, save
changes, et voila, it's done. When a couple of real contacts have been entered, delete the
fake QSO

15. Single Operator 2 Radios (SO2R)

Single Operator 2 Radioa (SO2R) is an operating technique that when done properly, can add
many extra QSOs and multipliers to your log. This is accomplished by increasing your efficiency
during "dead" time, specifically when you are sending on one radio. Efficiency is increased by
listening on a 2nd receiver while you are transmitting on the 1st radio. On the 2nd radio you are
scanning the bands for needed QSOs and multipliers. If you find a new station to work on the 2nd
radio, you leave it staged on the 2nd Entry Window until you get a free moment to work this station.
Even adding a few QSOs an hour will greatly boost your score.

A complete chapter has been devoted to SO2R.

16. Footswitch Support

Footswitch support has been added for multiple distributed stations.
In IARU contest headquarter station is allowed to use multiple stations located within one IARU

zone but the rule of one signal per band/mode still in effect. So there are often 2 (one running
station and another looking for multiplier) or more stations on the same band and same mode and
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they should keep only one TX signal on this band at any time. Now you can hook up a footswitch to
the LPT port 15 (LPT port should be enabled even though the only purpose for it will be to have a
footswitch, no any special check box to turn footswitch feature on/off). If the station is not in
multi-multi operator category the footswitch will directly control PTT just like Alt+T. If it is a
multi-multi station (connected to other stations on LAN or via the Internet in Multi User mode) it will
be blocking TX of any other station from the group on the same band (and mode if mode category
is "Mixed").

Yes, for now a quite exotic feature.

Two Monitor Support

Original by Joe Natale, K1JN, with major revisions (so don't blame him)

General Two Monitor Operation

Using two monitors is easy and once you have used two you won't want to go back to using one
The operating system (Windows XP or later) takes care of everything. Just think of the two monitors
as one, whether side by side or top and bottom. You only need one mouse and keyboard. The
mouse will move quite smoothly between the two screens. To jump from a program on one monitor
to one on the other, just click a window of the program you want to use. All of the Windows setting
and commands are available to both monitors and can be different for each.

Two Monitor Setup

e Install hardware - Many new computers already have two video outputs on the video card. In
that case adding an extra card with a video output is not needed
o Shut down Windows
o Open the case
o Install a second video card (when needed)
o Attach a monitor
= Any card/monitor will do, they don't have to be same as the one already installed, |
used a Windows 95 era ATl Rage video card and an old Gateway 2000
CrystalScan monitor
o Close the case
e Software
o Start the computer and reboot
o Windows should find the new card and monitor and install the software
= You will get a message on the 2nd monitor that says if you can read this, you can
extend your desktop onto this monitor
o You do that by right clicking on the desktop and click on properties. Click on the settings
tab. There will be icons for two monitors. Click on the one numbered 2 and check the
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box that says extend my Windows desktop onto this monitor
o Drag the monitor icons to set which is left and which is right
= The second monitor is actually an extension of your desktop, it will have the same
wallpaper and color scheme. If you move the mouse cursor off the right edge of
the left monitor, it shows up on the right monitor. The screen saver runs on the
main monitor, but not the 2nd one here

As far as the windows sticking, it varies by program. Luckily, in the case of N1MM Logger, they
stick!
Example Setup

The picture below is a setup example from K1JN during the CQ WPX CW contest.
The left monitor is a 17" set to 1024 x 768 resolution, the right monitor is a 15" set to 800 x 600
resolution.

B |

™7

Left screen windows Right screen windows

Both Bandmaps Packet/telnet window
Log window Info window
Entry window Available mult's and Q's window

Check partial window | Score Summary window

Contest Setup and Configuration

Table of Contents:

1 Station
2 Configurer
3 Start a New Contest Log or Open an Existing Contest Log

Station Dialog

Select Config >Change Your Station Data
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Your Station Dialog window will be similar to this one.

= Edit Station Information

Tip: vou need to bll ot this farm
Call [1pim ar the prograrm. will not perfarm
propery... Alzo, make sure your
Mame [T am computer date and time are set
el bo the LOCAL date and time
Address 301 Box Mountain Drive zone for your location.
Address |
City Iemon State |CT Zip| 05066
Courtry I|_|5,.g.'
Grid Square [FN3ST CO Zone |5 ITU Zone [
Licensze Clasz [Euha Latitude |ﬁgn31 o Longitude 72454193
Station TR [T antec Orion Fower 1500
Artenna 1E31.‘><F| Ant.height 0.g. |25 a.xl {200
ARRBL Section 1|:'|' Facket Mode Call |K'I TTT
Elub 1|Yankee Clipper Contest Club
email address ||
SMTR Server add’i:-:.:-:
Ok, Help Cancel

The information in this dialog is self-explanatory. Be aware that in order for the logger to calculate
accurate beam headings, you will need to put your longitude and latitude into the appropriate fields.
Also make sure that you enter your call as the station call sign. Many of the fields in this dialog are
used when creating contests or during contests, so have them updated with the correct values.

¢ ARRL Section entered and the State field are used in some contests and QSO parties to
determine if you are in or outside a state or province

o Latitude and Longitude are used to calculate the distance and bearing to another
station/country (for HF contests)

e For VHF contests (having VHF in the contest name) the Grid Square field (4 or 6 digit) in the
Station dialog is used as your bearing and not the entered Latitude and Longitude

e Contents of the Latitude and Longitude fields update when the Grid Square field is changed
and vice versa

e Club normally has to be spelled out completely, so not YCCC but Yankee Clipper Contest
Club (the dialog above is just a bad example!) to have it accepted (and counted) by the
contest committee

e E-mail address and SMTP server address are used for sending a bug report via e-mail. Your
e-mail address and SMTP server address can be found in your e-mail program

Help - Show the help file for this window.
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Configurer Dialog
In this Section...

Configurer Dialog
1. Configurer >Hardware tab
1.1. Hardware setup
1.2. Set button examples
1.3. Other Information
1.4. Windows NT/2000/XP (32 bit OS)
2. Configurer >Telnet Cluster tab
3. Configurer >Files Tab
3.1. Files Field Descriptions
4. Configurer >Function Keys Tab
4.1. Function Keys Field Descriptions
4.2. Remapping Function Keys
5. Configurer >Digital Modes Tab
5.1. Digital Modes Field Descriptions
6. Configurer >Other Tab
6.1. Other Tab Field descriptions
7. Configurer >Winkey Tab
7.1. Winkey Field Descriptions
7.2. How to Set Up Winkey in NTMM Logger
8. Configurer >Mode Control Tab
8.1. Mode Control Field Descriptions
9. Configurer >Antennas Tab
10. Configurer >Audio Tab

The Configurer is our name for the tabbed dialog that appears when you click Config on the Entry
Window top menu, and then choose Configure Ports, Telnet Addresses, Other. The Configurer has
many tabs with program settings influencing all aspects of the behavior of the program. Be careful
in setting up items on the different tabs, to be sure that you understand that the option you are
choosing is what you want.

All settings are remembered by the program in "N1MM Logger.ini". Function key definitions, telnet
clusters, call history, and country information are not saved in the .ini file, but in the database that
was in use when you loaded them. That means, for example, that function key definitions loaded or
modified when you are using one database will only appear in that database. You will need to
export them from that database and load them into another database before they would show up
there. The "N1MM Logger.ini" file contains the name of the .mdb file you were last using, which the
program will load when it is started, as well as the name of the current contest and other recently-
opened contests.

If you have not unchecked "Hide extensions for known file types" in Windows Explorer Options, you
will not see "N1MM Logger.ini". You will see "N1MM Logger" with a Type of "Configuration Settings".
Also, do not be confused by the file "N1MM Logger.ini.init". This is used by the program during
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installation. You should not modify this file, because if you ever have to delete your .ini file and start
over (to resolve a configuration problem, for example), it provides the basis for starting a new one

Ld Multiple ini files
You can invoke an ini file whose name is different from N1MM Logger.ini by using the file name
as a command-line argument when the program is started.

For example, suppose you wanted to be able to choose between two separate configurations,
one for SO2R and one for SO1V, perhaps using different radios and with different settings. You
could create two new copies of your N1MM Logger.ini file in the N1MM Logger program folder
and rename them to, for example, SO2R.ini and SO1V.ini.

Create two desktop shortcuts for N1MM Logger by right-clicking in an unused area of the screen
and selecting New > Shortcut. Use the Browse button to find your N1MM Logger program folder
and click on the N1MM Logger.exe file. You will notice that the file name appears in the location
box within quotation marks, e.g.

"C:\Program Files\N1MM logger\N1MM Logger.exe" . Click just to the right of this file name
within the box after the closing " , press the space bar once and add the name of one of your
new ini files, e.g. SO2R.ini

"C:\Program Files\N1MM logger\N1MM Logger.exe" SO2R.ini

Note that if the name of your new ini file contains a space, such as "RTTY SO2R.ini", you will
need to enclose the file name in quotation marks as well, e.g. "C:\Program Files\N1MM
logger\N1MM Logger.exe" "RTTY SO2R.ini"

Click Next, choose a name for the shortcut, e.g. N1MM Logger SO2R, and click Finish. Repeat
this procedure for other specific shortcuts.

Each of these shortcuts will now start up the Logger using the ini file named in the shortcut.
Any configuration changes you make will be stored in the named ini file, thus enabling you to
save different configurations in the two files and to choose which configuration to use by starting
the program from the appropriate desktop icon.

1. Configurer >Hardware tab

The Hardware tab is used to set up your radios, packet interfaces, telnet connections, CW/PTT
/digital ports and the interfaces to other devices, such as SO2R controllers, multi-purpose
interfaces, and keyers, if they require serial or parallel ports. Set the values appropriate to your
station. If you do not have one of the items listed connected to a port, make sure the port selection
is 'None' and the check boxes are not checked for that port.

L Why only 8 COM ports?
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One of the first things people notice when they begin setting up N1MM Logger is that there are
only COM ports 1-8 available. This is a limitation of some of the components used in the
programming, and cannot be changed at this point without a prohibitive amount of effort.

In helping people who say "but my lower-numbered COM ports are all committed to other
things", we have found that it often turns out that some of these ports, though seemingly in use,
are in fact relics of the past. As an example, COM3 used to be the standard port for built-in
modems, and even though those modems have largely gone the way of the dinosaur, many
computers still show COM 3 as committed to that use.

If you are familiar with the use of Device Manager, you can always set up several hardware
profiles, including one for ham radio that deletes the devices that are getting in your way
(printers and so on). That way, you are only a reboot away from being ready to go for radio or
being back in everyday mode.

Sometimes, though, ports will not seem to be committed, but when you try to create virtual
serial ports (with a USB-to-serial adapter, for example) Windows will inexplicably skip some
lower number ports. Ron Rossi, KK1L, has contributed the following note about how to track
down and eliminate these phantoms. Be aware that it involves a little beyond the basic
user-level skills, so ask for expert local help if you're not comfortable with what he suggests.

Often there are ports assigned which no longer have devices connected to them. These are
called "phantom ports". These can be discovered and removed. It may then be possible to move
ports around to accommodate the program.

Here is how to have Device Manager show any "phantom" ports...

Click Start

Click Run

Type cmd.exe in the textbox and click OK

Type set devmgr_show_nonpresent_devices=1 and hit ENTER

Type cd\windows\system32 and hit ENTER

Type start devmgmt.msc and hit ENTER

When the device manager opens, click the View menu

Click Show Hidden Devices

Click on the + sign next to the Ports to see the full list of Com ports being used
Highlight the port you wish to delete and then press delete

CO®NOOAWN=

—

Accept when asked to do so and continue with any more that you wish
to delete.

Here's what the Device Manager looks like before you delete the phantom ports:

Ll Pevice Manager

File Action Vew Help

M EES 2E 8 =R
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Z» Keyboards

Mice and other pointing devices

% Monitors
\> Multifunction adapters

[+ E8 Metwork adapters

\> Mon-Plug and Play Drivers

= Ports (COM &LPT)

el

n_jf Communications Paort (COM1)

4 ECP Printer Port (LPT1)
: ng" ELTIMA Virtual Serial Port (COM1)
- ;" ELTIMA Virtual Serial Port (COM10)

ELTIMA Virtual Serial Port (COMZ)
ELTIMA Virtual Serial Port (COM3)
ELTIMA Virtual Serial Port (COM4)
ELTIMA Virtual Serial Port (COMS)
ELTIMA Virtual Serial Port (COM&)
ELTIMA Virtual Serial Port (COMT)

e rj ELTIMA Virtual Serial Port {COMS)
e ;" ELTIMA Virtual Serial Port (COM3)
e '_7’ MetMaos PCI ECP Parallel Port (LFTZ)
B B rCI Serial Port (COM2)

1.1. Hardware setup

If you want, you can right-click on any of the shaded ports and examine their properties. Each one
will show up as a "device no longer connected to this computer.”
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™ Configurer,

[ Winkey T tode Control T Antennaz T Audio ]

Hardware T Filez T Function Keys T Drigital Modes T Other B
Part Radio Digtal Packet Cw/Other Detail: ¢ S01W ¢ 502 & S02R
Corml I—_| I I 4
Comz I—_| I I 4
Caom3 I—_| v - M DTR=Always O RTS=PTTTx=1
Carmd I—_| ¥ I |_ Sat DTR=Alwapsz O RTS=PTTTu=2
Comb [iore | 7 [ W Set | DTR=Always OnRTS=Alwaps
Comé [Elecraftka  »| 7 17 [~ Set | 3B400N.81.0TR=bhways
Com? [IC7S6PRON ~| T 1 [ Set | 9600N81.DTR=Akways
Com® I—_| I I 4
LPT1 ~d M Pin1 7=Cw FPinl E=PT T Tx=Bath
LPT2 ~d M Pin 7=Cw! Pin1 6=PTTTx=2
LPT3 - _Set |
Telnet Cluster
ABEK. | _Edit]

ITI Cancel Help

The program supports 8 serial ports (COM1 - COM8) and 3 parallel ports (LPT1 - LPT3).
Set up each port depending on what equipment is connected and enter the appropriate information.

¢ Radio - The radio used and controlled by the program using radio control (CAT control).
Select 'None' if no radio is connected to this port for this purpose

¢ Digital - Means this port is used for digital communication (MMTTY/MMVARI engine or TNC)

o Use this to indicate the port that is used for a TU or TNC that is being used for RTTY
o Use it also to indicate the port that will be used for PTT in digital modes
= Exception: if you do PTT on the radio control port or from a Winkey, do not check
the Digital box for that port

e Packet - This port is used for packet radio (TNC) if selected. Do not select if no TNC is
connected for packet radio

e CW/Other - This port is used for CW, PTT, footswitch, DVK or an SO2R controller. This
selection may be made in combination with a Radio, Digital or Packet selection provided the
uses are compatible (e.g. Winkey and radio control cannot use the same serial port, because
both use serial communications)

o Details - The Set button in this column can be used to open a window with a set of controls
depending on what is selected in the preceding columns (Radio, Digital, Packet, CW/Other).
To the right of the details column is a summary of the detailed settings. See below for details

e SO1V - Single Operator 1 VFO i.e. one radio and one VFO used

o In SO1V mode, the backslash, Pause, Ctrl+Right-arrow, grave accent(’) and Ctrl+Alt+K
keys are disabled to prevent opening the second Entry window. If the second Entry
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window and/or Bandmap window were open, they will be closed when exiting the
Configurer after selecting SO1V

e SO2V - Single Operator 2 VFO i.e. one radio and two/both VFO used
o Permits using two separate entry windows, one for each VFO

e SO2R - Single Operator 2 Radio (2 radios used by one operator)
o Permits using two separate entry windows, one for each radio

1.2. Set button examples

. Com/ PE| . Comb P§|

Speed Parity [ ataBitz Stop Bits
| 9600 RMIL =lls =0 =l
DTR [pin 4] RTS [pin 7] |com Code [hex]  Fadio Mr DTR [pin 4] RTS [pin 7] Fadio Mr
\Bhways OFf = | |alwaps DFF = | |BE 2 > | |owaps o+ |dwaps o | Buth  ~
PTT Delay [mzec)
an
[ Allow ext interrupts [~ Radio PTT wia command [ Allow ext interrupts
FoatSwitch (pin 6] fw D“’;‘;‘;zypmtml FootSwitch (pir 6] Cw//PTT Port Addr
Maone - Help m |N|:|ne ﬂ |2F|:| Help

Suggested lcom Settings:

1200 - 19200, M, 8, 1. Always Off, Alwaysz OF, |com Hex Code
IDTR RTS should be Always On with & COM port powered interface,
Set the radio to the zame speed or auto-baud.

Set the radio CI- Tranzceive option to OFF.

Eancel|

i Com3d P§|

Carcel |

OTR [pin 4] RTS [pin 7] R adio Mr Fin 17 Fin 16 Fadio Mr
\Bhways OFf = | |PTT | k ~Ill| =1 =] Buth  ~
PTT Delay [mzec] Dig ‘w'rd Mr PTT Delay [mzec)
a0 0=Mone |1 - a0

[ Allow ext interrupts [ Allow ext interrupts

B Sl 7 L O¥K b otSwitch [pin 15] CW/PTT Part Addr
Nane - Help |Switch Radios « | |378 Help
Mate: When DVE. iz checked, Pin 16 PTT iz disabled for
the zelected R adiolz).

Cancel

Carcel
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COM?7 details shown when Radio selected (serial port)

COMS5 details shown when CW/Other selected for Winkey (serial port)
COMS3 details shown when Digital selected (serial port)

LPT1 details shown when CW/Other selected (parallel port)

There are many more possible combinations than the pictures above are showing.

e Speed - The speed of the serial port to radio/if-interface link (check the manual of your
radio/TNC)
Parity - The parity used (check the manual of your radio/TNC)
Data Bits - The number of data bits used (check the manual of your radio/TNC)
Stop Bits - The number of stop bits used (check the manual of your radio/TNC)
DTR - The following selections can be made (pin 4 on DB9 connector):

o PTT - used for keying the radio

o CW - used for sending CW to the radio

o Always on - DTR is always 'high'

o Always off - DTR is always 'low'

o Handshake - DTR is used for handshaking
RTS - The following selections can be made (pin 7 on DB9 connector):

o PTT - used for keying the radio

o Always on - RTS is always 'high'

o Always off - RTS is always 'low'

o Handshake - RTS is used for handshaking

© Windows 98 Users

If you are having trouble getting your radio working... Windows 98 used to enforce handshake if
the port were set for it even if the application did not request it. Go into the Windows Control
Panel, select the serial port, advanced settings and mark the port for XON/XOFF or "NONE"
handshaking. That should allow receive data from the radio to pass without handshake lines
connected and pulled high.

e Ilcom Addr (hex) - The address for the radio used, enter without the H i.e. 26 not 26H. (This
field is only shown when Icom is the selected radio)
e Radio Nr - The radio controlled from this port
o In SO1V (one radio, one VFO used) Radio Nr = 1
o In SO2V (one radio, two VFOs) Radio Nr = 1
o In SO2R select the radio (1 or 2) connected to or controlled by this port
= If one LPT "CW/Other port" is set up as Radio=Both, and another LPT "CW/Other
port" is set up as Radio=2, route band data for second radio to second port
= When using CW/Other with an external SO2R controller the lowest numbered
(first) LPT port must be assigned RADIO=BOTH (toggles pin 14)
» |.e. When using LPT-2 and LPT-3 then LPT-2 must have Radio=Both
e Dig Wnd Nr - Set this to indicate which Digital Interface window uses this port for PTT and/or
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FSK keying (only shown when Digital is checked)
o If only one DI window is used, select 1
o If two DI windows are used, select the DI window number this port will be used for
o If the port is being used for FSK keying, you will also have to configure it in the MMTTY
Setup window
e PTT Delay (mSec) - The time between keying the radio and starting to send CW, a wav file or
transmit a digital mode (only shown when PTT or Winkey selected)
e Radio PTT via command - Select when using a software command via the control link to the
radio to key PTT.

¥ Use only one PTT Method at a Time

Do not select PTT via DTR or RTS in addition to Radio PTT via Command. Whether on
the same port or another, doing so can result in conflicts that may cause PTT
lockups or other malfunctions. If these occur, a first troubleshooting step is to verify that
you do not have more than one PTT method checked.

When checked, the radio will be set to transmit 40 milliseconds (default) before beginning the
message, this is configurable using 'PTT delay (mSec)'

o Allow ext. interrupts - Allow external interrupts from this port (serial port - DSR pin 6; parallel
port - pin 15), e.g. from a footswitch. An interrupt on this line will bring focus to the Entry
window and stop a CQ in progress

e Winkey - Select when using a Winkey keyer. Speed, Parity, Data bits, Stop bits or Handshake
settings do not have to be adjusted; they are fixed and set by the program. Settings for the
keyer can be done on the Winkey tab in the Configurer. If you select Winkey, DO NOT set
DTR to CW.

o Not possible if the port is used for radio control, digital or SO2R control (incompatible
uses)
o Note: Only one Winkey is supported, but a single Winkey can key two radios

¢ Two Radio Protocol - Support for the MK2R or other SO2R controller from microHAM (using
control protocol on COM port). USB-only SO2R (no LPT port required) with the MK2R/MK2R+.
Protocol used may be either the MK2R proprietary protocol or OTRSP (Open Two Radio
Switching Protocol)

o Disabled when selection for CW/Other is turned off or when a radio is selected

o OTRSP forces the port speed etc. to 9600,N,8,1

o More info in chapter Supported Hardware under MK2R

e CW/Other Port Addr - specify port address for serial and parallel ports

o Note: For real ports, the address here should be the same as used for this port in
Windows

o For USB-to-serial adapters, the address here can be ignored

o When both RTS and DTR are set to PTT they will both be keyed for PTT with the set
PTT delay

o Packet uses as handshaking RTS + XON/XOFF

o When using a self-powered interface set the handshaking to always on (DTR), always
on (RTS) to supply power to the interface
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©@ LPT Port Numbers

With NTMM, SO2R and LPT CW, the LOWEST number port must have the CW output for
BOTH radios if it is used with a conventional LPT SO2R box (DXD, KK1L, N6BV, etc.) or
microHAM MK2R/MK2R+ in LPT (Classic auto control) mode, The LPT with CW, PTT and the
TX/RX/Split controls must be connected to the SO2R controller. If NTMM is configured for CW
on TWO LPT ports (first port: Radio=1, second port Radio=2) then CW will be present only on
the port representing the radio with transmit focus.

e DVK - DVK interface for MK2R, WOXT & other DVK's. Also recording is supported by the
program

o When DVK is selected, the Antenna selection via the LPT port is disabled

o Note: The DVK pins and the antenna pins on the LPT port overlap

o When using an external DVK, all of the Run and S&P SSB function keys should be set

to empty.wav and not left blank

o microHAM MK2R: if DVK is checked, N1MM Logger will use the DVK in Router instead of

its own DVK support
e FootSwitch mode - Pin 6 on the serial ports and pin 15 on parallel ports. The combo box
options are:

o None - No footswitch

o ESM Enter - Pressing Footswitch will cause the same action as pressing Enter key in

ESM mode

o Typing Focus - Pressing Footswitch will switch typing focus

o Switch Radios - Pressing Footswitch will switch the radios (in SO2R)

o Normal - Pressing the footswitch it will behave if it was connected to the PTT of the
active transmitter and is automatically connected to the proper (active) radio.When the
footswitch is released the focus will be set to main Entry window
F1 - Pressing Footswitch will cause the same action as pressing functionkey F1
F2 - Pressing Footswitch will cause the same action as pressing functionkey F2
F3 - Pressing Footswitch will cause the same action as pressing functionkey F3
F4 - Pressing Footswitch will cause the same action as pressing functionkey F4
F11 - Pressing Footswitch will cause the same action as pressing functionkey F11
F12 - Pressing Footswitch will cause the same action as pressing functionkey F12
Band lockout - Implemented mostly for multi user stations to block second signal on
the same band/mode. It may be useful for single user as well. This mode should allow
you to control PTT for both radios (in case of SO2R) in different modes (SSB/CW). The
advantage of using it (compared to the foot switch directly connected to the radio) is - it
stops AutoCQ and Dueling CQ's

O O 0O O O o O

It is possible to hook up a footswitch to a serial or parallel port. This should help users with only one
or no serial ports (when a USB to serial adapter is used) to get the footswitch connected to the
computer. A pull up resistor is needed between DSR input (pin 6 on both DB9 and DB25) and +12
VDC and for the parallel port, between pin 15 and +12 VDC. Multiple footswitches (one per parallel
or serial port) can be used where different settings may be used for each one.
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1.3. Other Information

It is possible to have the PTT on the same serial port as the radio with interfaces that support this
(e.g. with a keying circuit connected between RTS and the radio's PTT input).

If the type of CW/Other port chosen is LPT1, LPT2 or LPT3, additional information will be present
on the parallel port. See Radio Interfacing for more detailed info.

1.4. Windows NT/2000/XP (32 bit OS)

Under 32 bit Windows operating systems, using the parallel and the serial ports requires a special
dll which will be installed using the program: Port95nt.exe. A link to this file can be found in the
Installation chapter.

2. Configurer >Telnet Cluster tab

o Telnet Cluster - The default telnet cluster to connect in the Telnet Window
o Ctrl+D - delete a row in the table or use right click menu
e Edit button - Change Telnet Cluster List
o File
= Import... - Import a text file with Packet/Telnet cluster nodes into the program
= Export... - Export the the Packet/Telnet cluster nodes to a text file

3. Configurer >Files Tab
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= Configurer

[ YWinkey T tode Control T Antennaz T Audio ]

Hardware T Files T Function k.eys T Drigital Modes T Other

Callzign databaze path
[SCallDB,

Recorded way file path
|E:'xF'rcugram Filez\M 1k k4 logger',

Letters file path
|E:'xF'rcugram Filez\M 1k b logger',

QK. I Cancel I Help

The files Tab is used to set the path to the Buckmaster callsign database if present, and to wav files
used for SSB message macros.

3.1. Files Field Descriptions

o Callsign database path - Used to identify the directory of the Buckmaster callsign database
to be used by the logging program. Be sure to include a trailing '\" in the directory name. Make
sure that the path to the CD is set correctly. You can set the path to the Buckmaster database
here and type in the full path to the Buckmaster database on your CD. For example: If your
CD-ROM is mapped to the 'E' drive, the full path is: E:\HAMO\

o Don't forget the back-slash '\' at the end of the path! Also, make sure to copy the
HAMCALS32.DLL from the CD to the program directory where N1MM Logger is installed.
On older CDs, this file is located in the \AAPNWINDOWS directory. It may be located
elsewhere on newer CDs

¢ Recorded wav file path - The full path where the recorded wav files should be placed on
your harddisk. In this path the directory with the contest name will be created

o Letters file path - The full path to the letters directory. Example: C:\program Files\N1MM
Logger\wav\{operator}\ This provides the ability to have a separate letters file for each
operator. The decimal point (.) should be specified as Point.wav
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4. Configurer >Function Keys Tab

™ Configurer,

[ Winkey T tode Control T Antennaz T Audio ]

| DigtalModes |  Other

Hardware T Filez

r Monitor via PC Speaker
[tAin93ME only]

= Send Carrected Call v StDp_Sending CO when
[Eefore End of Q50 Msg] Callzigh changed

ESH only zends your call once in S&F,
then ready to copy received exchange

[ Send leading zeros in zenial numbers

[v Send partial calls

. Ii String to uze on cw between
v Wark Dupes when Funning hiz zall key and exchange key
Use Contest word Soaci [default iz one gpace]
ze Contest Word Spacing
v fiar Chaf 186 K.eyoode of Ing Key Substibute
[ Send Cut Mumbers 222 K.epcode of TU /Log K.ey Substitute

b ake sure that the key mappings defined below match the contents of the keys az defined in
Config/Change Cw' buttonz, Config/Change 558 Buttons and Config/Change Digital Buttons.

CO Key End of S0 Kep by Call Kay Again Key Mext Call Key
|F-I ﬂ |F3 ﬂ |F4 ﬂ |FB j |Disabledﬂ
Ewchange Key Hiz Call Key 050 B4 Key Cut Mumber Style (if enabled]

[F2 ~ [ R | | 71234567890 (leading T] |

QE. | Cancel | Help

Function keys for each message are set here.

4.1. Function Keys Field Descriptions

e Monitor via PC speaker (Win98/ME only) - The CW sent by the program plays via the PC
speaker (only for Windows 95, 98, ME, disabled for NT/2000/XP machines)

e Send Corrected Call (Before End of QSO Msg) - Send Corrected Call (Before End of QSO
Message) - If the callsign is corrected after answering a call, then the corrected call will be
sent before the End of QSO message (as configured by the End of QSO Key). E.g. 'PA1M TU
DE N1MM' instead of 'TU DE N1MM'

e Send Partial Calls - Only CW. When sending a partial corrected call only the corrected part
will be send (prefix or suffix). If not checked the whole call will be sent

¢ Work Dupes when Running - Work dupes is for ESM in Run mode and don't send the QSO
B4 Key. All it does is determine what is sent when a dupe calls you AND YOU PRESS
ENTER. Normally you do want to work dupes. See the chapter Off topic for a discussion

¢ Use Contest Word Spacing for CW - The box is defaulted ON for "Use Contest Spacing for
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CW". This setting changes the spacing between words in your CW, where "N1MM 599 5" is 3
words. Default is 6 bits for "contest spacing". When box is not checked, 7 bits between words
is used, which is "normal spacing"

e Send Cut Numbers - Ctl+G is cut number mode toggle. This is a toggle function and the new
status is shown on the bottom left of the entry window. The cut number style can be set at the
bottom of this dialog. The characters that can be entered into a serial number field are: A, N,
T,0, E, S, U, W, G, and D. Some contests do not use a serial number field due to length or
because the exchange can contain characters. In these contests the conversion from letters to
numbers will not function

e Send leading zeros in serial numbers - Send leading zeros to make into 3 digit number. In
CW: Select leading T with the Cut Number Style selector. RTTY: In RTTY zeros will be added,
so 1 will become 001

e Stop Sending CQ when Callsign changed - Typing a character in the callsign field will stop
a (repeated) CQ

e ESM only sends your call once in S&P, then ready to copy received exchange - This is
many times called the "Big Gun versus Little Pistol switch" . When selected and in Enter
Sends Message mode the cursor moves to the Exchange field when there is something in the
Callsign field and Enter is pressed (so it does not keep the cursor in the callsign field). If you
don't usually get a station on the first call then deselect this option

e String to use on CW between his call key and exchange key (default is one space) - Just
as it says. Example ' ur'

o Keycode of Ins Key Substitute - Enter the number for the Ins Key substitute as mapped
below in this configurer dialog. Defaults to 186, the ; character. The program can
automatically enter the keycode in this field . Place the cursor in the keycode field and press
the key you want to substitute, it will put the correct keycode in. 186 is an extended key code.
Not all keyboards map keys the same way. Note that you can't use a Shift, Ctrl, Alt etc. key. |
would not advise using a key like Numeric + that is already in use. It may or may not work. In
this case Numeric +, does NOT work

o Keycode of TU/Log Key Substitute - Enter the number for the TU/Log Key substitute as
mapped below in this configurer dialog. Defaults to 222, the ' character. The program can
automatically enter the keycode in this field . Place the cursor in the keycode field and press
the key you want to substitute, it will put the correct keycode in. 222 is an extended key code.
Not all keyboards map keys the same way. Note that you can't use a Shift, Ctrl, Alt etc. key. |
would not advise using a key like Numeric + that is already in use. It may or may not work.
This particular case (Numeric +) does NOT work

e Cut Number Style - the following cut number styles can be chosen:

o T1234567890 (leading T) - leading O will be replaced with a T. So 007 will become TT7
and 030 will become T30

o0 01234567890 (leading O) - leading 0 will be replaced with a O. So 007 will become OO7
and 030 will become O30

o T123456789T (all T) - all zeros will be replaced with a T. So 007 will become TT7 and
030 will become T3T

o 01234567890 (all O) - all zeros will be replaced with a O. So 007 will become OO7 and
030 will become O30

o T12345678NT (TN) - all zeros will be replaced with a T, all nines with a N. So 097 will
become TN7 and 090 will become TNT

o T12345678NT (ON) - all zeros will be replaced with a O, all nines with an O. So 097 will
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become ON7 and 090 will become ONO

o TA2345678NT (TAN) - all zeros will be replaced with a T, all nines with a N, all ones with
an A So 091 will become TNA and 190 will become ANT

o TA234E678NT (TAEN) - all zeros will be replaced with a T, all nines with a N, all ones
with an A, all fives with an E So 091 will become TNA and 1590 will become AENT

o TAU34EG67DNT - the zero, one, two, five, eight, nine s will be replaced with a T, A, U, E,
D,NorT

4.2. Remapping Function Keys

Select which function keys to send messages. Each type of message has a combo box for you to
set the appropriate function key. If the program is sending the wrong message check here first. The
only restriction is that a key must mean the same thing in Running and in S&P. Function keys do
not have to be unique for a selected message. There is little reason to do so although if you want it
can be done. For the following messages a function key can be selected

e CQ Key - defaults to F1

Exchange Key - defaults to F2

End of QSO Key - defaults to F3

His Call Key - defaults to F5

My Call Key - defaults to F4

QSO B4 Key - defaults to F6

¢ Again Key - defaults to F8 (can be disabled)
¢ Next Call Key - defaults to Disabled

ESM |Work Mode QSO B4 Again | Action Result action

Mode dupes Key Key
when
running

On don'twork |Run |Disabled F-key DUPE callsign Send AGN message when
dupes entered Enter pressed

On don'twork |Run |Disabled Disabled DUPE callsign Send the EXCH when Enter
dupes entered is pressed, station will be

worked and logged with
Enter, Enter

On don'twork | S&P |Disabled F-key DUPE callsign Pressing Enter does nothing,

dupes entered no blue buttons in the Entry
window
On don't work |S&P |Disabled Disabled DUPE callsign Pressing Enter does nothing,
dupes entered no blue buttons in the Entry
window
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On

On don't work
dupes

On -

work dupes | Run | -

Disab

Run |- Disab

S&P | - Disab

5. Configurer >Digital Modes Tab

™ Configurer,
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led DUPE callsign Send EXCH when Enter is
entered. Mistake | pressed
with received QSO
data

led Mistake with Send EXCH when Enter is
received QSO pressed
data

led Mistake with Send EXCH when Enter is
received QSO pressed. After the user
data corrects the entry, it will log

and not send anything

[ Winkey T tode Control T Antennaz T
Hardware Filez T Function Keys T igi Other
Diigital Interface 1 Crigital Interface 2 — DI-1 MBTTY Setup [If used]
TU Type TU Type MMT T Mode: " AFSE + FSE
|5|:uunu:||:aru:| ﬂ |S|:uunu:||:aru:| ﬂ MMT T Pathe
Speed Speed C:\Program Files\MMTTYADITAMMTTY.EXE Select
| ; J | ; J Df-2 bR T T Setup [If used]
| Parity =il Parity = MMTTY Mode: AFSK (& FSK
Data Bits Data Bits MMTTY Path:
| J | J |E:'xF'ru::gram Files\MMTTYSDIZAMMTTY.EXE  Select
Stop Bits Stop Bits DI-1 Fldigi S etup (I used)
| =1 | || Fidigi Path:
Flows Control Flaws Control |C:4Program Files\Fidigi-3. 20, 284digi exe Select
| J | J DI2 Fldigi Setup [If uzed)
Fldigi Path:
Mote: Any Changes |C:4Program Files\Fidigi-3. 20, 284digi exe Select
m_ade in _thls section
will require the digital 5 4 y4mp) Senp DI-2 MMVARI Setup
window's to be clozed _ _
and re-opened before MYARI BTTY Mode:  FSKPort MYARI BTTY Mode:  FSEPort
changes take effect. |  AFSK &+ FSK |[FSskoos - 0" AFSK f« FSK IFSkazs - ||
QE. | Cancel | Help

The Digital modes tab is used to set up the interfacing to external Controllers (TNCs), or for PTT
control using MMTTY/MMVARI for sound card digital modes.

In SO1V mode, there is only one Digital Interface window, DI-1. In SO2V and SO2R modes, there
are two Digital Interface windows, DI-1 and DI-2. Each DI window is associated with one of the two
Entry windows. Each DI window is opened from the Window > Digital Interface menu item in the
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corresponding Entry window. The Digital Modes tab in the Configurer is used to configure both
Digital Interface windows.

5.1. Digital Modes Field Descriptions

Digital Interface 1/ 2
o TU type
= None
= Other: like the KAM, PK232, PTC and any other external TNC
= Soundcard: when using MMTTY or MMVARI soundcard software

o Port, Speed, Parity, Data Bits, Stop Bits, Flow Control - Have to be set if 'CW/Other'

has been chosen as well
DI-1 MMTTY Mode | DI-2 MMTTY mode

o When using MMTTY, select whether AFSK or FSK is being used

o If AFSK is selected the serial port (if any) with a check in the Digital check box and with
Dig Wnd Nr corresponding to the DI window number will get passed to MMTTY when the
DI window is opened, so that MMTTY can use it for PTT control.

o If FSK is selected the serial port will not get passed to MMTTY. The serial port for FSK
has to be set in the MMTTY Setup. This is necessary in order to allow for the possibility
of using EXTFSK in MMTTY. More information in the MMTTY support chapter

DI-1 MMTTY Path | DI-2 MMTTY Path

o The path to the MMTTY engine goes here including the file name of the program

o It's not necessary that MMTTY be in the same directory as N1MM logger

o Via the 'Select' buttons the path and file name can be selected

o Itis possible to select two instances of MMTTY in two separate folders. You must do this
if you want the MMTTY settings in the two instances to be different (e.g. left vs. right
channel, different sound cards, etc.)

DI-1 Fidigi Path | DI-2 Fidigi Path
o The path to the Fldigi engine goes here including the file name of the program
o Via the 'Select' buttons the path and file name can be selected

DI-1 MMVARI RTTY Mode | DI-2 MMVARI RTTY Mode

o When using MMVARI for RTTY, select whether AFSK or FSK is being used

o If AFSK is selected the serial port (if any) with a check in the Digital check box and with
Dig Wnd Nr corresponding to the DI window number will get passed to MMVARI when
the DI window is opened, so that MMVARI can use it for PTT control

o If FSK is selected, the port to be used for PTT control is defined in a separate setup
window

DI-1 MMVARI FSKPort | DI-2 MMVARI FSKPort

o Choose FSK8250 if you are using a true serial port or a device that can simulate a serial
port and handle 5-bit codes at 45.45 baud (this does not include most USB-to-serial
adapters, but it does include some commercial interfaces designed to support FSK
RTTY)

= When MMVARI is opened for FSK RTTY, a small window labelled FSK8250/16550
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1.03 will open, or appear on the Windows Task bar. In this window you select the

COM port number and the signal line to be used for PTT (RTS or DTR). FSK

keying will be done on the TxD line. If this is a USB device that simulates a serial
port, check Limiting speed. You can use the _ box at the top right to minimize this
window after completing the setup

o Choose EXTFSK if you are using a regular USB-to-serial adapter

= When MMVARI is opened for FSK RTTY, a small window labelled EXTFSK 1.05a
will open, or appear on the Windows Task bar. In this window you select the COM
port number and the signal lines to be used for FSK keying (normally TxD) and
PTT (RTS or DTR). You can use the _ box at the top right to minimize this window
after completing the setup

6. Configurer >Other Tab

™ Configurer

[ Winkey T tode Control T Antennaz T Audio ]

Hardware T Files T Function Keyz T Digital Modes T
FPacket Spaot Timeout [mirn] 55B Tuning Tolerance [Hz) S5B Up/Diown Arrow Incr [kHz)
50 1300 0.10
Cuwf Tuning Tolerance [Hz) Cif Up/Drovan Ao [ncr [kHz]
1300 0.0z
Repeat time in millzecs: RTTY Tuning Talerance [Hz) Palp/Paln Iner [kHz)
11600 1300 110.00
Default # Spots in SHADEMA — Cw Weight Friman Cw Speed Step
|30 |50 2
Secondany Cw Speed Step
4

[ Clear populated exchange on callzign change
[v FKeeplogof all 150z to facilitate recoveny of log
[ Start Contest Beporting Application

[ Mute mic on supported radioz

[ Faormat for DS pider Cluster
[ Auto-Completion Mode
[ Uze Reverse CW

ok |

Cancel | Help

The Other tab is used to set up default values and select special modes and functions.

6.1. Other Tab Field descriptions

o Packet Spot Time (min) - Indicates how long (in minutes) spots are kept in the bandmaps.
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The default is 60 minutes, any integer may be specified

Repeat time in millisecs - Specify the repeat interval (CW or SoundBlaster) in the Entry
window (Auto-CQ). The default value is 1.8 seconds. Enter a value in seconds or milliseconds.
The maximum value is 32767. This is the same as Ctrl+R or 'Config | Set CQ repeat time' in
the Entry Window

Default # Spots in SH/DX/# - The number of returned spots by the SH/DX command in the
bandmap window. The default value is 30 spots. The number of returned spots for the SH/DX
command in the Packet / Telnet window is not affected by this value and has to be changed in
the Entry window under 'Config menu | Edit Packet/Telnet Buttons'

SSB Tuning Tolerance (Hz) - SSB mode: Clicking on or next to a station in the bandmap
window will put the call on the callsign frame (if the callsign field is empty) of the Entry
window. This value gives the maximum frequency distance to the call on the bandmap when it
will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The
default value is 300

CW Tuning Tolerance (Hz) - CW mode: Clicking on or next to a station in the bandmap
window will put the call in the callsign frame (if the callsign field is empty) of the Entry
window. This value gives the maximum frequency distance to the call on the bandmap when it
will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The
default value is 300

RTTY Tuning Tolerance (Hz) - RTTY mode: Clicking on or next to a station in the bandmap
window will put the call on the callsign frame (if the callsign field is empty) of the Entry
window. This value gives the maximum frequency distance to the call on the bandmap when it
will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The
default value is 300

CW Weight - Adjusts the CW weight (between 30-70% limits). The default value is 50. Thie
weight command not only works for serial or Ipt CW but also for Winkey

SSB Up/Down Arrow Incr (kHz) - This value gives the frequency jump amount in SSB by the
up/down arrow keys. NB. Never make it smaller than the smallest step your radio can make in
SSB. Older Icom rigs are known to have a smallest step of 100 Hz which is quite big. When
the step is made smaller than the minimum step size the Up/Down Arrows don't seem to work.
Also controls the amount of each frequency change when tuning the RIT on radios that
support doing so from the computer.

CW Up/Down Arrow Incr (kHz) - This value gives the frequency jump amount in CW and
digital modes by the up/down arrow keys. NB. Never make it smaller than the smallest step
your radio can make in CW. Most rigs have a smallest step in the order of 10 Hz. When the
step is made smaller than the minimum step size the Up/Down Arrows don't seem to work.
Also controls the amount of each frequency change when tuning the RIT on radios that
support doing so from the computer.

PgUp/PgDn Incr (kHz) - This value gives the frequency jump amount for the {PGUP} {PGDN}
macros (Note: the PgUp and PgDn keys are not used for this; the {PGUP} and {PGDN}
macros must be used in function key macros. These macro names are holdovers from early
versions of the program)

Primary CW speed Step - The primary speed step is used with PgUp/PgDn button or the
speed adjust in the Entry Window

Secondary CW speed Step -The secondary speed step is used when Shift+PgUp/PgDn is
pressed. Alt+PgUp/PgDn adjusts the CW speed of the inactive radio/VFO in SO2R/SO2V
mode
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o Clear populated exchange on callsign change - When selected (default is Off), if the
callsign in the Entry window is changed by the operator, this option clears the contents of
exchange fields in the Entry window that were populated (filled in) from a CallHistory file, from
previous QSOs in the contest, or from a Telnet spot. Does not affect exchange data that have
been manually filled in.

o Keep log of all QSOs to facilitate recovery of log - This is the transaction back-up log file.
This journaling back-up text file has all QSOs from the contest in it. So if the database for
some reason would become corrupt it is possible to import this file in a new database and go
on with the contest

o When this option is selected the transaction log is created for each contest you log to
o The file is closed after each transaction and reopened to force the data to be written to
disk
o To keep things simple and foolproof, you are not allowed to change the name of the
transaction log
= The name is used to make sure you are loading it properly, and to prevent mixing
logs of two contests
= Example name: 'ham.mdb - CQWWCW - 2005-09-19.TRN' i.e.: Used database
name - contest name - date log created
o When importing you MUST import the transaction log into an NEW (empty) database
= Why? To prevent a user recovering from a database problem making the problem
worse. This will prevent any issues from duplicate contacts and a number of other
problems
= Use 'File, Import, Recover QSOs from a Transaction Log' to import the transaction
log file
o As you load the transaction log, a new transaction log is automatically made with the
transactions in the first log. Thus you should never have to merge logs. You always use
the last one

o Start Contest Reporting Application - Start the contest reporting application. With this
application you can show your contest efforts in real time during a contest to the world. Next
to this application a website is needed where everyone can see the score. This application
does automatically upload scores from the current selected contest to the configured website

e Mute mic on supported radios - Mute the microphone during transmit. Normally used to
enter audio via an other radio input then the microphone. Default is to not mute

o Tentec Orion: If "Mute" is checked, it causes the Orion's mic input to be muted and the
Aux input to un-mute during voice keyer events
o Supported radios are: Tentec Orion and Elecraft K3

o Format for DXSpider Cluster - This will send the right SH/DX message for DXSpider clusters
from the button in the top of the bandmaps (Example: SH/DX/30 on 20). Also SH/QRZ will be
sent instead of SH/BUCK. Only select this when connecting a DXSpider cluster. Connect the
cluster and send: SH/VER A DX-spider cluster will say something like: DX Spider Cluster. The
'normal’ setting is not selecting this option

¢ Auto-Completion Mode - Auto-completion of callsigns. It works like Internet Explorer's
address bar. If you type in a partial callsign, the program will attempt to match it with a call
that you have already logged or is uniquely identified in the check window. If it matches, the
rest of the call will be added to the callsign textbox and highlighted. You can then either
accept the call as displayed, or keep typing. If you keep typing, the highlighted portion will be
replaced by what you type
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e Use Reverse CW - When selecting CW send a command to the radio to use Reverse CW

7. Configurer >Winkey Tab

™ Configurer,

[ Hardware T Filez T Function KE_','ST DigitaIMDdes]_T Other

Winkey: T tode Control T Antennaz T Audio

lambic 2 | Keying Mode v Autozpace

[ Pat iz wired with bwo leads
Winkey Winkey 2
PTT | Pin & Function [~ Sidetone [ Use 2nd Output

469 | Sidetone Frequency v Paddle only sidetone

[ Reverze Paddles
[ lgnore “Winkey Speed Pot

1 Lead Time [0-250] x 10 msec
1 Tail Time [0-250] = 10 mzec
0 First Character Estension [0-250] in meec

0 K.eving Compenzation [0-250] in mzec
1.00 »| Hang Time

QE. | Cancel | Help

The Winkey tab is used to control functions of the K1EL Winkey keyer chip. Winkey is designed by
K1EL and G3WGV. It is only active when the Winkey box has been checked on a serial port,
and that port (whether real or virtual), has been connected either to a stand-alone keyer or to
a device that embeds the Winkey chip, such as various MicroHAM products and RigExpert.

Consult your unit's manual along with the Winkey chip manual for more information on these
settings.

Winkey is fed ASCII characters from N1MM Logger (via COM or USB Ports), and converts the ASCII
to timed CW. For more info see the links page and the Supported Hardware page. The pot speed
range is from a minimum of 10 wpm to a maximum of 55 wpm. Winkey can also be used to control
PTT. Winkey PTT can be used on modes other than CW. Note: This only works for Winkey versions
10, and 21 and greater.

7.1. Winkey Field Descriptions
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o Keying Mode - Select the keying mode. Choices are: lambic A, lambic B, Ultimatic and
Semi-Automatic. The default is lambic-B
e Autospace - Select when the autospace feature should be used. When using the paddles to
send, if a pause of longer than one 'dit' time is detected, THREE dit times of pause will be
inserted before the next character. See the manual for more information
¢ Pot is wired with two leads - Select when the potentiometer on the board is wired only with
two instead of three wires. Under normal operation, leave unchecked. Unless you've built the
keyer yourself, or your keyer vendor recommends this, leave unchecked
e Pin 5 Function - Select the function of pin 5. Unless your keyer's manual tells you otherwise,
the default of PTT is likely what you want here. Other choices include PTT, Sidetone, 2nd CW
(second output) or None. The Winkey manual is also a good reference. The choices are:
o PTT (default)
o Sidetone
o 2nd CW (second output)
o None
o Sidetone Frequency - Select the sidetone frequency. The default sidetone frequency is 469
Hz
* Reverse Paddles - Reverse the left and right paddle
¢ Ignore Winkey Speed Pot - Ignore the setting of the Winkey potentiometer
¢ Lead Time - Set the lead time value in 10ms Increments (up to 2.55 seconds). This value
reflects the amount of time that the Winkey PTT will be asserted BEFORE keying commences
o If when sending CW you are missing the first dot or dash, or if paddle-sent CW doesn't
seem responsive (again, missing the first character) set this to at least 10 mSec
o NOTE that this field denotes 10 mSec intervals — '1" in this box means 10 mSec
o |IF Pin 5 function is set to PTT, set this value to at least 1 (10 mSec)
¢ Tail Time - Sets the tail time in 10 mSec Increments (up to 2.55 SECONDS). This value
reflects the amount of time that the Winkey PTT line will be held after keying stops. Tail Time =
1 results in a tail time of one dit time (v2.2; 10 msec in earlier versions of Winkey), Tail Time =
2 adds 10 msec to that, Tail Time = 3 adds another 10 msec, and so on. If Tail Time is set to
zero, then Hang Time is used instead
¢ First Character Extension - Sets the extension time in 10 mSec steps (up to 2.55 seconds).
Normally ONLY used with older, slower-keying rigs at speeds above 25 wpm, this setting will
add time to the first element sent to help with the lack of T/R speed of those rigs. This value is
usually set by experimentation. See the Winkey manual for more information on setting this
value
¢ Keying Compensation - Normally only used with high speed (>30 wpm) QSK operation.
Adds time (in 1 mSec increments) to both dashes and dots to adjust for rig switching delays
(however slight). See the Winkey manual for more information
e Hang Time - Provides a CW-Speed dependent means of holding PTT after CW sending is
finished. Hang Time can be used to set a CW-speed dependent delay of 1, 1.33, 1.67 or 2
letterspaces (not dit spaces). Tail Time must be set to zero to use Hang Time
e Winkey 2
o Sidetone - Gives a sidetone when sending CW (when using paddle and computer
input)
o Paddle only sidetone - Gives a sidetone only when sending by paddle
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o Use 2nd output - Use the second output from the Winkey 2

© Setting CW Speed in Winkey

The CW sending speed can be changed to any value by typing over the provided field in the
Main Entry window. Using the scroll bars on the CW speed entry field, or using the speed
control connected to the Winkey chip changes the speed in 2 wpm steps.

Setting the speed using the speed control pot changes BOTH the paddle speed and the N1TMM
sending speed. Setting the speed using the entry window changes both the paddle sending
speed and N1MM sending speed but ONLY UNTIL the next time the speed pot is adjusted, i.e.
the absolute position of the speed pot then overrides any changes made in the entry window.

© Setting CW Weight in Winkey
CW weight for Winkey can be set up on the Other tab using the same 30-70% limits.

7.2. How to Set Up Winkey in N1MM Logger

Identify the port to control it. Check " CW/Other" on that port. Click Set. Check Winkey. Now go to
'Config|Configure ports, CW/Other', and on the Winkey tab, make the relevant choices. The only
subtlety is that if you are using Winkey's PTT you need to set a lead-time value of other than zero,
and a tail time or hang time value as desired (e.g. sufficient to make Winkey hold in between
characters of hand-sent CW). That's it.

8. Configurer >Mode Control Tab
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™ Configurer,

[ Hardware T Filez T Function KE_','ST DigitaIMDdes]_T Other

winkey | fMode Controf Arternas | Audio

tode recorded in log tode sent to radio

¢ |ze radio made [default] Mode Radio 1 /%FO0A  Radio 2 /%FOB
" Follow band plan RTTY o |aFsk  «| [RTTY ]

" Usze contest mode or bandplan

" Uze contest or radio mode Pk to ||jSK ﬂ |'&'FSK'H ﬂ

" Always: RTTY =

QE. | Cancel | Help

The mode control tab determines how the mode will be controlled on the connected radio,
whether the program sets the mode when changing frequency or not, and what mode it changes
it to. This dialog also gives you control over how contacts will be logged.

8.1. Mode Control Field Descriptions

e Mode recorded in log - Set how to determine the mode that will be entered in the log
o Use radio mode (default) - use the mode received from the radio
= In digital modes, the mode in the log will be RTTY if using the MMTTY engine or a
TNC
= When using the MMVARI engine, the mode will be as selected in the MMVARI
window
o Follow band plan - use the mode the internal bandplan gives for this frequency
o Use contest mode or bandplan - if the contest is a single mode, use that mode. If
mixed, use the bandplan (as above)
o Use contest or radio mode - if the contest is a single mode, use that mode. If mixed,
use the mode from the radio (as above)
o Always: - always log the mode selected here (CW, SSB, RTTY, PSK31, PSK63,
PSK125)
¢ Mode sent to radio - Select how to determine the mode sent to the radio
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o This applies only for digital modes. See the note below for details

© Digital Mode Selection

Every radio seems to have a different range of choices and names for digital modes. Some
radios have no modes specialized for digital modes, some have only one digital mode for FSK
RTTY (for sound-card digital modes, you use USB or LSB), some add to this a separate mode
intended for sound-card digital modes like AFSK RTTY and PSK31, and some radios have three
separate digital modes for FSK RTTY, AFSK RTTY, and other sound-card digital modes like
PSK31. There may also be two versions of each of these, one "normal" and one "reverse"
(opposite sideband). Every manufacturer uses different names for these specialized modes.

For simplicity, NTMM Logger has its own radio-independent terminology. The Logger uses
RTTY for the radio mode normally used for FSK RTTY (which is usually but not always called
FSK or RTTY on the radio). If the radio has a mode that is designated for AFSK RTTY, the
Logger calls it AFSK. AFSK-R is the "reverse" of this AFSK mode, i.e. on the upper sideband
instead of LSB. If there is a mode intended for sound card data modes that is different from the
AFSK-R mode, it will be called PSK in the Logger. Not all radios have all of these modes, so not
all choices will necessarily be available, depending on what radio(s) is/are configured.

The translation between the mode name used on the radio and the mode name used in NTMM
Logger is described at Click here to see the table

For RTTY, if you are using FSK, you should normally select RTTY. If you are using AFSK, you
should normally select AFSK or LSB/USB, depending on whether your radio offers a specialized
AFSK mode or not.

For PSK, the choice would normally be one of: PSK (if available), AFSK-R (on some radios), or
USB.

9. Configurer >Antennas Tab
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™ Configurer,

[ Hardware T Filez T Function Keys T Digital Modes Other
Winkey | ModeContol | Antennas | Audio

Code [Antenna Bands [1.8. 3.5, 7...1|Rotar Partlz] 1, 2, 3.1 |Offset [Bidirect
1] 160 1.8 1]

1 an 35 1]

2 40 7 1]

3 Tribander 14.21.28 a 1]

4 20m stack [2 rotorz) 14 1.2 ]

] 1]

B 1]

7 1]

a 1]

9 1]

10 1]

11 1]

12 1]

13 1]

14 1]

15 1]
Starting UDP Port for Rotar Program: {12040 [w Start M1k Rotor Program

QE. | Cancel | Help

The Antennas tab gives control over which antenna should be automatically selected when
selecting a new band. The parallel port is being used to give the needed code to an external
Top-Ten type device box. The code to send to the box is setup in this dialog. To replicate the default
Top-Ten behavior see the example setup in the Interfacing chapter.

When you press Alt+F9, you will toggle through all the antennas FOR THAT BAND. If there is only
one, then no toggling will occur. When you change bands, the antenna switch will be changed to
the antenna with the lowest code for that band. The selected antenna will show in the status pane.
Commas are not allowed as separator if that's the decimal separator (in Windows).

e Code - The code which will be presented on the LPT port
o Each code represents ONE ANTENNA not a band
o Code is binary code on the parallel port using the pins 9, 8, 7 and 2
¢ Antenna - Free text to describe the antenna, give a meaningful name here
e Bands - The bands on which this antenna should be used
o Use bands in MHz e.g. 1.8, 3.5, 7 etc.
o Bands should be separated by a comma for multi band antennas
o An antenna may be used on any number of bands
¢ Rotor Port(s) - setup the serial port used with N1MM rotor
o Has to be set up to the ports used in NTMM Rotor
o More than one port can be selected (separate using comma). Great when turning a
stack with more rotators
¢ Offset - This offset is added to the rotor position to determine the antenna position. This is
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useful for antennas that are mounted at 90 degrees for pattern interference reasons, or for
antennas that have simply turned some in the wind over the winter. The offset can also be
entered for the selected rotor in the rotor program

¢ Bidirect - Set to 1 if the antenna can be set bidirectional (0 = not bidirectional, 1 =
bidirectional) (e.g. Steppir)

o Start UDP port for Rotor Program - Set the UDP which is used in communication between
the Rotor program and N1MM logger. Defaults to UDP port 12040 and has to be set up the
same in both programs to work

o Start Rotor Program - Start rotor program automatically by N1MM Logger main program. You
will need to stop it manually

© LPT Port Conflict
When DVK is selected on the used LPT port, the antenna selection on the pins is not working
because the DVK pins and the antenna pins do overlap.

10. Configurer >Audio Tab

™ Configurer,

[ RETEETE T Files T Function KE}'ST Digital Modes Other
Wik ey T Mode Contral T Antennas T """

|4 - Dual Cards - Two Radio, Sound Card SO2R |
Tx Sound Card and 050 Recording Setup

Select Device |5oundhax Digital Audio = |

Select Input Line |Miu:ru:uphu:une

Chooge the input line connected to
wour mic for 'Input Ling' and 'Line to
kute!

Select Line to Mute | Microphone

Recording Bits |3

Max Recording Length [secs] [0

Recording Channels (2 »

Recording Sample Rate |11|:|25

Fx Sound Card Setup [used for S02R Headphone Switching)

0228 |Creaiive Sound Blasto PLr | - o™ st crce. pou

L Lef Lefle e

Left Radio Input Part |Line In ﬂ have to use one of the intemal inputs
. . like 'CO' or ‘Ao’ ou will need to
Right B adio [nput Port |ED Audin ﬂ make a custom stereo cable.

Mate: It iz best to chooze the default card for the Tx Sound card. This is becausze the CO input iz not
uzed for T and can be used normally. 1F vou do uze the default card far Bx, try connecting ane af the
radio inputs to an unuged input, like B

QE. | Cancel | Help

For the Two Sound Card SO2R ($5 SO2R) check the SO2R chapter.
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Select at the top of the page the configuration to use. (example picture how to connect can be
found in the SO2R chapter.)

1 - Single Card - One radio, No Sound Card SO2R

e One radio and one sound card to play wav files and record new messages and mute the
microphone when playing wav files

¢ Only the top part of the dialog above (Tx Sound Card and QSO recording) has to be set up.
Bottom part is deselected

2 - Single Card - Two radio, No Sound Card SO2R

e Not SO2R but two radios and one sound card to play wav files and record both radios
¢ Only the top part of the dialog above (Tx Sound Card and QSO recording) has to be set up.
Bottom part is deselected

3 - Single Card - Two radio, Sound Card SO2R, CW Only

¢ SO2R with one sound card for CW only

e The drawback here is that no switching of the headphones is done

¢ You will have to wire a cable to the cd or aux input of a sound card in order to make use of this
feature

e You'll need to define your radios as SO2R in the Hardware tab

¢ Both the top and bottom part of the dialog above (Tx Sound Card and QSO recording + Rx
Sound Card) have to be set up

o The TX Radio Input Port in the top part of the dialog is deselected

4 - Dual Cards - Two radio, Sound Card SO2R

¢ Full SO2R with audio switching where two soundcards are needed

e Switching of the headphones is done

¢ You will have to wire a cable to the cd or aux input of a sound card in order to make use of this
feature

¢ You'll need to define your radios as SO2R in the Hardware tab

¢ Both the top and bottom part of the dialog above (Tx Sound Card and QSO recording + Rx
Sound Card) have to be set up

o The TX Radio Input Port in the top part of the dialog is deselected

© Not All Sound Cards are Created Equal

The Configurer lets you pick parameters that your sound card may not support... usually 16 bit,
11025 Hz/sec is safe for all cards.

e Tx Sound Card and QSO Recording Setup - It is best to choose the default card for the Tx
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Sound card. This is because the CD input is not used for Tx and can be used normally. If you
do use the default card for Rx, try connecting one of the radio inputs to an unused input like
'Aux’
o Select Device - Select the soundcard to use for sending Wav files (DVK) and recording
QSOs
o Select Input Line - Select the Input line for recording. If your microphone is connected
to the soundcard this will be the 'Mic input'
o Select Line to Mute - Select the line to mute when playing wav files. This is also mostly
the Mic input
o Recording Bits - Select 8, 16 or 24 bit recording. NB Your soundcard should support
this or an Error 4 will appear when starting to record
= Select 8 bits or 16 bits and it will probably always work and make the smallest files
(and good enough quality recordings)
o Recording Sample Rate - Select the sample rate to record. The lower the rate the
smaller the files but less quality recording
= Selecting 11025 is a good starting point
o Radio Input Port - Select the Radio Input Port which receives the audio from the radio.
Mostly Line In. Only when configuration 1 or 2 selected, otherwise grayed out
o Max Recording Length (secs) - This is the maximum recording length of a wav file,
when the recording is longer the first part will be discarded so always the last 30
seconds (in this example) will be recorded
o Recording channels - Select the number of channels to record, 1 or 2

The output for Wave files from the computer to the radio/radios is always the 'Speaker Out' from the
soundcard.

e Rx Sound Card Setup (used for SO2R Headphone Switching) - Two line-level inputs are
required for SO2R. With almost all cards, you will have to use one of the internal inputs like
'CD' or 'Aux'. You will need to make a custom stereo cable. This part can only be selected with
configuration 3 or 4, otherwise grayed out

o Device - Select the (second) soundcard to use
o Left Radio Input Port - Select the Left Radio Input Port which receives the audio from
the radio. Mostly Line In, CD or Aux
= Must be different from Right Radio Input Port
o Right Radio Input Port - Select the Right Radio Input Port which receives the audio
from the radio. Mostly Line In, CD or Aux
= Must be different from Left Radio Input Port

Start a New Contest Log or Open an Existing Contest Log
In this Section...

Start a New Contest Log or Open an Existing Contest Log
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1. Start a new contest log
2. Open an Existing Contest Log
3. Contest Specific Information
3.1. Contest Tab
3.2. Tab: Associated Files

L Databases versus Logs

Before starting your first contest, you should understand how N1MM Logger stores contests and
contacts. The two keys terms are Databases and Logs. As an analogy, think of your PC's hard
disk as a large room containing computer stuff. Into this room, N1MM Logger places File
Cabinets (Databases) and within those File cabinets, N1MM Logger adds individual Folders
(Logs). For each contest that you operate, you will add a new Log to hold the contacts for that
contest. Your large room with computer stuff can hold as many File Cabinets (Databases) and
as many Folders (Logs) as you want - until, of course, your hard drive is full.

Continuing our File Cabinet and Folder analogy, there are many methods by which you can
arrange your file cabinets (Databases). Here are three examples:

1. DATABASE PER CONTEST TYPE - Some hams prefer to create a Database for each major
contest type. Your \N1MM Logger directory would contain databases (>File >New Database)
named CQ WW. MDB, ARRL DX.MDB, ARRL 160.MDB and CQ WPX.MDB. When setting up
each contest, you >File >Open the Database corresponding to the contest to be operated, then
>File >New Log (folder) for that particular contest. So, one of these databases would contain
CW, Phone, and RTTY logs from 2007, 2008, and 2009... for that particular contest. You might
want to add a database like MISCELLANEOUS.MDB for the smaller contests or contests that
you only plan to operate a couple of times.

2. DATABASE PER CALENDAR YEAR - Some hams create a new Database each year. At the
beginning of each year, you would >File >New Database a database named K8UT 2008.MDB,
K8UT 2009.MDB or K8UT 2010.MDB. In each database would be the Logs (folders) for every
contest you operate during that year. When setting up each contest, you would >File >Open
Database for the correct year, then >File >New Log (folder) for that particular contest. So, this
database would contain all contests (CQ WW, ARRL DX, CQ WPX...) worked during that year.

3. DATABASE PER EACH CONTEST - Some hams create a new Database each time they
operate a contest. Your \N1MM Logger directory would contain lots of databases - one for each
contest that you operate. When setting up each contest, you would >File >New Database, and
then within that database you would >File >New Log. Although some hams may find this the
easiest method to understand, managing all of those files after many years may become a
problem.

These aren't your only Database/Log options, but perhaps one of them matches the way your
brain works. How about organizing your logs by mode: CW.MDB, PHONE.MDB, DIGITAL.MDB?
N1MM Logger can do any of these - choose the method that provides the easiest way for you to
create new logs before the contest and find your old logs after the contest.

152 of 680 2/2/2011 4:54 PM



153 of 680

http://nlmmtw61.semdxa.org/tiki-print multi _pages.php?printstructures...

Select Contest Type for Mew Log

Log Tepe | D+

FD
FOREGT
FOCCW
GACW
GCLUP

>l

Start Date

GEMERIC
HAD
HELYETIA bs

r e \r Hommmmi=be A Cilmn \l

© sent Exchange
Do not enter the signal report as part of the exchange on this setup page.

1. Start a new contest log

To start a new contest select >File >New Log in Database.

C:%Program Files'N1MM logger',CQWWssbZ2005.mdb

Select Contest Tupe for Mew Log

Log Type | COMAWSSE |

Start Date |2006-03-19

e Initially, you'll see the name of the contest last used by the program. Click the downward-
pointing arrow to the right of the current contest name (called the "handle") to drop down the
list of all supported contests.

Select Contest Type for Mew Log

Log Tupe |D>< ﬂ
FO FS
FOREGT

FOCCW

GACW

GCUP

Start Date

GEMERIC
HAD
HELYETIA bs

r e \r Hommmmi=be A Cilmn \l

You can search alphabetically by pressing the first letter of a contest's short name, and then
scrolling to find the right one.

A list of supported contests can be found in the Supported Contests chapter. Check the contest
website for the latest rules and check the contest setup information in the Contest Setup
Instructions chapter.
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2. Open an Existing Contest Log

To open an existing contest log in the currently selected database. Select >File >Open Log in
Database

¢ In the top part of the dialog the currently available contest logs can be selected by clicking on
the down arrow to the right of the textbox. Note that the textbox is captioned "Select Existing
Log"

e Contest specific changes can be made in the Contest and Associated Files tabs. More
information in the paragraph below

C:%Program Files'N1MM logger',CQWWssbZ2005.mdb

Select Existing Log

Start Date
B 28-10-2005

DELETEDQ

To delete a contest, click on the contest in the contest pane, as shown above, so it is selected.
Then press Delete.

For example, the CQWWSSB in the picture above is selected and can be deleted by pressing the
Delete key.

3. Contest Specific Information

Contest T Azzociated Files ]
Operatar Categon |SINI3LE-EIF' j 1 Contacts
Band Cat -
NG LSO AL Mate - the program doss
Paower Catagar I—_| hot validate categories.
9o THIGH T1 Check the contest rules
Mode Category [RTTY - | forvalid categories. Import Section List |
Qverlay Category | s | Show Rules [Intemet
access reguined)
Sent Exchange |01 Omit RST. E.g. COwMW: 05 55: A 56 EMA
BT P& TH Update Ops from Log |
Soapbox
Comments

QK Help| Eahcel|

Default entry category information will be used on new contests to that of the currently open
contest.
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3.1. Contest Tab

e Operator Category: Make a choice for your situation. Choices are:
o SINGLE-OP
o SINGLE-OP-ASSISTED
o MULTI-ONE
= In CQWW contests, a prompt is issued asking whether this station is a Run or a
Mult station
o MULTI-TWO
= An identifier is needed for Station 1 and Station 2 that must be specified when
setting up initially. Each time the program is loaded or contest changed the
program asks to set Station 1 or 2
o MULTI-MULTI
o SCHOOL-CLUB
o CHECKLOG
o SINGLE-OP-PORTABLE
o ROVER
= when going Rover or Mobile and use different QTHs select this for additional
functionality
o MULTI-UNLIMITED
o MULTI-LIMITED
e Band Category: Make a choice for your situation. Choices are:
o ALL
o 160M
o 80M
o 40M
o 20M
o 15M
o 10M
o LIMITED
o CHECKLOG
e Power Category: Make a choice for your situation. Choices are:
o HIGH
o LOW
o QRP
o MEDIUM
e Mode Category: Make a choice for your situation. Choices are:
o CW
o SSB
o RTTY
o PSK
o MIXED - the Available Mults and Qs window will show one column each for CW and
SSB. The number of band/mode buttons may be limited by the contest rules. For
instance, in a mixed mode contest that has mults once per band and a dupe type of
Each Band (mode independent), there is no need to display more than one column of
mode buttons.
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o MIXED+DIG = CW & SSB & Digital (defined by the contest) Could be RTTY & PSK or
RTTY
o DIGITAL = no CW & SSB, just RTTY & PSK, or RTTY (defined by the contest)

e Overlay Category: Used in relatively few contests. Choices are:
o N/A (default)
o ROOKIE
o BAND-LIMITED
o TB-WIRES (tri-bander and wires)
o OVER-50
o HQ
o NOVICE-TECH
o EXPERT - The EXPERT overlay category in contests where it exists must be selected for
the 5 minute band change counter to be inactive for SINGLE-OP stations

In CQ WPX CW and CQ WPX SSB, category overlay may be any combination of ROOKIE,
BAND-LIMITED, TB-WIRES. In STEW-PERRY ,category overlay may be OVER-50. In IARU-HF,
category overlay may be HQ. In PACC category overlay may be NOVICE-TECH.

e Sent Exchange: Contest-dependent, mostly a number, zone, state etc
o without the RS(T)__

D No RST in the Exchange|
Do not put a signal report in the sent exchange. It will cause incorrect Cabrillo output. Typically,
the program will warn you if you make this mistake.

e Operators: Enter here all the operators' callsigns. Clicking the button 'Update Ops from Log'
will do this for you (most useful after the contest..).
o Update Ops from Log - Clicking this button will transfer all operators from the contest
log to the operators field.

e Soapbox comments: Your comments on the contest, results, propagation etc. This text is
cleared when selecting a new contest.

e Section Lists
o Selection list: State for Log Type QSOPARTY

2 Contacts
State for Log Tepe QSOPARTY
A, -
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Edit Section List
Impart Section List

Show Bules [Internet
access required)

*** These selection buttons are only shown when the contest has a selection list (like QSO parties).

= In the example above the QSO party for the state CA (California) has been
selected which has 2 contacts/qso's in it.

o Button: Import Section List: Importing the contest section file for the selected contest.

= This section list is used to determine multipliers (States, Provinces etc.) for the
contest which will be shown in the Multiplier window.

= The name of the list is hardcoded and will be shown while importing the file.
Example name: IOTA.SEC

o Button: Edit Section List: Edit the contest section table for the selected contest.

= This is used to edit the section table in the current database. It does NOT edit the
section text file. If you want to export your section file after editing, use the File
menu accessed from the upper left corner of the Edit Section List dialog.

o Button: Show Rules (Internet access required): Goes to the contest sponsor's website
where the rules can be found. A frequent source of problems is when some contest
sponsors change the relevant page within the website or even the whole website every
year, which will make the link fail. Please contact us to update this entry when this
happens.

3.2. Tab: Associated Files
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C:\Program Files\N1MM Logger\junk.mdb [

Select Contest Type for Hew Log

Log Type |HADX d

Start Date |2010-09-04

Conts Associated Fies, |
Master.DTA Filename | MasterDTA Change
ET:nFaL:nneCtiDn e Ehange| Clear |
Ei?ei§;2CtiDn ey Ehange| Clear |
i Change | _Cler |
Call Hiztory Filename Ehange| Clear |

(] | Help | Eanu:el|

o Master.DTA Filename: Shows the selected master.dta file for this specific contest-specific
(not contest instance-specific)
o For example, all QSO Parties will use the same master.dta filename
o Defaults to master.dta
= Use the Change button if you wish to select a file other than the basic master.dta
for use in this contest.

© Update Your CTY.DAT File Before Each Contest

In addition to these files, be sure always to load the most recent CTY.DAT file before entering a
contest. This is a 2-step process. Download the most recent country file from the Internet using
>Tools >Download latest country file (wl_cty.dat) (Internet). Then import it into the current
database using >Tools >Import country list from downloaded file. The program will warn you if
you open a database whose CTY table is less recent than the wl_cty.dat file in your N1MM
Logger program directory.

For each of the following Associated Files, the Change and Clear buttons have the same function -
the Change button allows you to select or change the file to be used, wherever you have stored it.
The Clear button lets you clear the filename if you don't wish to load one.
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e SSB Function Key Filename - Select the SSB function keys to use with this contest.

e CW Function Key Filename - Select the CW function keys to use with this contest.

¢ Digital Function Key Filename - Select the Digital Interface function keys to use with this
contest from the Entry Window (not the extra keys that can be set up in the Digital Interface).

o Call History Filename - Select a call history file to be loaded for use with this contest. This is
entirely optional. See the manual section on Call history Lookup for details. If you want to use
a Call History file, don't forget to turn on Call History Lookup on the Config menu.

Windows
Table of Contents:

1 Entry

2 Log

3 Bandmap

4 Packet and Telnet
5 Check

6 Available Mults and Qs
7 Edit Contact

8 Info

9 Score

10 Mults by Band

11 Statistics

12 Visual Dupesheet

Entry Window
In this Section...

Entry Window
. Button Assignments
. Callsign/Exchange Editing Features
. Other Info
. Status Bar Information
. Callsign Colors
. The Red and Green dots (LEDs)
. The Entry Windows
. Other Features
. Function Keys
9.1. General
9.2. Running mode and S&P mode

O O ~NO O, WON -
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10. Other Keys
11. File Menu Selections
12. Edit Menu Selections
13. View Menu Selections
14. Tools Menu Selections
15. Config Menu Selections
15.1. Configure Ports, Telnet Address, Other - Also called Configurer.
15.2. Change Your Station Data
15.3. Change Sub Bands
15.4. Clear INI file settings
15.5. Find all windows (move to within 800 *600)
15.6. Enter Sends Messages (ESM mode)
15.7. AutoSend Threshold - Ctrl+Shift+M
15.8. Spot all S&P QSOs
15.9. QSYing wipes the call & spots QSO in bandmap
15.10. Do not run on CQ-frequency
15.11. Show non-workable spots
15.12. Reset Rx freq when running split
15.13. Dual Rx always on
15.14. CQ Repeat - Alt+R
15.15. Set CQ repeat time - Ctrl+R
15.16. Call History Lookup
15.17. Record QSOs
15.18. Change Packet/CW/SSB/Digital Message Buttons - Alt+K
15.19. Multi-User Mode
15.20. Change Exchange Abbreviations
15.21. SO2R
15.22. WAE - Special commands for the WAE DX contest only
16. Window Menu Selections
17. Help Menu Selections

Your entry window will be similar to this one.

= 14200,00 CW Manual - A
Ele Edit View Tools Config Window Help

Snt Ry Zone
|N1MM “599 |599 |5 —‘

ERT ] fipe | Log It | Edit I Mark I Store | Sgotltl Buck I

Ese:top | Fipa | F2enns | FaTu | FapatM
I Rurning _F5HisCal | FEnsoBa | 77 F8 Ao
22 = FINR? Fo | FioRz | Fre

Bearing = 302", 4078 mi, 6563 km, LP = 122"
Zr 160 802015 10 [ iAax & >

There are two ways to move from field to field.

e Tab or Shift+Tab will move through the fields one by one in the standard sequence.
e The Spacebar will jump from field to field in the Entry Window, filling in defaults where
appropriate and skipping those fields that are unlikely to change.
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L Tip
Because it generally reduces the number of keystrokes required to log a contact, the Spacebar
is the preferred way of navigating the fields of the Entry Window.

1. Button Assignments

(hotkeys in parentheses)

e Wipe (Alt+W)- Wipe Out Entry Fields. Clear information about the current contact
(alternatively, Ctrl+W).

e Log It (Enter) - Write this contact to the database. Disabled when in Quick Edit mode.

o Edit - Pops up the full Edit window to edit the last contact. Use Ctrl+Q (Quick Edit) as a
convenient alternative.

e Mark (Alt+M) - Mark the current frequency in the Bandmap as being in use. Used when you
don't want to take time to enter the call of the station using the frequency.

o Store (Alt+0) - Spots the callsign you have entered in the callsign field on the Bandmap,
where it will be shown in bold because it is self spotted. The Config menu option "QSYing
wipes the call and spots QSO in Bandmap" is an easier way to do this, whether you have
worked a station or not.

e Spot it (Alt+P) - Spot the contact on the current Packet/Telnet connection.

¢ Buck - Display information on the current call using the Buckmaster callsign database. Note:
hamcal32.dll must be in the start-up and the callsign database must also be set up properly
in the Files Tab from the Configurer. If hamcall32.dll is not found it will use www.qrz.com to
find the call.

¢ F1 through F12 - Send the associated CW/Digital text or .wav file. Right click on the buttons
to change labels and actions (or go into the menu). Running mode has 12 function keys and
also S&P mode has 12 function keys. When Running the S&P keys can be found under
Shift+Function key. See below for more info about the files send and the status of the
Running indicator.

o Shift+F1 through Shift+F12 - Send the associated CW/Digital text or .wav file from the
opposite mode. So when the program is in Run mode pressing Shift will show the labels (and
send the associated info) from S&P mode and vice versa. Each mode has 12 function keys.
When Running the S&P keys can be found under Shift+Functionkey.

e Esc - Stop sending. Also stops playback of recorded contacts.

¢ Running Alt+U - Toggles "Running' box". When running is checked, the behavior of Enter
Sends Messages mode changes appropriately. Additionally contacts are logged as being part
of a run.

e CW speed - The CW speed in wpm can be set using the textbox with speed & up/down
buttons (only visible when CW mode is selected). Also Page Up and Page Down can be used
to change the CW speed. The CW speed is limited to 98 wpm...
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2. Callsign/Exchange Editing Features

e Space Bar - moves cursor to the position the last position the cursor was in prior to leaving the

Callsign or Exchange fields.

Tab - Move to the next field.

Shift+Tab - move to the previous field.

e Home - moves cursor to beginning of the field it's in.

e End - moves cursor to end of the field it's in.

¢ Question mark (?) - Sends a ?, and will cause the ? to be highlighted when you reenter the
field. E.g. N?MM will send what is typed, but automatically highlight the ? so you can replace
it. Adouble ?, as in DL?K?A will highlight all text in between and including the ? marks. The
first keystroke entered will replace all three characters.

o Left/Right Arrow - moves cursor to left or right one position within the field it's in.

o Backspace - delete character to the left.

e Delete - delete character to the right.

o Shift+Home - will highlight from the cursor insertion point to the home (beginning) of the
textbox.

o Shift+End - will highlight from the cursor insertion point to the end of the textbox.

o Shift+arrow key - will highlight as you press the keys. When you type the first character, it
will delete the highlighted character.

© Note
Check out the chapter Key Assignments for all available key assignments by the program.

3. Other Info

Running Alt+U - Mark this contact as being part of a run (versus S&P).

"Running" is automatically checked:

¢ When you click on CQ-frequency in the Bandmap window

e When you are in tuning range of your CQ-frequency (on that band)

e When you pressing F1(= default CQ-key) (and no S&P macro has been added to Search and
Pounce F1 key.

¢ When clicking on the green dot when it shows SP (Search & Pounce)

4. Status Bar Information
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o Left pane - Information

o After entering a callsign - Country, Zone, Continent

o Otherwise - Messages (like error messages, results from commands etc.)
e Middle pane - QSOs /multipliers (/zone) depending on the selected contest
e Right pane - Current score

5. Callsign Colors

There are two places where a callsign can be shown in the Entry Window , in the Callsign field and
in the Call-frame.

Red Single Multiplier Example: CQWW - gso is either zone or country multiplier (one
multipliers)

Green Double or better Multiplier Example: CQWW - gso is a zone and a country multiplier (two
multipliers)

Blue |New contact

Gray Dupe contact or an unworkable station in a non-workable country. This means that you
don't need this station because he is a dupe or you are not even 'allowed' to work him in
this contest according the contest rules.

6. The Red and Green dots (LEDs)

On the Entry Window below the left end of the Callsign textbox you will see either a green or a red
dot (LED), or both. The LEDs are visual aids that help you keep track of what is happening on each
VFO/radio when operating SO2V or SO2R. This is part of N1MM's continuing philosophy of letting
the operator easily know what's happening at any given time.

Green dot/LED - This VFO/radio has Entry focus in SO2V or SO2R modes - also known elsewhere
in this manual as RX (Receive) focus or Keyboard focus. This means that any information entered
by keyboard goes in that window, including function keys. Depending on your SO2R switching
setup, it may also denote which radio you are hearing in your headphones.

¢ Inside the green dot (or in that location if the green dot is in the other Entry Window) you will
see either Ru or SP (Run/S&P). Ru means the Entry Window (and the VFO or radio that it
controls) is in Running mode, and SP means it is in Search&Pounce mode.
o Clicking on the green LED toggles between running mode (Ru) and S&P mode (SP)
e Entry focus can also be toggled between the VFOs/radios by
o using a mouse to click on a free space in one of the two Entry Windows
o pressing the \ key (backslash)
e To move both Transmit and Entry focus
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o press Ctrl+Left-Arrow / Ctrl+Right-Arrow to move both foci to the left or right VFO/radio

o press the Pause key - if the green and red LEDs are in different Entry Windows, the first
press will bring them together in the window that has the Entry focus. Subsequent
presses will toggle both LEDs between the two Entry Windows.

Red dot/LED - This VFO/radio has Transmit (TX) focus

e Transmit (TX) focus can be changed between the VFOs/radios by pressing the Alt+F10 key or
by pressing the Pause key (see above)

¢ To move both Transmit and Entry focus, pressing Ctrl+Left-Arrow / Ctrl+Right-Arrow will move

both foci to the left or right VFO/radio, or use the Pause key, as explained above.

When transmitting the TX focus can not be changed

When the VFO/radio has TX focus, the LED is dark red. When that VFO/radio is transmitting,

the LED changes to bright red

Inside the red dot the R (Repeat) designator is shown when Repeat mode (for CQ-ing) is

active

Inside the red dot the D (Dueling CQ) designator is shown when Dueling CQ is active

L Important note

When using function keys to transmit either CW or stored voice messages, the message will be
sent on the radio or VFO that has the Entry focus, not the one that has the Transmit focus.
When you press the function key, the red LED denoting Transmit focus first switches to the
Entry window that has the Entry (Keyboard) focus, and then the message is transmitted. On the
other hand, when using either manual CW or phone, messages will be sent on the radio or VFO
that has the red LED, so if you grab the microphone or paddle, that's what you'll get. After a
while, it becomes second nature - we promise!

7. The Entry Windows

The program has two Entry windows. When using both bandmaps/both VFOs, both Entry
windows are needed to make QSOs on both VFOs!

The standard Entry window, which is always open, is being used to transmit on VFO-A (SO2V) or
the left radio (SO2R).

The second Entry window is being used to transmit on VFO-B (SO2V) or the right radio (SO2R).
The second Entry window can be opened by entering a backslash \ in the first Entry window.

If two Entry windows take up too much space, position the second Entry window over the first Entry
window. "\" will toggle you from one to the other (typing focus) or use Ctrl+right/left to move transmit
and typing focus. The Entry window can be resized if the two needed Entry windows take to much
screen space.

Most SO2R operators get the most efficiency while CQ-ing on 1 radio, and S&Ping on the other.
The Entry Window examples below reflect a typical setup: The left VFO-Ais now assigned to
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running, and the right VFO (B) is assigned to S&P.

Witz background = Renning mods Canany bastoground = S5F mods

gm 14044.73 USB Kenwood VFO A

y= 14033.75 USE Kenwood YFO B

Fle Edit Yew Fool: Config Window Help File Edit 'LI"rF.II.I.I ooiz Config Window Heip

~CQ-Frequency - Snt Aoy Zore N1MM ~5nl Hev Zome——

[pascer ¥ [ [ | “mmm "' [s9 |59 [

i Beaning = 30°, 5435 mi, B747 km, LP = 210°  F5 Hiz Cal-F2 Exch & Bearing = 68", 1ﬁ15 mi, 2527 km, LP = 248" EEEmh
- tﬁﬁﬁ?rmk_ggm 27.EU ST Kt United States, Zana 8. NA ,f‘

\ TX foous LED ‘ \

Gresn RE M evboard foous hest ESA staie Green R Heyboard foous Mext ESM stale
LED. Mofice Ru, mesning LED: Mefice SP, meaning
t's in Running maode its m 58P mods

All of the features that are available to the single radio operator also work in SO2R/SO2V. For
example, when tuning the band with the S&P VFO, spots that are in the bandmap are automatically
inserted into each call frame (above callsign entry window) when you tune across the frequency of
the spot. Hitting the space bar will pull the callsign from the call frame into the QSO field. Then if a
station calls you on the run radio, toggling back and forth between Entry Windows with the \ key or
Ctrl Left/Right arrows will keep the information in each Entry Window until the respective stations
are logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the callsign is entered into the
bandmap (if "QSYing wipes the call && spots QSO in bandmap" is selected). Most people who are
comfortable with Logger tend to use the reduced size Entry Windows in the examples above. All of
the vital information an operator needs is displayed in the smaller window.

The second Entry window will be opened when a call is clicked in the second bandmap and it is not
open.

More SO2R info can be found in the SO2R chapter.

L Tip

In SO2V (one radio - two VFOs = 'normal’ operation) QSOs made on VFO-A have to be entered
in the standard (first) Entry window. Making a QSO on VFO-B (so transmitting on VFO-B) has to
be done by using the second (VFO) Entry window. So when using both bandmaps, both Entry
windows are needed to make QSOs on both VFOs. When a call from VFO-B is entered in the
first Entry window you will transmit on the wrong VFO. Select the correct Entry window!

8. Other Features

¢ When a callsign is entered info about the country (bearing, distance etc.) is shown just above
the status bar. Additional information from the call history lookup file may also be displayed
(e.g. name, state, section, gird square, etc.). When calculating the bearing, if call history
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lookup is off the coordinates of the state that is the closest to the middle of the call-area is
used. If call history lookup is on, the section or state from the call history is used. For VHF
contests (having VHF in the contest name) the Grid Square field in the Station dialog is used
as your bearing and not the entered Latitude and Longitude. If a beacons file is used, the grid
square from the beacons file will be shown just above the status bar when the beacon call
sign is entered.

e When a callsign is entered and the station is a dupe moving to another frequency will
automatically clear the callsign field (and place the station on the bandmap)

e If in the callsign typed there is a question mark (you didn't get the complete call the first
time), the cursor highlights the ?, so that when you type, it will replace it. When in Enter
Sends Message (ESM) mode a ? in the callsign field Enter doesn't move focus to the
Exchange field but highlights the question mark. A callsign with a question mark in it can not
be logged!

¢ Clicking on the Exchange pane will have the same effect as pressing Space when the cursor
is in the callsign field.

e When both bandmaps are closed the frequency and mode are shown on the Entry window
title bar before the contest name.

e When tuning the band and a station on the bandmap is within tuning range, this call will be
placed on the Entry window callsign frame. When the callsign field is empty, pressing the
space bar will copy the callsign from the Entry window callsign frame to the callsign field. Also
clicking on the callsign in the callsign frame will place the this callsign into the callsign field,
replacing anything that was previously there. The tuning range can be set in the configurer
(Other tab).

e Set Frequency in callsign field - The frequency from the first VFO (A) can be set by entering
a frequency or offset into the callsign field. Decimal points and comma's are allowed in (split)
frequencies in the callsign pane. Placing a / in front of the frequency or offset will set the
second VFO (B). Also Split frequencies can be set here, see the chapter Basic Functions for
frequency change and split frequency examples.

o Set Mode in callsign field - The mode can be set by typing CW, USB, LSB, SSB, RTTY, AM,
FM, PSK or SSTV into the callsign field. If the contest mode is mixed or a digital mode, typing
RTTY or PSK in the entry field will open the Digital Interface window and open the serial ports
for which the Digital check box has been checked in the Configurer. If the contest mode is not
mixed or digital, typing RTTY or PSK will result in an error message; if you really want to open
the DI window in this situation, for example to use Fldigi as a CW decoder, use the Windows >
Digital Interface menu item. When the DI window is open and a non-digital mode is entered in
the callsign field, the Digital port(s) is/are closed so it/they can be used for CW, PTT, etc.

o Ctrl+P - Spot the station entered in the callsign field as a spot to the active cluster connection,
either packet or telnet. You will be prompted for a comment. If no station is entered in the
callsign field, the last logged station this session will be spotted. Macros are accepted in the
comment sent.

e Ctrl+O - Change the callsign of the operator. If you are multi-user, you will be prompted for
the operator at the first call logged. The default is the callsign in the station information dialog.
Entering "OPON" in the callsign field will also prompt for an operator callsign.

o Auto-call completion - As you are typing a callsign in the callsign field, if a unique match to
your log or to the check window call occurs, the remaining characters in the call are added to
what you have already typed. They will be highlighted, so that if you continue to type, you will
replace the characters automatically added.
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¢ Auto-CQ - Alt+R toggles the CQ button to send CQ once or repeat. The on/off on the status
bar signals whether the next CQ will go into repeat mode. The only way to stop the repeat
(mid stream), and to get completely out of it, is to hit Escape.

o Ctrl+R sets the period of repeat in seconds or milliseconds.

o Alt+R turns repeat mode on or off.

= If repeat mode is on, CQ will always repeat
= CQ needs to be the first two letters of the text sent by the function key for
CW or anywhere in the name of the wav file name for SSB or text for all
Digital modes.
= CQ needs to be the first two letters of the caption of the function key for CW
and SSB or anywhere in the caption of the function key for Digital modes.
» If repeat mode is off, CQ will not repeat.
= A'R' will be shown in the red status 'led' when repeat mode is on.

o The repeat timer for CW and SSB is for the interval from when you stop sending CQ

until CQ resumes.
= When using an External DVK there is no stop sending indication and CQ will not
repeat.

o When using a radio with internal voice message memories, the repeat timer can be used
together with a CAT macro in the A¢a,~A“CQA¢4,-A function key. Note: The repeat timer
in this case starts when the radio command is sent to the radio. Users that use this
function to trigger radio voice keyers must assign the radio command to abort the
message to a separate function key.

o Ctrl+Shift+Fx - Record SSB message for the assigned function key. Pressing Ctrl+Shift+Fx
again stops the recording. Fx can be F1 to F12.

e Ctrl+Alt+Fx - Record external DVK memory 1 to 4. Fx can be F1 to F4. An external DVK has
to be connected and configured on a LPT port.

o When using an external DVK, all of the Run and S&P SSB function keys should be set
to empty.wav and not left blank.

e Enter sends messages - the so called 'Enter mode' or 'ESM' mode. An entire normal contact
(CQ & S&P) can be handled with the Enter key. More information is given in the chapter Basic
Functions

e Automatically Spot all S&P QSOs - Spot the contact automatically when you log it (only
when in S&P mode).

e "Quick Edit" (Ctrl+Q/Ctri+A). - Quickly edit the QSOs worked before in the log.

o Ctrl+Q - moves back one QSO

Ctrl+A - moves forward one QSO.

Enter - logs the changes made and brings you back in normal logging mode.

Escape - discards the changes made and brings you back in normal logging mode.

If the text boxes in the Entry window are colored blue, you are in Quick Edit mode, also

"QuickEdit" will be shown in as the callframe caption when re-editing QSOs. Quick Edit

starts editing with the highlighted contact and you can move forward or back from there.

There is no check if the entered contents is valid as is done when the QSO is entered

normally. So check thoroughly what you type.

e The program will display a warning if it suspects that the computer time is wrong (by checking
local time & time zone).

e Call Stacking - This command is used for callsign stacking and only available in 'Multi-User
Mode'. It is described in the Advanced Functions section.

(¢}

o O O

(e]
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¢ Using both VFOs when 'Running' - When using the main VFO to transmit and the other to
receive (split mode) after each logged QSO the RX frequency will be made equal to the TX
(main VFO) frequency. It's there to let you use the main frequency control as an RIT. It resets
after every RUNNING QSO.

e Automatic antenna selection can be used. Antennas have to be set on the Antenna tab from
the Configurer dialog and can be controlled using an external box on the parallel port. When
you press Alt+F9, you will toggle through all the antennas FOR THAT BAND. If there is only
one, then no toggling will occur. When you change bands, the antenna switch will be
changed to the antenna with the lowest code for that band. The selected antenna will show in
the status pane.

o Alt+' (Alt+single quote) toggle between the wide and narrow filter for the selected mode (SSB,
CW and Digital modes). This hot key will work whether you have changed your filter codes or
not. Filter codes can be set in the the bandmap right click menu.

e Pause - swap radios and match keyboard to radio.

o Update timestamp gso - Updating the timestamp from a gso can be done from within the
Entry window using the callsign field. Entries starting with "T" and four numeric digits will
update the current row time in the log.

e Awarning message will be shown if user tunes away before logging a qso in the Entry window
with a correct entered exchange.

e Exchange field validation:

CQ Zone |only allow numbers, tab, space, backspace
Section | only allow letters/numbers
Exchange only allow letters/numbers
Grid only allow letters/numbers

Power only allow letters/numbers

e K1TTT's call checking function has been implemented. When a callsign is entered it is
checked against a pattern file to see if the callsign entered is a possible callsign. A warning
will be given in the Check window when this is not true. The checking in done using a set of
rules in the file CALLSIGN.PAT. Note that the call checking function only works for HF (no
WARC) and only for CW and SSB. More information in the chapter Call Checking.

e When a SH/DX command is entered in the callsign field it is passed to the packet window for
processing.

e Show windows when radio frequency changed - This function will bring the program on
top when the radio frequency is changed.

o This only happens when there is another program on top of N1MM logger like your
Internet browser, e-mail client etc.

o Aradio is attached (to get the frequency change from).

o When N1MM logger is minimized nothing will happen.

o This function is standard behavior and is always enabled.
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e TOUR command. A very few contests allow for multiple sessions in which you can work the
same station in every session for QSO credit. You can enter TOUR into the Entry window in
place of a call sign to reset dupe checking at any time before or during the contest. This
command has 2 parameters that are entered into the Sent RST field, separated by a forward
slash "/". The first parameter is the time when the current session begins (GMT) and the
second parameter is the duration of the session. The format for both parameters is hhmm. For
example, 1200/30 means the session starts at 1200Z and has a duration of 30 minutes. The
minimum value for the duration parameter is 10 (10 minutes). If the TOUR command is
entered without any parameters, the current values of the start time and duration will be
displayed. The default values are 0000/00.

o At the beginning of each session the start time and duration will be displayed in the
status field at the bottom of the Entry Window. After the first QSO has been logged
during the new session you should see the Multiplier window reset and dupes will be
reset for this new session as well.

o Most of the contests supported by the Logger do not need this command but some
(mostly Russian and Ukrainian) have it built into the contest module and do not require it
entered manually.

o If you are planning on using TOUR command with other contests, keep in mind that
settings for it will be lost when the logger is restarted. If the Snt (sent RST) field is not
displayed in the Entry window, you will not be able to use this command.

9. Function Keys

9.1. General

The program has 24 possible programmed messages assigned to the function keys. There are two
sets of messages, Run messages and Search and Pounce messages. The first twelve messages
you enter are presumed to be Run messages F1 to F12, the second twelve, Search and Pounce
messages F1 to F12.

The function keys can be redefined by right-clicking on the function key/message button array in
the Entry window

The function keys can be stacked. This means you can press several function keys behind each
other which will all be sent in full in the selected order. For example, you could press F4 to re-send
your call (if you think the other station did not get it right) and immediately press F2 to send the
exchange. The program will send the two messages seamlessly.

When hovering with the mouse over a function key button the text to sent is shown.

9.2. Running mode and S&P mode
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If "Running" is checked, you will see the Run messages, if not, you'll see the Search and Pounce
messages on the function keys. SHIFT REVERSES THE MEANING OF THE ABOVE RULE.
When you press Shift, the labels will change (if you made them different) and the text from the
"Running" keys become the text from the "Search & Pounce" keys and vice versa.

Running mode is determined by whether you are on a CQ-Frequency or when the 'Running’
indicator is marked. There is one CQ-Frequency per band. Swapping VFOs may possible swap
between Running mode and Search & Pounce mode. Running mode is based on the TX frequency.

Moving away from the frequency on which you were in Running mode will place you automatically
in Search and Pounce mode. Going back to the Running frequency will put you back in Running
mode (the 'Running' indicator is marked again), clicking on the 'CQ-frequency' in the bandmap also
will place the program in Running mode again. An exception is when you are working split i.e.
transmit on one VFO and receive on the other. Moving around will not change Running mode into
Search and Pounce mode.

Default Function keys

F1 CQ Key F5 His Call Key F9 |---
F2 Exchange key |[F6 QSO B4 Key F10 ---
F3 End of QSO Key F7 - F11 -
F4 My CallKey F8 Again Key F12 ---

The above mentioned function key assignments are the defaults. The function keys can be
remapped in the 'Configurer' dialog.

Just put 24 messages (for CW/Digital) or 24 wave files for SSB in order. They will map to F1-F12
(first 12 are for Run mode) and Shift+F1-F12 (second 12 are for S&P mode). Keys not programmed
in S&P mode take the value of that key from Running mode (if programmed). This means that when
the F5 key in S&P mode isn't programmed, the F5 key from Running mode will be shown (and
used) by that function key in S&P mode. If you want you can come close to CT compatibility.

Therefore the text sent by and shown on the function keys depend on the Running mode
indicator!

More info about Running and S&P mode can be found in the {{Basic Functions}} chapter.

Note that when in Search and Pounce mode, to call CQ, the CQ-key as configured is used i.e
mostly F1. No need to press Shift+F1. That will place the program in Run mode and will press F1;
from that point on F1 will call CQ (in Running mode). If you sent CQ, don't you want to be in Run
mode? If not use the {S&P} macro to stay in S&P mode.

There may not be any 'holes' in the function key lines with skipped function keys. ALL
preceding function keys must at least have a line in the table Example: You'd like to have a
different S&P F3 key than the Run F3 key. First you have to add the 12 Run lines in the table,
after that the S&P lines for F1 + F2 +F3 which you liked to change for S&P. So at least 15
lines in total have to be in the function key table (12 run + 3 S&P).
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The text F1 (etc.) in the left column is only text and has no intelligence/meaning for the
program. You could remove it and change it to any text you like, which will show on the
Function key in the Entry window. The order of lines determines what the key will do.
Examples: line 5 is Run F5, line 11 is Run F11, line 17 is S&P F5 (17-12=5) etc.

Alt + F11 - Run box behavior: The behavior of the running indicator (run box) can be
manipulated using the Alt+F11 toggle. Normally when you are on your CQ-frequency you will
be in Run mode. Changing frequency will toggle the run box into S&P mode. With Alt+F11
this behavior can be changed and the program will stay in the Run mode or S&P mode
regardless to which frequency the VFO is tuned. A message is given in the Entry window
status bar what the new value is. When on a DXpedition this behavior can be very useful.

10. Other Keys

Key

Insert

Alt+Enter

Send
function
key(s)

His Call and
Exchange
Keys

His Call and
Exchange
Keys

N/A

End of QSO
Key

Ctri+Alt+Enter N/A

Action(s)

Send His Call followed by the Exchange

Send His Call Followed by the Exchange

Sends the End of QSO message and logs the contact

Sends the End of QSO message and logs the contact

Logs a normally invalid QSO (invalid exchange, etc.). Prompts for a
comment. When no comment is entered Forced QSO is added to
the comment field. The receive frequency is reset to the transmit
frequency. Use View>Notes to correct later

Background: The ; and ' keys were added to make touch typing much easier for those who use the
Insert and + keys for working and logging QSOs. It is impossible to touch type and easily hit these
very often used keys. If you have ever operated at a multi-multi event with many different keyboard

layouts (QWERTZ, QWERTY, German, Dutch etc.) you will have noticed that each keyboard layout
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has these keys in different places. Using keys like ; and ' helps standardize often used keystrokes.

the keys to use can be set in the Configurer under the Function keys tab.

11. File Menu Selections

= 0.00 Elecraft K3VFOA [« |[O)&]| B

File Edit View Tools Confip Window Help .00

Mew Log in Database: C:\Program Files\M1MM Logager{Test.mdb
Open Log in Database: C:\Program Files{1MM Logger {Test.mdb

Mew Database. ..

Open Database. ..

Copy (and Compact) Database...

Copy This Contest to Another Database...
Repairing a corrupted database (Internet)

Import
Export

1 COWWEW (12/15/2010)

2 ARRLDXCW (8/12/2010)

3 CQWPXCW (1/15/2010)

4 ARRL10M (12/2/2010) in C:\Program Files{1MM Logger2010-11.mdb

5 COWWCW (11272010} in C:\Program Files\M1MM Logger2010-11.mdb

6 55558 (12/4/2010) in C:\Program Files\™ 1MM Logger2010-11 copy.mdhb

7 COWWCW (11/27/2010) in C:\Program Files\N1MM Loggeri2010-11 copy.mdb
& UKRAINDY (11/6/2010) in C:\Program Files\M 1MM Logger2010-11.MDE

9 COWWCW (11/27/2010) in C:\Program FilesiM 1MM Logger2010-11.MDB

Exit Alt+F4

© Note

Generate Cabrilla File

3
4

A database is a single Access 2000 database file. It has an extension of . mdb. In each database

are held zero or more general or contest logs. For the time being, only one contest or general
log within a database may be viewed or edited at a time.

¢ New log in database - Create a new contest log within the current database. More info

((Open/New Contest Dialog|here))

¢ Open log in database - Open an existing log within the current database. More info

((Open/New Contest Dialog|here))

¢ New Database - Create a new log database. Change the proposed name (new.mdb) into a
meaningful name for the use or contents of this new database. From now on this database
will be opened by default at startup of the program. Use Open Database to select another

Database which will become the default database to open. Many contests can be stored

within one database. Always use a separate database for testing new versions of the program
and make regular backups of the N1MM logger directory with all it's contents but with at least

the database files ( *.mdb) with 'real' contest QSOs.
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¢ Open Database - Open an existing log database. A selection can be made from databases
already created. Many contests can be stored within one database.

¥ Warning

All setup information like station info, telnet clusters, function key information etc. is stored in
the current database. When creating a new database this information is copied to the new one.
Changes are always stored in the current open database. So when opening an old database all
the stored information has to be checked if still valid and changed where needed. This can be
facilitated by using the export and import functions for packet/telnet buttons and function keys.
Just export the files, change databases, and re-import them.

e Copy (and Compact) Database - Copy the database to a new database file, and compress
the data at the same time. Change the proposed name (new.mdb) into a meaningful name.
This function can be used to reduce the size of the database after importing a new CTY.DAT
file or after deleting contests. The original database is not changed, nor does the program
start using the new database, unless Open Database is subsequently used to open the new
database.

Note: Copying a database also compresses it. If you have deleted contests from your database, you
may want to copy it to reduce the space it takes up. Deleted contests and contacts are definitely
gone after this action!

e Copy This Contest to Another Database - Copy the key/button information and QSOs from
the current contest to another database. The database should exist, if not create it first with
'New database'.

¢ Repairing a corrupted database (Internet) - This is a link to the Microsoft Web site on how to
fix a corrupted Access databases. A program to fix can be downloaded there (Jetcomp.exe).
This file can also be download from the N1MM website under the menu item 'Other files'.

¢ Generate Cabrillo File - New with Version 10.12.3, replacing Export - Cabrillo File. One fewer
step to producing the Cabrillo format text file that most contests now require of entrants
submitting electronic logs.

Once created, the Cabrillo file can be edited using Notepad or any text editor. Make sure that the
Station information 'Config > Change Your Station Data') and overall contest information (File >
Open Log in Database ) is correct before creating this file. Be sure to enter the correct Sent
Exchange, or else your Cabrillo file will be wrong. For Multi-op stations select the correct Operator
Category in the contest setup window. This generates the correct numbers for each station; in Multi-
single, the station number field (the last digit in each line) identifies the Mult and Run station.

It is a good idea to rescore the contest before submitting and check to be sure that the header of
the Cabrillo file is correct before submitting the log. Some contest organizers use non-standard
operator categories (i.e. not in the official Cabrillo specification); in these contests you will have to
edit the category by hand to make it agree with the organizer's requirements.

L Digital Mode Designators
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Note: The Cabrillo standard only supports one mode designator for digital modes: RY. In some
digital or mixed-mode contests, PSK and RTTY may be considered separate modes, and the
contest organizers may specify additional non-standard designators such as PK. The Logger's
Cabrillo mode export string for PSK is "PK" unless the contest considers RTTY and PSK to be a
single digital mode. When this occurs the mode export string is "RY". Because the use of these
mode designators is non-standard, you should always check with the organizer's file
specification and if necessary, edit the Cabrillo file to meet the organizer's requirements.

e Import

o Import ADIF from file... - Load the data from an ADIF file into the current database.
ADIF is being used to import into and export from many contest and logging programs. It
is not possible to import a contest if the contest ID doesn't match the current contest. So
the exported and imported contest have to be the same. If not look in the FAQ section
what to do.

o Import Call History... - Some contests use exchanges which are very often the same
the next contest you work a station. This table in the log database can be used by some
of the contests to show information in one of the exchange fields or fill a macro when a
callsign is entered. This information can be Name (RTTY friends file), Grid square, age,
etc. For more information see the Before the Contest chapter and for vhf the VHF and
Up Contesting chapter (VHFREG1 is a VHF contest which uses this table to fill the grid
square). When importing a new file with information the contents of the CallHist table will
be deleted first. So export first if you want to keep the content!

o Import State and Province abbreviations... - Import the state and province
abbreviations used in many contest modules (QSO parties). Only needed to import
when changes have been made to the file StatesAndProvinces.sec or internal in the
program (CallAreas). When a state or province does not show up correctly in Logger this
menu item is a good try to resolve the problem. Do a rescore after executing this menu
item when QSOs have already been logged.

o Import Packet/Telnet Buttons from file... - Import the contents of the Packet/Telnet
buttons file (*.mc). This way a separate set of Packet/Telnet Buttons can be created for
different Packet/Telnet nodes which may have different commands.

o Import Telnet Clusters... - Import the contents of a telnet cluster file (*.txt) into the
program. This way you can import a small file with telnet clusters suited for your
location/situation. The 2 items in the file (name and Telnet cluster address) are
separated by a comma. A port number may be added using a : after the telnet cluster
address where needed (the default is 7300). Example:
GB7UJS,gb7ujs.shacknet.nu:7373 or KITTT.NET,K1TTT.NET

o __Import Function Keys - Import the contents of a saved function keys file (*.mc). This
file can be edited with a text editor like Notepad before importing. Note that for each
mode, only one set of function key definitions can be loaded in a database at one time.
However, the Associated Files tab of the Define Contest dialog provides the ability to
associate a definition file with each contest, so that it will be loaded automatically when
that contest is started.

= SSB Function Keys...- import SSB function keys.
= CW Function Keys... - import CW function keys.
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= Digital Function Keys... - import the Digital Interface function keys (not the extra
keys from the Digital Interface).

= Recover QSOs from a Transaction Log... - Import the created transaction log file.
This file is created when on the 'Other' tab in the Configurer the option 'Keep log of
all QSOs to facilitate recovery of log' has been selected. More info in the
Configurer chapter.

e Export

L Filename Tip

When the "Save File" window prompts for a filename the default is callsign.txt. If your contest
call sign was NTMM/P, put something like "N1MM_P.txt" The / and many other characters are a
no go in the Windows OS.

o Export ADIF to file

= Export ADIF to file... - Create an ADIF file. This file can be used to import into a
logging program or contest program (like this one). Deleted QSOs are not
exported, select the 'DELETEDQS' contest to export these.

= Export ADIF to file by date... - Create an ADIF file from the selected contest from
the date set. The first time the default date from which QSOs will be exported is
1900-01-01 (yyyy-mm-dd). The second time the default date and time will be
shown by the program and will be the moment you last exported with this option.
The date/time can be changed if necessary, i.e. when opening another (older)
database. This function is especially useful when you liked to export the generated
ADIF file into a (general) logging program to do award tracking etc. Deleted QSOs
are not exported, select the 'DELETEDQS' contest to export these.

B

Enter the starting date & time for the expart. The default 0k
timestamp iz the lagt time you exported or 1300-07-07 if -

you have never uzed this function, Bemad] |

OMLY this contest will be exported.

o Export ADIF to file by date from ALL contests... - Create an ADIF file from all QSOs
in all contests when the current contest is DX. Otherwise, it exports only from the contest
you are logging in. The first time the default date from which QSOs will be exported is
1900-01-01 (yyyy-mm-dd). The second time the default date and time will be shown by
the program and will be the moment you last exported with this option. The date/time
can be changed if necessary, i.e. when opening another (older) database. This function
is especially useful when you want to export the generated ADIF file into a (general)
logging program to do award tracking etc. Deleted QSOs are not exported, select the
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'DELETEDQS' contest to export these.

Export All Q50s by Date ﬂ
Enter the starting date & time far the expart. The default 0k
timestamp iz the lagt time you exported or 1300-07-07 if -

you have never uzed this function. Bemad] |

= Export ADIF to file by Multi-User Station Number - Create an ADIF file from all
QSOs from one station in a Multi User environment when you are currently logging
DX. Otherwise, it exports only from the contest you are logging in. A station
number has to be given after which a filename can be given for the ADIF file to
generate.

Note: When using ADIF export and the contest name contains "RTTY" or "JARTS" the export mode
is set to "RTTY" even when the log file shows otherwise (i.e. LSB).

o Export to File (Generic)

= Export to File (Generic), order by QSO Time (normal)... - Creates a generic file
named callsign.txt from the contest log ordered by time (and not by band). In some
cases this is the file needed by the contest manager. This file can also be used to
import into a spreadsheet or database program or your logging program if it can't
import ADIF format. The exported file can be edited with a text editor like Notepad.

= Export to File (Generic), order by Band... - Creates a generic file named
callsign.txt from the contest log ordered by band, per band ordered by time. In
some cases this is the file needed by the contest manager (like in VHF and up
contests).

o Export EDI to file by band... - Create an EDI (REG1TEST) file which is a regular file
format used for VHF contests in Europe. A separate file will be created for each band
with QSOs made on it.

o Print Score Summary to File... - Print a summary sheet to a file with the default name
Callsign.SUM Example: NTMM.SUM The number of contacts printed on the Summary
sheet is without dupe contacts. The exported file can be edited with a text editor like
Notepad.

o Export Call History... - Exports the information in the Call History database table. This
table can only be filled or revised by using Import Call History. Do your editing on the
Call History text file before import.

o Export Packet/Telnet Buttons to file... - Export the contents of the Packet/Telnet
buttons to file (*.mc). Exported Packet/Telnet buttons can be imported using the menu
item 'File | Import Packet/Telnet Buttons from file...". The exported file can be edited with
a text editor like Notepad.
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o Export Telnet Clusters... - Export the telnet clusters (*.txt) in the program. This way you
can export the current entries and update it for your own location/situation. Exported
Telnet clusters can be imported using the menu item 'File | Import Telnet Clusters...". The
default name for the exported file will be 'Clusters.txt'.

o Export Function Keys to file - Export the contents of the function keys to file (*.mc).
Exported function key settings can be imported using the menu item 'File | Import
Function Keys to file...". This way for every contest a separate set of function keys could
be created. The exported file can be edited with a text editor like Notepad.

= SSB Function Keys... - Export the SSB function keys.
= CW Function Keys... - Export the CW function keys.
» Digital Function Keys... - Export the Digital Interface function keys (not the extra
keys from the Digital Interface).
e Recently used contests/databases - The most recently used contest/databases will be shown
here with a maximum of nine.

o Exit Alt+F4 - Quit the program. If two Entry windows are open the program will not exit. If
unlogged contacts are in the Entry window you will be prompted with the dialog below.

WPX CW - 15-May-01 07:29:512 [09:29]

il Cancel

12. Edit Menu Selections

¢ Wipe Out Entry Fields Ctrl+W - Clear information from the current contact (equal to Alt+W).

¢ Edit Last Contact Ctrl+Y - Open a dialog to allow all fields for the last contact to be modified.

¢ Add a Note to Last/Current Contact Ctrl+N - Add a note to your the current contact in the
Entry window or the last QSO logged when no callsign is shown in the Entry window.

e Edit Current Contact - Open a dialog to allow all fields for the current contact to be modified.
Double clicking in the Log window on a contact will open the same dialog.

¢ Quick Edit Previous Contacts (Back) Ctrl+Q - Quickly edit the QSOs worked before in the
log. Ctrl+Q moves back one QSO, Ctrl+A moves forward one QSO. If the text boxes in the
Entry window are colored blue, you are in Quick Edit mode. To exit, press enter to save
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changes or Escape to abandon changes.

¢ Quick Edit Previous Contacts (Forward) Ctrl+A- Quickly edit the QSOs worked before in
the log. Ctrl+Q moves back one QSO, Ctrl+A moves forward one QSO. If the text boxes in the
Entry window are colored blue, you are in Quick Edit mode. To exit, press enter to save
changes or Escape to abandon changes.

¢ Increase Received NR by 1 Ctrl+U - Increase the number in the exchange field by 1. You will
find this useful during serial number contests when you are in a pileup and you need to keep
incrementing the DX station's serial number because you can't get him in the log...

¢ Find/Find Again Ctrl+F - Find the callsign entered in the callsign field in the log. Pressing
Ctrl+F again will find the next instance.

13. View Menu Selections

e Max Rates - View 1 minute, 10 minutes and 60 minutes highest rates for the contest. The
content shown can be saved as a text file by clicking on the Save button or by right clicking to
the clipboard using the menu item: Copy text to Clipboard.

o Off Times - Show off times. Shown is the start and end of the period and the minutes off time,
if the operator is known it will be shown. Also the total off time is given in minutes and
days/hours/minutes. If a contest does not have an off period it is set at 30 minutes. The
content shown can be saved as a text file by clicking the Save button or by right clicking to the
clipboard using the menu item: Copy text to Clipboard. Off times uses time of first (last)
logged QSO as the start (end) of on time. Any time between start (end) of contest and first
(last) logged QSO is counted as off time. Awarning will be displayed for pre-contest QSOs
that cause the report to be incorrect.

i= ARRL SS CW - 2009-11-07 2100Z to 20... [= |[B]X]

ARRL 55 Cw - 2009-11-07 21002 to 2009-11-09 03002 - 1086
[50z
MALR - OFf Times »= 30 Minutes

20091107 2100 - 2009-11-07 21:322  00:33 [33 ming] [Start
late]

2009-11-08 07342 - 2009-11-08 11:472 04:14 (254 minz]
20093-11-08 18002 - 2009-11-08 19062 01:07 [E7 mins)
20031108 225592 - 2009-11-09 02592 04:00 [240 ming) End
early

Total Tirne OFf 09:54  [594 minz)
Tatal Time On 20:068 [1206 mins]
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Save | Help |

¢ Runs - Shows all runs. These are the periods between band changes and includes off times.
The content shown can be saved as a text file by clicking the Save button or by right clicking
to the clipboard using the menu item: Copy text to Clipboard.

e Suspect Calls - Show suspect calls using the K1TTT's call checking function. A window will
open with the results. The content shown can be saved as a text file by clicking the Save
button or by right clicking to the clipboard using the menu item: Copy text to Clipboard.

i= CQ WW SSB - 2004-10-30 00007 to 2004-11-01 00002 - 4180... [ |[B][X]

CO Wi SSB - 2004-10-30 00002 to 2004-11-01 0000 - 4180 Q50s ”
|F'.-’-'-.'IT Suzpect Callz:

PH7A 2004-10-30 01162 70114 TC2K 4 Errar - Maybe miszing portable, or parts of 2 calls?

PESDX 2004-10-30 10592 1425255 G1E Waming - Call too short?

PESD: 2004-10-30 201 3£ 3707 GEW “Wamning - Call too ghort?

PATTE 2004-10-30 22342 3707 12 ORBEU Errar - OT and OR callz have 1 letter suffises!

PATTE. 2004-10-31 00042 37259,23 GAB Waming - Call too short?

PH?A 2004-10-31 11132 21379,94 TC2K4) Error - Maybe mizsing portable, or parts of 2 calls?

PCIT 2004-10-31 11472 14187 38 VEA Waming - Call too short? hud

Save Help

e Suspect Zones - Show suspect zones. Zones in the USA and Canada are omitted. The first
zone is the zone from this contest, the second zone is the zone from the cty.dat file loaded. A
window will open with the results. The content shown can be saved as a text file by clicking
the Save button or by right clicking to the clipboard using the menu item: Copy text to
Clipboard.

™= Suspect Zones K & VE Omitted

Suzpect Lones K &WYE Omitted
First zone i zone from thiz contest, second zone iz zone from cty.dat loaded 23-10-2004 21:53:11

Do not change zones just because it appears on this listl These are SUSPECTS.

1617 2004-10-30 00:17:30 UAISPY logged by PESDE

1614 2004-10-30 03:01: 46 ED 2B logged by PESD

01 15 2004-10-30 03:24: 323 SPACMP logged by PHA

1817 2004-10-30 03:55:05 ADAZA logged by PHYA

1817 2004-10-30 11:30:15 R<0AR logged by FESDN w

Save Help
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e Varying Zones - Show varying zones. The first zone is the zone from this contest, the second
zone is the zone from any other contest in this database or this contest. A window will open
with the results. The content shown can be saved as a text file by clicking the Save button.

™ Varying Zones EJ[E| g|
Y

I arving Zones
First zone iz zone from thiz contest, second zone iz zone from any other contest ar thiz contest,

14 20 2004-12-15 20:56: 28 TC2kK4) logged by PATT

1416 2004-10-30 00:12:53 EDZE] logged by PESDN

0314 2004-10-31 23:17:07 EI3E logged by PATT

20 27 2004-10-30 21:57:13 5B4PRC logged by PATM

16 20 2004-10-30 01:46:48 ER 3R logged by PATTE

0314 2004-10-31 231707 EI9E logged by PATT w

Save Help

e Passed QSOs -The number of passed gsos per operator. Showing band, number of passed
gsos and multipliers.

e Cross Check Exchanges - Will create a report of inconsistent exchanges, Grid Squares not
in the call history and distances >= 700 km in VHF contests. Great to find typos after the
contest.

¢ Unique calls not in Master.dta - Will create a report of unique calls which are not found in
the master.dta file in the N1MM logger program directory.

() 008 0 D000Z to 2008 01 0000 0 Q50 L]

CQ W CW - 2008-11-29 00082 to 2008-12-81 800062 - 78 (50s

Contest Callsign: PA1H

Callsigns logged once that are not in the master callsign database.

Possible calls from the log and the master callsign database are listed. If fFrom
the log, the number of times logged is shown in parenthesis.

¢ Notes - Open a window and display all contacts with notes. Great feature to check operator
notes when checking the log after the contest. The content shown can be saved as a text file
by clicking the Save button or by right clicking to the clipboard using the menu item: Copy text
to Clipboard.

¢ Statistics - Show statistics for the selected contest. Many choices available. See chapter
'Statistics' for more detail. When, possibly during a contest, you check the statistics and a
station comes back, just start typing. The statisctics window will go to the background and
every typed characters will go to the Entry Window. A Print to File output can be import in the
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Import Goals in the Info Window.

© Note
All 'Show' items below can only be used when valid callsign information is entered in the
callsign field or the callsign frame.

e Show Last 10 Spots - Show the last 10 spots for the call in the callsign field. If the callsign
field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet
session with a DX cluster should be present because a query will be send to that cluster.

o Show Buck/Packet - Show the Buckmaster information for the call in the callsign field. If the
callsign field is empty the callsign on the callsign field frame will be used, if any. A Packet or
Telnet session with a DX cluster should be present because a query will be send to that
cluster.

e Show Station - Show the station information for the call in the callsign field. If the callsign
field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet
session with a DX cluster should be present because a query will be send to that cluster.

e Show QSL/Packet - Show the QSL information for the call in the callsign field. If the callsign
field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet
session with a DX cluster should be present because a query will be send to that cluster.

e Show Sunrise/Sunset - Show the Sunrise/Sunset information for the call in the callsign field.
If the callsign field is empty the callsign on the callsign field frame will be used, if any. The
information shown is also available in the Info Window. A Packet or Telnet session with a DX
cluster should be present because a query will be send to that cluster.

e SH/DX Current Call or Spot - Shows DX information from the current call in the callsign field
or spot. If the callsign field is empty the callsign on the callsign field frame will be used, if any.
A Packet or Telnet session with a DX cluster should be present because a query will be send
to that cluster.

e Show QRZ (Internet) - Show the information that QRZ.com has for this call using your
browser. An Internet connection should be present.

e Show Google (Internet) - Show the information that Google.com has for this call using your
browser. An Internet connection should be present.

e Show Buck (Local) - Show the Buckmaster database information for this call. This requires
installation of Buckmaster database software and Buckmaster database on the local
computer.

e Set Font - Change the font of the Entry window text boxes and callframe text. The callframe
text is the same type but not size as the textboxes. If Arial is the choosen font,the callframe
remains however MS Sans Serif. A nice slashed font is Monaco.

181 of 680 2/2/2011 4:54 PM



http://nlmmtw61.semdxa.org/tiki-print multi _pages.php?printstructures...

14. Tools Menu Selections

™ J029.96 CW Elecraft K3 VFO A
File Edit View | Tools Config Window Help

Rescore Current Contest

| Rescore last M Hours
Download Latest Chedk Partial file (Master.OTA) (Internet)

%. Wine Tune (CW mode) Ctrl+T

Ezc: Stop | F1 Download latest country file {wl_cty.dat) (Internet)

[ Runring P! Import country list from downloaded file

Bearing informatior

Tune to beacon for this band (20m - 10m)

Update Call History with Current Log
Clear Call History then Update with Current Log

Telnet port cloged.
—

Turn Rotaor Alt+]

Stop Rotor CHr+alt+]

Packet Window Tools

Program Execution Logging (debugging only) r

Save Window Positions

Restore Window Pasitions

¢ Rescore Current Contest - Rescore the current contest. This is required before submitting a
log if CTY.DAT has been changed (if applicable) or if contacts have been modified or deleted
during the contest. It may be run at any time but is rather slow.

* Rescore last N Hours - Rescore the last N hours for the current contest. It may be run at any
time but is rather slow.

e Download Latest Check Partial file (Master.DTA)(Internet) - This item will open your web
browser to the web page where to download the latest version of the check partial file. Select
the file to download and copy the file in the program directory(NB. N1MM logger supports the
CT format master.dta file). Select the file to use in the tab 'Associated Files' under 'File | Open
Log in Database' dialog. The calls in these database master files appear in the Check window
after entering at least two letters of the callsign field.

e Tune (CW mode) Ctrl+T - Switches the radio into CW mode and using the CW keying
interface, key the transmitter. The PTT line will also activate and the radio has to be in semi- or
full-break-in mode (vox) to transmit. To stop the tuning signal, press the Esc key or Ctrl+T
again. After the tuning signal ends and PTT is released, the radio will return to the original
mode.

e Download latest country file (wl_cty.dat)(Internet) - This item will open your web browser to
the web page where to download the latest wl_cty.dat file. After downloading the new country
file it has to be imported in the program by selecting 'Tools>Import country list from
downloaded file' which is the next menu item.

¢ Import country list from downloaded file- Load a new copy of the country file into the log
database. Mostly this file is called wl_cty.dat but may have any name. Just select the right file
when importing and select Open”. To check which file you are using go into 'Help - About
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N1MM logger Vx.x.xx and look at the bottom line which tells you the current country file
(mostly cty.dat or wl_cty.dat), check the date and time if it matches the file. Duplicate entries
are ignored during the import so the first instance will be added.

© Note
Always load the most current WL_CTY.DAT file before entering a contest from the Internet.

e Add call to country - Specify a country for the callsign in the callsign field in the Entry

Window. If no callsign entered this menu item will be grayed out. This is a quick way during
the heat of a contest to add a country. Added callsigns to countries are valid until you do a
new 'Import country list from downloaded file'. Making changes permanent means changing
the imported country file (wl_cty.dat) and importing the changed country file. This feature is
for getting stations accepted by the program from countries when otherwise rejected by the
program due to a faulty country file. When using the right country the program will accept the
station and calculate the right (well at least a more accurate) score (points and multipliers).
Tune to beacon for this band - This will change mode to CW/CW-R and tune to the NCDXF
beacons on bands 10, 15 and 20 meters and displays the station transmitting and the power
steps in the status bar of the focus window. Also the Short Path and Long Path bearings are
shown. See: http://www.ncdxf.org/Beacon/BeaconSchedule.html

Update Call History with Current Log - Update the call history file selected with the qsos
from the current log file. Contacts will be added when new or updated when already in the call
history file. For the 2 grid fields the behavior is a bit different. When both grid fields are filled
and a new third grid has been logged, the second grid (oldest) will be removed, and replaced
by the contents of the first field. The new grid will be added to the first position. The same
change in position will happen when only the first grid is filled and a new grid has to be added
from the log. A 4 digit grid will be overwritten by a 6 digit grid when the first 4 characters are
the same.

Turn Rotor Alt+J - Turn rotor to bearing for the callsign in the Entry window or to the callsign
in the callframe (when callsign field is empty).

o The statusbar will show the bearing it will turn to. Example: Turning Rotor to 123°

o Alt+L will turn the beam to the proper bearing for long path

e Stop Rotor Ctri+Alt+J - Stop turning the rotator.
e Packet Window Tools - Opens the menu for the Packet Window, from the Entry window, so

you don't need to look at the Packet Window

e Program Execution Logging (debugging only)

o Trace facility. Exports to a selectable file (*.trc). Tracing has been added to all program
areas. If you experience problems (like a serious delay) please turn on tracing for the
window/dialog giving (performance) problems. Send the recorded trace file to the
programmers so they can figure out the problem/delay is in the program.

= Disable

= All

= .... one entry per program window/dialog (Available window, Bandmap window
etc.)

e Save Window Positions - Save the current window positions to the .ini file.

o NB. window positions are automatically being saved when the program is closed.
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o Window positions are saved per operator. Use Ctrl+O to select Operator and press 'Save
Window Positions'.

¢ Restore Window Positions - Restore from the .ini file the most recent saved window
positions. The screen will update immediately
o Window positions are restored per operator (when saved first by the operator). Use
Ctrl+O to select Operator and press 'Restore Window Positions'. The windows will
change to their new positions immediately. This enables easy reconfiguration of the
screen when changing operators at a multi-op.

© Note
More info about rotator control can be found in the chapter {{Supported Hardware}} under
'Rotator control'

15. Config Menu Selections

15.1. Configure Ports, Telnet Address, Other - Also called Configurer.

This a very important dialog which can change the program's behavior. This menu opens the
configuration dialog to modify setup options.

15.2. Change Your Station Data

Modify overall Station information - name, call, address, state, latitude, longitude, etc. The callsign
entered here is very important for most contests, It determines what country you are in, which may
in turn affect the required exchange, scoring, which stations may be worked for contest credit, etc.

15.3. Change Sub Bands

These are the band edges which are used when you invoke the use of a bandplan in the Configurer
dialog's Mode Control tab. The Sub Bands are disabled in the default setting, which is Follow Radio
Mode, because this option often causes operator confusion if it is set by mistake.

You may want to set up a bandplan as an aid to the operator. For example, in Europe, you might

want to set the lower band edge on 40 SSB at 7040 to help you conform to the IARU Region 1
bandplan. In that case, you need to add the frequencies (in kHz) that are used for the specific
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mode to the bandplan for that mode.

If you click or tune to an area designated for a given mode on the bandmap and you are following a
bandplan, then the program and attached radio will change modes appropriately. It is assumed that
digital segments are the smallest, SSB, next, and CW the largest, and that they may overlap. For
that reason, the program checks the digital sub-band list first, then SSB and finally CW.

e CW Sub Bands - See example below. The band 7000 to 7040 is set as CW in Europe by the
IARU bandplan. The frequencies above 7040 are automatically set to SSB if no digital sub
bands are set.

e SSB Sub Bands - the sub bands for SSB , if nothing is set this is the default mode.

¢ Digital Sub Bands - the sub bands for the digital modes

™ Change CW Sub Bands

Low [kHz] Hiih kHz] -
& (7000

To delete a row, click on the leftmozst column and press

the delete key. [The * row iz not a real row.] Ok

15.4. Clear INI file settings

Option to clear out the 'N1MM logger.ini' file. Could be used when having Configurer troubles.
Radio, port etc. settings will be lost when using this item.

15.5. Find all windows (move to within 800 *600)

Option to force all windows onto primary 800 x 600 screen. Great when coming from a higher
resolution screen or a two monitor setup and windows are 'missing on the screen'.
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15.6. Enter Sends Messages (ESM mode)

Ctrl+M - A mode of operation frst introduced by N6TR in TRLog, and much improved in N1MM
Logger. The program anticipates the needed sequence of messages to complete a QSO in either
Run or Search & Pounce mode, and sends each one in turn by simply hitting Enter. See ESM for
further details.

15.7. AutoSend Threshold - Ctri+Shift+M

Start sending the callsign after a certain number of characters typed AFTER the last number in the
callsign. The minimum threshold is 1. 0 will turn off the feature. Only when in RUN mode, not in
S&P. More info in the chapter Advanced Functions.

15.8. Spot all S&P QSOs

Spot the contact when you log it. This feature is turned off EVERY time you exit the program. This is
to prevent accidental spotting of test QSOs or casual rag chew QSOs.
If this option is checked, a contact is automatically spotted when:

e You complete the QSO in S&P mode and
¢ the spot is not already on your bandmap

15.9. QSYing wipes the call & spots QSO in bandmap

Very useful for S&P. If you enter a station's call in the entry window, and then tune off for any
reason (he doesn't answer your call, or...) the call is shown bold in the bandmap. The setting of this
feature remains as it was across program restarts.

Example: Tune to 21200, Enter VU2PTT, Tune off, VU2PTT is "spotted" on your bandmap at 21200.
Repeat as long as desired. Go back and work all of them using Ctrl+Up and Ctrl+Dn to navigate.

15.10. Do not run on CQ-frequency

When selected and you QSY back to an old Run frequency, the mode stays in S&P. F1 and Alt+Q
continue to switch to Run mode. This is most useful in Sprint-like contests, where you QSY
frequently and want to avoid unexpected switches to Run mode

15.11. Show non-workable spots
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This allows non-workable spots and logged contacts to be hidden. . If you hide spots, you will likely
never utilize the program to its full advantage, especially S&P. If you don't know why | am saying
this, then don't hide spots.

15.12. Reset Rx freq when running split

When using the main VFO to transmit and the other to receive (split mode) after each logged QSO
the RX frequency will be made equal to the TX (main VFO) frequency. It resets after every
RUNNING QSO. Using a radio with VFOs A and B, this feature is ithere to let you use the main
frequency control as an RIT. With Main/Sub radios like the Icom 756/7800 series you can not RX on
SUB without receiving on both VFOs. In this case put RX on Main and TX on SUB for Alt+S to work.

15.13. Dual Rx always on

Yaesu FT-1000 series, lcom IC-756 series, IC-781 ,IC-775 and IC-7800, Elecraft K3 with subRX only:
Selects the mode for Dual Receive toggle (Alt+F12).

e When selected -
o Yaesu FT-1000 series: The sub receiver will be left on (blinking green RX led)
o lcom IC-756 series, IC-781 ,IC-775 and IC-7800 only: Dual watch is not turned off when
you switch from SUB to Main with Ctrl+Left Arrow or PAUSE
o Elecraft K3: The sub receiver will be left on
o Not selected - The sub receiver will switched off (RX led off)

15.14. CQ Repeat - Alt+R

Toggle for repeat CQing.go into repeat mode. With Winkey, beginning to enter a call-sign in the
Entry Window terminates the CQ, but the program remains in CQ repeat mode. The function is
automatically turned off when no longer on the CQ-frequency and the mode changed to S&P
mode.

15.15. Set CQ repeat time - Ctri+R

Specify the repeat interval (CW or SSB with sound card) in seconds. The default value is 1.8
seconds.

15.16. Call History Lookup

When selected, a callsign entered in the entry Window is checked against a Call History file. For
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further details see Call history Lookup

15.17. Record QSOs

Record current contacts when in CW or SSB; disabled for other modes. The path set in 'Configurer',
tab: Files is being used. More info can be found in the chapter Tips and Tricks.

15.18. Change Packet/CW/SSB/Digital Message Buttons - Alt+K

Change the contents of the Packet/CW/SSB/Digital message buttons (Elsewhere called Function
Key definitions). The maximum length of text in each Packet, CW, SSB and RTTY button is 255
characters. Alt+K will access the relevant list of definitions, depending on the mode you are in, or
you can right-click in the button area to get there . The first 12 rows are for Run mode definitions
(F1-F12), and the second 12 are for S&P mode. (also F1-F12). The row-to-key association is fixed
— that is, the third row in the table is Run F3, and the 14th is S&P F2. Empty rows must have
something in them - it can be a single space, for example.

If you wish, you can supply a single set of definitions (12 rows), and the program will use it for both
Run and S&P mode. Alternatively, you can supply S&P F1 and F2, for example, and leave the
remainder empty - the program will substitute only the first two S&P definitions when in S&P mode

Also note that if you use a "&" character in a button caption, such as "S&P Exchange", you need to
double it (S&&P) to avoid problems with a reserved Windows function.

e Change CW Buttons - Change the contents of the CW buttons.

e Change SSB Buttons - Change the contents of the SSB buttons (.wav files). Please use the
file chooser buttons to the right of each row.

e Change Digital Buttons - Change the contents of the Digital buttons.

15.19. Multi-User Mode

Start the networked mode of N1TMM logger (Multiple computers connected to each other).

e Multi-User Tools - Menu with Multi User stations tools. For more detailed info see the chapter
on Multi-User Support.

o Edit Station Computer Names - Associate the computer numbers (starting with 0 for the
master station) with their IP-addresses for use in Multi-User mode..

e Change Operator - Ctrl+O - Change the callsign of the operator. If you are multi-user, you
will be prompted for the operator at startup. The default is the callsign in the station
information dialog. Entering "OPON" in the callsign field will also prompt for an operator
callsign.
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15.20. Change Exchange Abbreviations

N1MM Logger recognizes a number of alternative forms for the standard abbreviations used in
Cabrillo logs to denote multipliers. The tables accessed from these relate the alternative and
standard forms. Here is an example:

™ Change ARRL Section Abbreviations

File
Abbreviation Section -
Wi ML
WT WT
W M T
WCF WCF
Wl Wl
WA, WA,
WASS WA,
WY WY
WP, WP,
WiTw WiTw
Wy Wy
WO Wy
WA, WS,
Wy Wy
YWEZ (K]
¥T M T
FOINT M T
* -

To delete a row, click on the leftmozst column and press

the delete key. [The * row iz not a real row.] Ok

This table is edited the same way as the function key definitions tables, but since it is unlikely that
you would ever need more than one table, any changes are saved in the database and cannot be
exported. If you use multiple databases, you will need to make the same changes in each. Note that
the right column is the official abbreviations. normally, you should not edit this column unless the
contest sponsor changes its official abbreviations. The left column, on the other hand, can be
changed at will, so long as each left column entry is associated with a right-column official
abbreviation. The the example, for example, YT NT and VY1 are both equated to the official
abbreviation NWT.

e Change ARRL Section Abbreviations - Change table of ARRL Section abbreviations.

e Change QSO Party Abbreviations - Change the table of county abbreviations for a given
QSO Party. you must have previously selected a particular QSO Party in the contest Setup
dialog. Again, be extremely cautious in changing the right-hand column unless you are sure
that the QSO party sponsor has made a change.

15.21. SO2R
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More info about Single Operator Two Radio operation of the program can be found in the chapter
SO2R

e Dueling CQ's - Ctrl+B - SO2R feature that alternates sending CQ on each radio in turn,
listening on one while transmitting on the other. Supported for both CW and SSB.

o Changing either radio in frequency more than 200 Hz will terminate Dueling CQ.

e Set Dueling CQ Repeat Time - Adjusts time after CQ ends on one radio before it starts on
the other. In seconds.

e Advanced SO2R - Ctrl+Shift+l - toggle 'Advanced SO2R' mode. See Advanced SO2R

e Advanced SO2R Delay Time - Ctrl+Shift+N - Adjustable delay for Advanced SO2R.

e Focus on Other Radio - Ctrl+Shift+K - FocusOther, See FocusOther

e FocusOther Always Swap - Focus always switches to the other radio when one radio is
transmitting, and always switches back to the original radio when transmission is completed.

e Toggle CTRLFx Macro - Ctrl+Shift+L - When enabled and present in one of the function key
definitions, the {CTRLFx} macro executes Fx (Function key definition x) on the opposite radio.
An example is TU{CTRLF1} in Radio 2's F3 slot, which sends TU and then sends the other
radio's F1, used to get quickly back to the Run radio and call CQ after finishing an S&P QSO
on Radio 2.

e TX Lockout (Digital) - Select a lockout option. Also MIXED mode category is supported i.e.
blocks second TRX on the same band and mode. This doesn't prevent RX overload. For
digital modes only.

o Multi-TX - This is the default setting. Start CQ on radio A, next a CQ on radio B, both
are active. (no lockout)

o First one wins - Start CQ on radio A, pause, Start CQ on radio B. The radio B CQ is
ignored since radio A is already active, so if you press a F-key for the second radio while
radio1 is transmitting, the radio B F-key is ignored.

o Last one wins - Start CQ on radio A (CQ starts), pause, Start CQ on radio B. The CQ
on radio A will aborted and the CQ on radio B will start so if you press a F-key for the
second radio while radio A is transmitting, the radio A transmission is interrupted and
radio B transmits.

¢ Toggle SO2R Mode (Soundcard) - Ctrl+l - Used only with soundcard-based SO2R also
called "$5 SO2R"

15.22. WAE - Special commands for the WAE DX contest only

e Toggle WAE QTC mode - Ctrl+Z - Toggle the WAE QTC mode between QSO and
sending/receiving QTCs. See Contest Setup Instructions .
e WAE Received QTC Confirmation - Enter the WAE confirmation string or .WAV file

16. Window Menu Selections
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¢ Available Mult's and Q's - Display the Available Mult's and Q's window. More info in the
Available Mults and Qs Window chapter

e Bandmap Ctrl+B - Display the Bandmap window. In SO2R/SO2V each Entry window has its
own Bandmap window. More info in the Bandmap Window chapter

e Check - Display the Check window. More info in the Check Partial Window chapter

e CW Key Ctrl+K - Display the CW Key window. Pressing Ctrl+K again or Enter will close the
window but will continue sending the message. Pressing Escape will stop sending the
message. The windows is multiline (for pasting in text) and can be resized. The font type and
size is the same as used in the Entry Window

‘|cq de palm \

¢ Digital Interface - Displays the Digital (RTTY/MMTTY/PSK) Interface window. In SO2R/SO2V
each Entry window has its own Digital Interface window (DI1 and DI2 respectively). More info
in the Digital modes chapters

e Entry Window - Display the Entry Window

e Gray Line - Open the optional to install Gray line program (only for Windows NT, 2000, XP or
newer). More info in the Gray Line chapter

¢ Info - Display the Info window. More info in the Info Window chapter

e Log Ctri+L - Display the Log window (toggles between open and minimized). More info in the
Log Window chapter

e Multipliers by Band - Display the multipliers by band window. More info in the Multipliers by
Band Dialog chapter

e Packet - Display the Packet/Telnet window. More info in the Packet Window chapter

e Score Reporting - Start the realtime score reporting application. More info in the Advanced
Functions chapter under Contest Reporting Application

e Score Summary - Display the score summary window. More info in the Score Summary
Dialog chapter

¢ Visible Dupesheet - Display the Visible Dupesheet window. More info in the Visible
Dupesheet chapter

Ctrl+Tab toggles between the Entry window and Packet windows. If other windows are added that
have text boxes, then they will be accessed in a round-robin basis via Ctrl+Tab.

17. Help Menu Selections

¢ Help Alt+H - Show this help file. Note that pressing Alt+H in any window will show the help
specific to that window. You have to download the help file separately from the N1MM
homepage and copy the file into the directory that contains the Logger program. The Windows
Help file and Manual are maintained separately from the program and follow it as close as
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possible. So when checking for a new program version also check if a new version of the
Help/Manual is present. The revision number and revision date are shown on the first page of
the Help/Manual.

¢ Search Help using Google (Internet) - Search help using Google on the Internet.

o Key Assignments Help - Show this Key Assignments chapter of the help file.

e Manual - Show the PDF version of the help file, this version can easily be printed. You have to
download the manual separately from the N1MM homepage and copy the file into the
directory that contains the Logger program. At that point, clicking on Help->Manual should
launch the Adobe Acrobat Reader and display the Manual.

e Contest rules for this contest (Internet) - Go to the web site from the contest sponsor on the
Internet where the rules can be found.
¢ ARRL Contest Calendar Page(Internet) - Go to ARRL contest calendar site on the Internet.

¢ N1IMM Logger Home Page(Internet) - Go to the N1MM logger Home page.
e Download Help (English version) (Internet) - Download the Help file from the N1MM logger
Home page.
e Yahoo Discussion Group (Internet) - Go to the Yahoo Discussion Group page on the
Internet.
e Report Bugs/Request Features/Request Support(Internet) - Go to the NTMM logger web
site to report bugs or request features.
¢ Email Problem Report(Internet) - Send a problem report by E-mail to Tom, N1MM. The
Report gives detailed info about the problem and some program (configuration information)
and computer information (speed, processor etc.). To send a report some questions must be
answered.
o Long description of the problem
o Enter your smtp server name. (Only first time)
= Just check your e-mail program and look for the name of the outgoing e-mail
server that you use. Use that name for the smtp server name. Example:
smtp.freeler.nl

¢ View Revision History (Internet) - Shows the revision history from the program on the
Internet.

e View Revision History (last downloaded) - Shows the last downloaded revision history on
the harddisk. This avoids the need for an Internet connection.

e View Error Log - View the latest 'Errorlog.txt' file generated by the program. The program
creates and updates the contents of this file when the program generates an error. This could
be used to help pinpointing a problem in the program.

¢ Report Score to 3830 (Internet) - Go to the 3830 score reporting site on the Internet.
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e About NTMM logger Vx.x.xxx - Show the About Dialog. See Tom, N1MM's tower with a
Cushcraft X9 at the top!

Log

Your Log window will be similar to this one.
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= 29-6-2003 14:18:127 CQ WW 55B - PA9KT-COWW-55B-2002 ma... [Sy[m

15 Call Freqg |SHT [BCY [Mult [ZM  [bult|Pointz| 0perator
27-10-2002 23:60:2 | RV IFF AET84|59 |59 |Mee|1E  |[Mees|1 PaSKT
27-10-2002 235225515 AFEF84|59 |59 |Mee |15 |Mee|1 PAIET
27-10-2002 23573 | RYOAR AFEF84/59 |59 |Mee |17 |Mee|3 PAIET
27-10-2002 23578 K2PLF AFET.84/59 (B8 |Mee (B Mes |3 PAIET
27-10-2002 23582 RO 4M AET8459 |59 |Mee|1E  |Mee|1 PASkT
27-10-2002 235311 RweaH B9 |Mee |16  |Mee|1 PasSkT
27-10-2002 34" DLZLAR 1 PA3ET
26-10-2002 02:27:0 | PATHM 1853.95/59 |59 |Mee |14 |Mee|O PAICEF
27102002 23052 PATRM IEI08259 |59 |Mee|14 |Mee|O PA3ET
26-10-2002 11:27:1. | PATHM 212613859 |59 |Mee |14 |Mee|D FA3CEE
26-10-2002 08:29:1 | PATHM 2803782159 |59 |Ja |14 |Mee|D Pt

e The top grid is the log
e The bottom grid shows the contacts in yellow that match the partial or full call entered in the

Entry window. It is sorted by band, call, date & time.

e The separator bar is set at a percentage of window size. When shrinking the window, both

e The upper pane gives date and time (in UTC) and the selected contest.
¢ When a Multi operator mode (Multi-One, Multi-Two, Multi-Multi) is selected:

o The operator name is shown in the log window

o The radio number is shown in the log window

o Group edits are not allowed while in multi-user mode.

o Editing a gso is only allowed from the station who did make the gso, not from other
stations.

o A column will be added to the log window with Run1Run2

sections get smaller. After resizing the window, decide how much space to allocate to dupes
by setting the separator bar.

The relative sizes of the grids can be adjusted by clicking and dragging the gray bar between the

grids. The adjusted window size and the column width are saved by the program.
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In a serial number contest the serial numbers in the log window will be displayed without any
leading zeros even when zeros are entered before the number (like 001). When printing the leading
zeros will be added again and printed.

Keyboard Assignments

o Enter - Edit the contact which is selected.
¢ Delete (Ctrl+D) - Delete the contact which is selected.

Mouse Assignments

¢ Left mouse button click
o Single click on column title - Change log sort order using the selected column.
Second click on a column will sort descending.
o Double click on a contact - Quick Edit the contact.
e Right mouse button click
o Right-click on a contact - Displays a menu:
= Quick Edit Contact - Quickly edit the current contact using the Entry window
fields. Ctrl+Q moves back one gso, Ctrl+A moves forward one gso. If the textboxes
background in the Entry window are colored blue, you are in Quick Edit mode. To
exit, press enter to save changes or Escape to abandon changes. Quick Edit starts
editing with the highlighted contact and you can move forward or back from there.
Enter logs the changes made and Escape discards the changes bringing you back
in normal logging mode.
= Edit Contact - Edit the contact.
= Delete Contact (Ctrl+D) - Remove the contact from the log.
= Play Contact - This selection will be gray, if there is no .WAV recording file for this
contact. If it is not gray, the selection can be chosen and the contact audio will play
on your default sound player. (Make sure you don't have the sound card hooked
up at that moment to your microphone!)
= Jump to this frequency - Jump to the frequency logged with this contact
= Graph Q rates up to this entry - For a historical display of rates from an existing
log with QSOs in it, the procedure is to decide the point at which you want to
examine your rate in the preceding 30 or 60 minutes. Highlight that point in the log
window, and then right-click. Look for the option "Graph Q rates up to this entry"
and click OK. That will open a new window, on which you can right-click for the
same options as in the real-time window.

050 Rate from Log E3
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For period up to:
20-8-2007 16:33:48

= Menu items:
= The period
= 30 minutes / 60 minutes
The number of bars to show
= 6,10, 15, 20
Raw QSO count
Hourly rate (Q's/hr)
10 min moving avg
20 min moving avg
30 min moving avg

o www.qrz.com - Ask information about this station using www.qrz.com (name, address
etc.). An Internet session should be available.
o Change All Contact Timestamps by a Fixed Amount -this will fix a log where all QSOs
are off by a common amount of time
= Put mouse over log window and right click
= Select 'Change All Contest Timestamps by a Fixed Amount'
= Dialog box will open, and enter offset time (+ or -) in minutes
» The date will automatically adjust if the offset rolls a QSO into a different day. The
time is entered in minutes, and can be a negative time to go backwards. (You
might need a calculator to determine the offset in minutes if your date was off by
many days, months, or years)
= NOTE: While you can easily adjust for a mistake by doing another offset, it is
advisable that you backup your log before making any changes.
o Change Operator - Change operator callsign for this contact (Multi-user). The default is
the station callsign. When selecting several rows, the change will be applied to all rows.
This operation is not reversible. See example picture.
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Change Log Data .

You are applying thiz change to 18 row(s), This operation is not reversible - continue?

o Change Mode - Change the mode for this contact. When selecting several rows, the
change will be applied to all rows. This operation is not reversible. See example picture
above.

o Change Rx Tx Frequency (and band) - Change the RX and TX frequency for this
contact. When selecting several rows, the change will be applied to all rows. This
operation is not reversible. See example picture above.

o Change Station Number - Change the station number for this contact (Multi-user). The
Master station always has number 0. When selecting several rows, the change will be
applied to all rows. This operation is not reversible. See example picture above.

o Find all contacts with a station - Search a call (station) in the logged contacts from this
contest.

o Set Start Interpolation Time Row - Set the start row and time from where the time
interpolation has to begin. An example how to use can be found in the chapter 'After the
contest'.

o Set Stop Interpolation Time Row - Set the stop row and time from where the time
interpolation has to stop. This menu item is only highlighted when a start time has been
entered. An example how to use can be found in the chapter 'After the contest'.

o Rescore from this point on - Rescore the contest starting with this logged contact till the
end of the log.

o Delete custom column widths - Delete the custom column widths and go back to the
default column widths as set per contest (by the programmer).

o Show Mode - Select or deselect showing the mode behind all other columns in the log

window.

o Show Date - Select or deselect showing the date in front of the time (first column log
window).

o Select All - Select all QSOs in the log (for copy and paste actions)

o Copy

= Copy Generic Print String - Copy generic print string to clipboard

= Copy ADIF String - Copy ADIF string to clipboard
o Set Font - Set the font for the Log window, a selection window will appear.
o Help - Show the help file for this window.

Bandmap

In this Section...
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Bandmap
1. One radio scenario
. Two radio scenario
. Other
. Colors of the incoming spots:
. Keyboard Assignments
. Button Assignments
. Mouse Assignments
. Example bandmap usage

O ~NO O WN

Your Bandmap window will be similar to these.
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The Bandmap Window represents a VFO or a radio. There are three scenarios: one radio with 1
VFO displayed (SO1V); one radio with 2 VFOs displayed (SO2V); or two radios with one VFO
shown for each radio (SO2R). The bandmap is made zoomable to the complete band size.

1. One radio scenario

With one radio in SO1V mode, only one bandmap can be displayed. With one radio in SO2V mode,
two bandmaps may be displayed,m one for each Entry window. Each bandmap holds one VFO.
Typically, VFO-A will be on the left and VFO-B will be on the right. If you want to change VFOs, just
use the mouse to click on one of the spots in the bandmap or use the Ctrl+left & Ctrl+right arrow
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keys to change VFOs. The radio information box at the top of the bandmap will change colors as
you change VFOs. The selected Bandmap or Entry window will have a blue top.

2. Two radio scenario

With two radios the operation is exactly the same, except that each bandmap represents one of the
radios. It is best if one orients the bandmaps in the same position as the radios, left-right or
top-bottom. This will make operation more intuitive.

3. Other

e It is well worth your time to quickly review the Mouse Assignments below in order to become
familiar with the functions that the Bandmap provides.

¢ Also important! The usefulness of the Bandmap is greatly enhanced by reading the Key
Assignments

e The text CQ-Frequency will be shown on the bandmap when running stations. It is
automatically marked when you press the CQ-button (mostly the F1-key).

When a spot is less than three minutes old NEW will be placed behind the call and bearing in the
bandmap. When the station works split the receive frequency (QSX frequency) will be shown
behind the bearing after the spot is three minutes old, there is not enough room to give both NEW
and the QSX frequency. Splits are shown as 3 digits on HF. The bearing to a station is shown only
for stations outside your own country with exceptions for USA and Canada. When calculating the
bearing the section or state from the callhistory is being used otherwise the coordinates of the state
that is the closest to the middle of the callarea is used.

On the title bar of the bandmap you can see what type of radio is connected. It will show
Manual - A when no radio is connected or as an example Kenwood VFO A when a Kenwood
radio is connected. It will show a B for the other bandmap/VFO.

e Normally only one frequency is shown in the top portion of the bandmap. This is the receive
and transmit frequency. When working split the transmit frequency is added and shown just
below the receive frequency in a smaller font.

¢ Busted spots (calls with "BUST" in the comment) are not shown on the bandmaps (when
coming in via packet/telnet).

e When both bandmaps are closed the frequency and mode is shown on the title bar of the
Entry window before the contest name.

¢ During busy contests the default zoom is too dense. Use the right-click menu to zoom or use
the numeric pad +/- keys.

e New calls will show up first in the bandmap, ahead of old calls on the same frequency.

e A zone only multiplier will be shown in red (except "non-workables"). The exception means
that in CQWW, your own country will show as gray, even if it is a multiplier.

e Country of unknown callsign (like TX5A in 2006) will be made equal to the prefix to force it to

be a new country.

o Better a broken callsign then missing a multiplier.. If it is a broken callsign the user can
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delete the spot.
e Asunrise/sunset indicator (Afa€$A Ar) is shown for spots from stations where applicable.
e CW Skimmer spots are marked with "#" in spotter's callsign as skimmer spot in the bandmaps
(see picture at right above). If spotter's callsign contains your (Station dialog) callsign, then
the spots are marked with a "!".

4. Colors of the incoming spots:

¢ Blue: QSO

e Red: Single Multiplier Example: CQWW - QSO is either zone or country multiplier (one
multiplier)

e Green: Double or better Multiplier Example: CQWW - QSO is a zone and a country multiplier
(two multipliers)

e Gray: Dupe

e Bold - This is a self spotted call ('Stored' or by using the feature 'QSYing wipes the call &
spots QSO in bandmap') and is not coming from the cluster.

5. Keyboard Assignments

Mouse wheel - Zoom in or out the bandmap which has KEYBOARD focus.

Numeric keypad + key - Zoom In to show less spots from the bandmap which has
KEYBOARD focus.

Numeric keypad - key - Zoom out to show more spots from the bandmap which has
KEYBOARD focus.

o Shift - Numeric keypad + key - Zoom In to show less spots from the bandmap which does
NOT have KEYBOARD focus.

Shift - Numeric keypad - key - Zoom out to show more spots from the bandmap which does
NOT have KEYBOARD focus.

Jump to Spots on active radio/VFO

e Ctrl+Down Arrow - Jump to next spot higher in frequency.

e Ctrl+Up Arrow - Jump to next spot lower in frequency.

e Ctrl+Alt+Down Arrow - Jump to next spot higher in frequency that is a multiplier.
o Ctrl+Alt+Up Arrow - Jump to next spot lower in frequency that is a multiplier.

Jump to Spots on non active radio/VFO
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o Ctrl+Shift+Down Arrow - Jump to next spot higher in frequency on the inactive radio/VFO. This
will skip over CQ-Frequency when radios/VFOs are on the same band. Proper keystroke
operation is radio dependent. Disabled for SO1V.

o Ctrl+Shift+Up Arrow - Jump to next spot lower in frequency on the inactive radio/VFO. This will
skip over CQ-Frequency when radios/VFOs are on the same band. Proper keystroke operation
is radio dependent. Disabled for SO1V.

o Shift+Ctrl+Alt+Down Arrow - Jump to next spot higher in frequency on the inactive radio/VFO
that is a multiplier. If you are operating single mode, your mode won't change when jumping
between spots. Disabled for SO1V.

o Shift+Ctrl+Alt+Up Arrow - Jump to next spot lower in frequency on the inactive radio/VFO that

is a multiplier. If you are operating single mode, your mode won't change when jumping

between spots. Disabled for SO1V.

Shift+Alt+Q - Jumps to your last CQ frequency on the inactive VFO/radio. Disabled for SO1V.

6. Button Assignments

Narrow/Wide - Toggle the radio filters from Wide to Narrow, or vice versa. The label indicates
the current state. The label is not shown for some radios (like FT-817) and manual radios.
CW/USB/LSB/RTTY/PSK/AFSK/AM/FM - Click this label to toggle from USB/LSB (band
sensitive) via RTTY to CW/PSK/AFSK/AM/FM (radio dependent).

RIT Offset (-0.08) - Click this label to clear the RIT offset.

RIT - Click this label to toggle the RIT on and off.

e XIT - Click this label to toggle the XIT on and off.

7. Mouse Assignments

Left-click menu

e Click on frequency - Jump with the active VFO/radio to that frequency.

¢ Shift+Click on frequency (SO2R only) in Inactive Bandmap - Program the non active radio
without changing window focus. Allows you to be active and sending on one radio and change
the frequency on the non active radio without changing Entry window focus.

¢ Shift+Click on bandmap callsign (SO2R only) in Inactive Bandmap - Same as Shift+Click on
Frequency with the addition that the callsign is placed on the non active radio's callsign frame.

e Click on call - Jump to that frequency and place the call on the Entry window callsign frame.
When the callsign field is empty, giving space will copy the callsign from the Entry window
callsign frame to the callsign field. Also clicking on the callsign in the callsign frame will place
the call into the callsign field, replacing anything that was previously there.

¢ Double-Click call - Jump to that frequency, place call into Entry window callsign field,
replacing anything that was previously there. Spots with 'Busy' in the call will be ignored
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(placed in the bandmap when using Alt+M).

e Click dial ticks - Jump to that frequency.

e Click frequency label - Jump to that frequency.

¢ Right Click call - Display the right-click menu for the selected call (see Right-Click menu
below).

o The selected call will be shown italic and underlined when right-clicking on it

¢ Right Click anywhere else - Display the right-click menu with some options grayed out which

are call related.

Right-click Menu Options

If you right click in the Bandmap Window the right-click menu will appear. In the left-hand
illustration, the menu is shown as it appears when you click on the window, not on a particular spot.
The right-hand illustration shows how the menu looks if you right-click on a specific spot.
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Show Q5L Packet
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¢ Remove Selected Spot - equivalent to Alt+D with the spot callsign in the call-frame.
¢ Blacklist callsign - if you click on this option, then subsequent spots of that station will not be
displayed on the Bandmap or in the Available window. Used to get rid of busted spots that
recur often, such as LW3LPL. To edit the list of blacklisted spots, or to remove a call from the
list, use the Right-click menu in the Packet/Telnet window.
¢ Blacklist all spots from spotter - designed in particular for use when an RBN station is feeding
spots that are badly off-frequency (due to I/Q image problems) or otherwise defective. Could
also be used for the occasional harasser on traditional DX clusters. Again, the blacklist can be
edited from the Packet/Telnet window.
e Zoom In (Numeric Pad + or Ctrl+Scroll wheel if using a mouse.) - Show a wider frequency
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range on the Bandmap that has entry/RX focus.
e Zoom Out (Numeric Pad - or Ctrl+Scroll wheel) - Show a narrower frequency range on the
Bandmap that has entry/RX focus.

¢ Go to Bottom of Band - Go to the bottom of this SSB/CW subband.

¢ Go to Top of Band - Go to the top of this SSB/CW subband.

¢ Remove Spots, This Band Only, Leave Self Spots

¢ Remove Spots, This Band Only

e Remove Spots, ALL BANDS, Leave Self Spots

e Remove Spots, ALL BANDS

e Show Last 10 Spots - click this option (which is gray unless a callsign has been clicked on)
and the cluster will be asked for the last 10 spots of that station. These are displayed in the
Packet/Telnet window.

e Show Buck/Packet - requiests address information from the DX cluster

e Show Station - sends the SH/STA [callsign] command to the DX cluster

¢ Show QSL/Packet - sends the SH/QSL [callsign] command to the DX cluster

¢ Show Sunrise/Sunset - sends the SH/SUN [callsign] command to the DX cluster

e Show Buck/Internet - opens QRZ.COM in your default browser for manual entry of the
callsign.

e Show Buck Local - opens a call-sign database installed on the same computer as N1MM
Loggerl

¢ Set transceiver offset frequency - This is for transverter supporting transverters. The
transverter offset is saved when the program closes and read again when opened. Remember
to enter the frequency of the transceiver and not that of the transverter when going into split
mode (Alt+F7). Information how to fill in this table (which frequencies to enter and how to
calculate the IF frequency) can be found in the chapter 'VHF and Up contesting'.

i™ Change Transceiver Offset Freguencies

Edit
Band [KHz] IF Freq [KHz] -
144000 28000 T
432000 28000 ]

(1240000 aannd

*

Ok

e Set transceiver timeout time - Timeout value for each radio (default is 10 seconds). Entering a
value of zero will disable the timeout. Entering a negative number will set the time out value to
10 seconds. Entering a number that is too large for the program variable will set the timeout to
the program maximum. The positive minimum is 5 seconds.

e Set transceiver filter codes - You will be prompted for the wide or narrow string to set the
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filters. For Kenwood, it's pretty easy. You just look up in your manual the string you want and
enter it. For other radios, like FT-1000MP, its harder. You must enter a series of space-
delimited codes in DECIMAL. Therefore, when an FT-1000MP filter code of 0 0 0 0 8C is
required, you must enter 0 0 0 0 140 (8C hex).

To reset to the default values in the program enter a space and press the OK button. It is possible
to use {CR} in the filter codes which will be replaced with the return character. These selection are
disabled when manual radio is selected (i.e. no radio selected).

o CW Wide
o CW Narrow
o SSB Wide
o SSB Narrow
o Digi Wide
o Digi Narrow
¢ Bring to foreground when made active - This brings the active bandmap to the foreground.
When not having enough real estate on the monitor screen it is possible to place both
bandmaps on top of each other. The active bandmap will be shown hiding the non-active
bandmap.’
¢ Reset Radios - Allow manual reset all attached radios. When contact with a radio is lost the
dialog below will appear. Select 'Retry' to restore the connection with all attached radios or
Right-Click on the bandmap and choose "Reset Radios" to restart the connection.

Lost Communication with Radio 1 x|
@ Radio # 1 {Kenwood) on COM1 is not responding.

Restore the connection and dick Retry below, OR

Right-dick on that radio's bandmap and choose ‘Reset Radios' to restart the connection.

Cancel |

e Packet Spot Timeout - Indicates how long (in minutes) spots are kept in the Bandmaps. The
default is 60 minutes, any integer may be specified. For use with the Reverse Beacon Network
(RBN), a very short timeout (10-15 minutes) is recommended to avoid overloading the program
with the spot volume.

e Why don't | see spots? (Show packet filters) - Click and a window will open showing the
current spot settings in effect.
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Spot filters in effect Xl

\]:}) Current spok setkings in effect:

Mote: Incoming spoks are First filkered with Allow HE, WaRC, and ¥HF,
The allowed spots are Ffurther filkered with the contest mode,
continent, country, or call areais) filkers, So it is necessary to

have one or more of the allow HE, WaRC, and YHF selections checked,

Spots less than 30 minutes old (s time at top of log window GMT?)
Spots From myy continent anly

This contest's modes only

See packet window For cluster Filker settings as well

¢ Help - Show the help file for this window.

Note icon

When a command is sent to the packet window, it is sent to whichever connection is active.
Note icon

When the connected cluster is a DXSpider cluster, select on Tab: Other in the Configurer 'Format
for DX Spider cluster'.

Hovering with the mouse over a spot

Hovering with the mouse over a spot in the Bandmap gives the following info about the spotted
station:

e Exact frequency sent by spotter.

o Callsign of spotter.

e The time in minutes since the station was placed on the DX cluster network.
e Comments sent with the spot.

e The 'standard' country prefix from the spotted station

Hovering with the mouse over RX arrow
Hovering with the mouse over the RX arrow shows the frequency.

8. Example bandmap usage

by Tom, N1MM

In Search & Pounce (S&P) the callframe will show you each spotted station as you come within
"tuning tolerance" (user settable) of that station. I'm terrible at remembering whether | worked a
station and on what frequency. With worked stations in the bandmap, the program will tell you that
they are not workable again. You can tune by them more quickly. The same feature is useful in
contests with unworkable stations.
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In a contest like CQ WPX, with (basically) no value multipliers, here is how | use the bandmap.
Whenever | can't get a run going | start S&P on a band with a lot of unworked stations (use the
available window). | use Ctrl+Up and Ctrl+Down arrow to go to the next station. If that station is at
the beginning of a QSO, | move to the next one. If the QSO is near the end, | wait and work the
station. Then | move on. If | reach the top of the band, | start coming back down the band, working
the ones | missed on the way up. If there is no station at a frequency, that's my new running
frequency!

In contests with valuable multipliers, you should use Ctrl+Alt up/down to get the multipliers first,
then go back and get the QSOs.

If the rate drops fairly low, sweep the band using your VFO. That is where the old calls in the
bandmap come in useful. If you copy a call, but it seems like it is going to take a long time to work
him, tune to the next guy. If you have "QSYing wipes the call & spots QSO in bandmap" turned on,
the call will be spotted in bold, so you can Ctrl+Up/Ctrl+Down to him later.

Remember: if a call is in the callframe, space will load it into the call textbox.

If all this seems very unfamiliar, you haven't read the Key Assignments help (and/or the Key
Assignments Shortlist).
Reading that single item is your single best time investment in using this program.

Spots and the time shown

When you hover with the mouse over a spot in the bandmap, it will show the relative age of a spot
in minutes. The time shown here depends on the spot format. There are two formats for spots. One
is for current spots, one is for SH/DX spots. Some clusters allow to show old spots in the current
spot format. The program handles the two types of spots differently.

e Current spots go into the bandmap with the computer's local (converted to UTC) time. This is
to remove variations in cluster times and order the spots into the time they were received.

e Old spots are logged with the originating cluster's time with the provision that it cannot be
later than the current local (UTC) time.

With AR-Cluster you can display old spots with SH/DX or SH/FDX. It is recommended to use
SH/DX, as it will be recognized as an old spot. Other cluster software may have similar capabilities.

Red lines indicating US license frequencies

On the bandmap there are red lines to indicate extra, advanced and general portions of each band.
Since US hams can operate only in their section and the sections of lower class licenses, it is in
your interest to operate some in the higher portions of each band. Otherwise there are some US
hams you will not ever be able to work.

The lines can be found on:

e SSB: 3775, 3850, 7225, 14175, 14225, 21225 and 21300.
e CW: 3525, 7025, 14025 and 21025.
e No lines on 160 and 10 meters.
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. Supported Packet clusters:

. CW Skimmer and the Reverse Beacon Network (RBN)

Your Packet/Telnet window will be similar to this one, with Packet and Telnet tabs. The former is
used only when connecting to an RF packet cluster node. Unless specifically differentiated,
references in this manual to packet also apply to Telnet. For example, "Packet Filters" and "Packet
Spot Timeout" also apply to Telnet.

U U9 Frofil:
[0 de HITO:

D de OGELAY
HHY de THAOG
O de OHAPO:
D do R¥3RC:

[ de OK10W:

% de RX3RC:

0¥ de RU3AT:
[ de OK10W:

0% de SPA0FH:

[ de DGAKAS:
[ de SHOKAK :
0¥ de PL4ALE:
0¥ de EA7OEN:

0¥ de ITI0AA:

= Telnet Window - Host: K1 TTT.HET - Timeout 30 minutes - |3 |r5_(|
Packet | Telnet FITTT.MET * | Close Part
rUod.U0 RAYNL FLINL QRUY doull A
140854 IN2CT ETTY 18007 b

-7 140889 AI9T 18027

I <8f> « 8FI=121, A=1a, K=3, E= 85 Ho ztornz=>Ho storns

14260.0  PYMRCAT Tin  SA046 17582

7043.4  EE4HNT EOAC SE32 18027

1441300 RKAHC prazhu tove EHE sked cu 17592

18072.1  YIOKT 18012

144200.0 DLORSHALH - JO44HT <> J03000 59 18017

1442950 FFILGT JO96BH-T01 18K 18027
28081.0  DLZFAG ETTY 18022 =

1442990 ER3ABSSY IHASRH Cq Cq 18022

J063.4  RK9DY EOAC 5433 18037

14000.0 WIZHI (C-223 any nore act ivity? 18002

36999 IRSHHS ROA 18032
18075.4  WIZLK 18037 b
BvE | CONN | DM | SH/DX | USERS | wwev | 10M | 18M | 2oM | 4oM | B0 | PaIM |

2/2/2011 4:54 PM



208 of 680

http://nlmmtw61.semdxa.org/tiki-print multi _pages.php?printstructures...

The button values can be changed by right clicking on them or going into the menu: 'Config >
Change Packet/CW/SSB/Digital Message Buttons > Change Packet/Telnet Buttons'.

Connect and other messages are shown in the bottom pane from the Entry window. Status info for
Telnet is given in the Telnet window title. Focus is set to the Entry window when one of the 12
buttons is clicked.

All incoming DX spots are placed on the bandmaps. Also the spots requested with commands like
SH/DX etc. Split information given in the spot comment will be recognized. When such a spot is
selected the transceiver will go into split mode (if applicable). The program recognizes: UP, U,
DOWN, DN, D and the word QSX. Examples: QSX 3.838, QSX 4, UP 5, DOWN 2, U 5, D4, U4,
DN4, UP4, DOWN4, QSX7144 etc.

Where possible mode, state/section, grid etc. are extracted from comments on incoming spots. Grid
square from spot comment is used to calculate bearing reported in Bandmap, Available window,
Info window and Entry window.

When telnet is selected a Telnet DX-cluster can be chosen from the top of this window. By clicking
the 'Close Port' button the current connection will be closed. A telnet cluster can be updated in the
configurer dialog (Tab: Hardware).

Packet/Telnet has a nine minute stay-alive function which sends a CR every nine minutes (not
configurable). The timer is restarted when you send a message to the cluster.

1. Colors used

Blue - 'Normal' incoming spots

Red - (Talk) Messages

Magenta - WWV messages

Black - All other messages like cluster welcome messages, SH/DX responses, messages sent
to the cluster, prompts etc.

2. Initial Button Assignments

Below are the default button assignments for the Packet/Telnet buttons. A maximum of 12 buttons
are available for packet and Telnet. Adding more lines in the edit window will not lead to more
buttons (12 is a fixed value). The contents and texts shown on the buttons can be changed to
anything you like.

Button Command Description Packet Telnet
text
BYE BYE Log off cluster OK OK
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Connect to the (non telnet) packet cluster. Example: C Connect -
PE1M-7 You have to set your cluster's call under "Tools
>Change Packet Buttons'.

Show new messages (CLX needs the full: directory/new) OK OK

Show last DX spots OK OK
Show cluster users OK OK
Show WWYV spots OK OK
Show last 10M spots OK OK
Show last 15M spots OK OK
Show last 20M spots OK OK
Show last 40M spots OK OK
Show last 80M spots OK OK
Connect to the Telnet DX cluster by sending your call to - Connect

the Telnet cluster. Most Telnet clusters expect your
callsign as the first text received. The callsign used with
the macro {MYCALL} is taken from the station information
dialog

e Close Port - Close the current Telnet connection.

3. Keyboard Assignments

e Ctrl+C - Sends Ctrl+C to the TNC which is used by TAPR TNC's.

e Ctrl+Z - Sends Ctrl+Z to the TNC which is used by TAPR TNC's.

e Shift+Escape - Places an Escape character on the command line which is send to the TNC
after pressing Enter. The Escape character is being used by WASDED/ TF firmware TNC's.

The Packet/Telnet window must be active and the cursor must be on the command line.
N.B. The Escape key (without the Shift key) makes the Entry Window active.

4. Mouse Assignments
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e Left mouse button
o Single click - Tune the active radio to the frequency of the spot.
o Shift+click - Tune the inactive radio to the frequency of the spot.
o Double click - The spot under the cursor will be placed in the callsign field in the Entry
window and gets focus.
o Ctrl+Single click - Tune the non-active radio to the frequency of the spot and make it
active.

L Split operation
If you click on a spot that has a QSX (listening) frequency given, your radio is under program
control, and your radio can accept split commands, then the required QSX will be set.

¢ Right mouse button - Displays a menu - see below

5. Right Click Menu

i™= Telnet Window - Disconnected from: E|@|PZ|

Packet | Telnet| Type: FEN +| Close Por

To connect to Telnet, type yvour call and press enter, or press the
button with wyour call on it below.

Why don't I see spots? (Show packet filters)

Configure Ports, Telnet Address, Other
Edit Telnet Cluster List

Change Packet/Telnet Buttons

Close port

Specify Comment for All Spots

Auto Logon

Packet Spot Timeout

Remove Packet Spots, Leave Self Spots
Remove all spots

Packet Filters »

Set Font

sk1e0 | skeo | skdo | ska2o | SK15 | copy B0 | a0 | w4z
Help

o Why don't | see spots? (Show packet filters) - A window will open showing the current
spot settings in effect.

o Configure Ports, Telnet Address, Other - Displays the 'Configurer' dialog.

o Edit Telnet Cluster List - Displays the 'Change Packet Cluster List' dialog. Here you can
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add, edit or delete telnet cluster sites.
o Change Packet/Telnet Buttons - Change the label and contents of the packet/telnet

buttons. Note that the use of '&' in the Button Caption will cause the following lettered

key to become a "Alt+Hotkey."

o Close Port - Close the packet or Telnet connection (depends on the selected Tab)

o Specify Comment for All Spots - Enter the text you want appended to every spot. La
for the session only. Exit clears it. Example: PACC

sts

o Auto logon - Automatically connect to a cluster when the program starts. When running

Telnet, auto logon will send the right-most button (which by default contains the

{MYCALL} macro). When running packet, auto logon will press the second button: "C
call". When running both, only the one that was in focus the last time before closing the

program will be re-started.

o Packet Spot Timeout - Indicates how long (in minutes) spots are kept in the Bandmaps.

The default is 60 minutes, but any integer may be specified.

o Remove Packet Spots, Leave Self Spots - Remove all spots coming in via packet or
Telnet but leave all self spots in the Bandmap.

o Remove all spots - Remove all spots from the Bandmaps. This means that also all
information on the Available Mults and Q's window is cleared.

5.1. Packet Filters

™ Telnet Window - Disconnected from:

Packet | Telnet | Type: REN = | Cloze Port

To connect to Telnet, type vour call and press enter. or press the
button with wyour c . alowHF

Allow WARC
Allow VHF
Allow spots from my country only Why don't I see spots? (Show packet filters)
Allow spots from my continent only Configure Ports, Telnet Address, Other
Allow only spots from spedified call areals) Edit Telnet Cluster List
Enter call areas (currently K3 K4) Change Packet/Telnet Buttons
Allow spots for this contest's mode(s) only Close port
Filter Blacklisted Packet Spot Calls Spedfy Comment for All Spots
Edit Packet Spot Blacklist Auto Logon
Packet Spot Timeout

v Filter Spots from Blacklisted Spotters

R Packet Spots, Leave Self Spots
Edit Spotter Blacklist EMOVE FadEl Spats, Leave o€l 5po

Remove all spots

Set Font

sk160 | skeo | sk40 | skzo | sk1s | sk10 | SHDX | 1f Copy
Help

Change Subbands for mode filter r Packet Filters r

¢ Allow HF - When selected all spots on the HF bands ( < 30 MHz) are passed to the
Bandmaps. See note below.
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¢ Allow WARC - When selected all spots are passed to the Bandmaps from the WARC bands.
See also note below.

e Allow VHF - When selected all spots on the VHF bands (> 30 MHz) are passed to the
Bandmaps. See note below.

¢ Allow spots from my country only - When selected only spots originated from your own
country will be shown in the Bandmaps and Available window. See note below.

e Allow spots from my continent only - When selected only spots originated from your own
continent will be shown in the Bandmaps and Available window. See note below.

e Allow only spots from specified call areas - When selected only spots originated from specified
call areas will be shown in the Bandmaps and Available window. See note below. The spots
can be specified at the next menu item. A call area is the country prefix + the first number in
the call. Example: Call: WB1KK Call area: K1 (K + 1)

o Enter call areas) - Call area filter for the menu item above. Enter list of call areas to pass
separated by spaces. Example: K1 K2 K3 K4 and select the OK button. To clear the list
enter only a space and press the OK button.

¢ Allow spots for this contest's mode(s) only - Only allow spots where the mode is equal to the
mode set in the contest setup.

o When the mode is mixed the selection will be anything "not digi".

o Filter Blacklisted Packet Spot Calls - Used to block spots of specific calls from being added to
the bandmap. Could be used to filter out persistent busted spots.

o Edit Packet Spot Blacklist - Just what it sounds like, for adding to or deleting from the list of
blacklisted spot callsigns

o Filter Spots from Blacklisted Spotters - For use any time you do not want to receive spots from
a particular spotter. For example, if an RBN station's receiver were to be severely off
calibration, you could opt to block spots from that station rather than chase phantoms all
weekend.

o Edit Spotter Blacklist - Again, just what it sounds like. Add or delete spotters whose spots you
wish to be blocked.

e Change Subbands for mode filter - These are the definable band edges. The frequencies
added (in kHz) are used for the specific mode. Note that no band edges are defined for
Digital. What you will want to do for digital is add say 7060 7090 for band edges. That range
will show as magenta in the Bandmap. If you click in that area and you are following the band
plan , then the mode will change appropriately. Make sure you have the desired mode control
defined in the config dialog ('Config | Configure Ports, Telnet Address, Others | Tab: Mode
Control | Follow band plan (default)'). The bandplan is computed as follows: Is it Digital? If
not, is it CW? If not then is it SSB.

Note: The default US bandplan is used by the program. Non-US stations have to make changes to
that bandplan. An example is 40 meters for Europe where the CW part of the band is mostly much
smaller.

o Change CW Bands - The band 7000 to 7035 is set as CW (Europe), the frequencies
above are automatically set to SSB if no digital sub bands are set.
o Change SSB Bands - The sub bands for SSB , if nothing is set this is the default mode.
o Change Digital Bands - The sub bands for the digital modes
e Set Font - Change the font of the Packet/Telnett text boxes. Fixed fonts (like Fixedsys,
Courier, Anadale Mono which has slashed zeros etc.) are recommended, so that columns will
line up.
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e Copy - Mark a part of the Packet/Telnet window with the left button, then right-click and
choose copy. The selection will disappear before you choose copy, but that doesn't matter.
You can then paste the selected area into Word or Notepad or whatever you like.

e Help - Show the help file for this window.

Note: Allow spots and Allow HF/VHF/WARC filter settings.

These settings have nothing to do with what shows in the Packet/Telnet window. They are not
commands to the DX cluster, instead telling the program whether to use the spots in the Bandmaps
and the Available window.

Clear spots will take all the spots that appear in those two windows and delete them. It does
nothing to the Packet/Telnet window. The spots shown in the Packet/Telnet window itself will not be
filtered; you would have to do that at the cluster node. Learn your cluster's filtering commands. This
is the best way to accomplish what you want.

6. Special keys:

o Ctrl+key - Holding the Ctrl key while clicking in the packet window will jump the non-active
radio to that frequency and make it active

7. Macro keys

Macro key substitution is supported by the buttons in the Packet window and also in the comments
send with a spot (using Shift+F9).
The macros which can be used and some examples can be found on the macros page.

In the substitutions you can include things like {CTRL-M}. There is also a {WAIT} macro that waits 5
seconds and macros for {GRIDSQUARE}, {MODE}, {ZONE} and {QTH}.

So if you needed to press CTRL+M, then wait for a prompt, then C PE1M-7 then enter your callsign,
you could change the button to send:

{CTRL-M{WAIT}C PE1M-7{WAIT}PATM

Enter is sent automatically after each command. This may cause a problem with some systems.

8. How to add/edit/delete a Telnet cluster

There are three places where you can get to the 'Change Telnet Cluster List' dialog. Select one of
them.

¢ Right click in the "Packet /Telnet window" and select 'Edit Telnet Cluster List' or
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¢ Select 'Config | Change Telnet Cluster List or
e Select 'Config | Configure Ports, Telnet Address, Others | Hardware tab' and click on the 'Edit'
button.

The 'Change Telnet Cluster List' dialog will appear. You can go to the bottom of the list and add
what you want. Look at the already entered Telnet clusters to see what to enter. To delete a row,
click on the row "handle" - the gray arrowhead - and press the 'Delete' button on your keyboard. To
edit an entry select the field to update and enter the new information.

9. How to setup and connect a Telnet cluster

1. Add the Telnet address to 'Config | Change Telnet Cluster List'.

NB. Use gb7ujs.shacknet.nu as a model for how to specify a port other than 23.

2. Click on the Telnet tab in the Packet/Telnet window.

3. Choose the address to use from the drop-down box left from the button "Close Port".

4. To connect, click on the F12 button with your callsign in it.

*This presumes that the cluster you are using is looking for your callsign as the first thing to be sent
(which it usually is).

5. Now you should be connected to the cluster.

10. How to setup and connect to a Packet cluster using a TNC

1. Click on the Packet tab in the Packet/Telnet window.

2. Set up the connect string for your local packet cluster under the F2 (Conn) button.

3. Click on the F2 button (Conn).

4. Now you xhould be connected to the cluster.

*In general, setting up the connect string and the possible use of intermediate relay nodes to reach
the cluster causes most problems..

11. Auto connecting to a cluster

e Set up your packet or Telnet to the cluster, to connect as explained above
¢ Right click in the Packet/Telnet window text area and select Auto Logon in the men:
e From now on the program will connect to the selected cluster automatically when the program
starts
Auto Logon works only at program startup.
o Button 1 or button 12 is sent to the cluster, depending on whether you are using packet
or Telnet.
There is a "stay-alive" timer that sends a CR every 9 minutes.
If the connection drops spontaneously, you will have to re-connect manually.
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12. Spotting stations

Spotting stations has to be done from the Entry window. The station entered in the callsign field will
be spotted. If the callsign field is empty the last gso made will be spotted.

e Alt+P spots stations.
e Ctrl+P spots with a comment.
e Spot all S&P QSOs under 'Config'.

The frequency from the spotted station is rounded to one decimal place by the program.

13. Multi-User setup

When running in Multi-user mode (more computers connected in a network) only the Master station
has to be connected to the DX-cluster. The master station will send all information from the cluster
to all connected computers and also send info received from the connected computers running
N1MM logger to the DX-cluster.

14. Computers on a LAN

It is possible to connect to Telnet hosts when the Internet connection is on a LAN via proxy server or
router. First try to access the Telnet cluster via the Telnet program in Windows, if this works it
should also work from within NTMM logger. It does not matter if the proxy is in software or hardware.
Port 23 (=telnet) should be open.

15. Packet via the soundcard

Many hams use AGWPE for packet using the soundcard. N1MM logger is not able to direct use this
package but there are ways using additional software to get NTMM logger and AGWPE work
together. Basically you telnet from inside NTMM to either of these applications. They are in turn
linked to AGWPE. Links to these programs can be found in the links section.

e TelMgr by LU7DID
¢ Telnet interface by IZ4AFW

16. Supported Packet clusters:
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e AR-Cluster by AB5K
e Clusse by OH7LZB (not fully supported, only incoming spots)
o To make Clusse more compatible give the command SET/PCMODE YES (typed in
uppercase).
o Only incoming spots will be decoded by N1MM logger (not the response to the List
command)
o The List command (SH/DX) has a different format and will not be decoded.
CLX by DJOZY and DL6RAI
DX-spider by G1TLH
o DX-spider uses a different SH/DX format, check in 'Configurer / Other' the setting
'Format for DX-spider support'. This will send the right SH/DX message from the button
in the top of the bandmaps.
DXnet by FSEMZN (Unknown if fully supported but it probably is)
PacketCluster by AK1A
Wincluster Lite by KH2D
More?

17. CW Skimmer and the Reverse Beacon Network (RBN)

CW Skimmer version 1.1 and up has a built in Telnet server which allows N1MM Logger to receive
spots from it. Add an entry to your Telnet list with the address: 127.0.0.1:7300 if you are running
Skimmer on the same machine as NTMM Logger. If running on a different PC on the same network,
use that machine's internal IP address in the same format.

The Reverse Beacon Network's Telnet server (telnet.reversebeacon.net:7000) makes all of the
RBN's Telnet spots available to the program. Because of the huge volume of spots on a major
contest weekend - at least ten times as many as the conventional cluster network - we highly
recommend that you use the Telnet server's filtering capabilities to manage the quantity actually
sent to you. The server uses the DXSpider software, which has very flexible filtering capabilities. It
will be helpful to use a short Packet Spot Timeout (set on the right-click menu of either Bandmap) -
15 minutes should be more than adequate, because CW Skimmer re-spots stations that remain on
the same frequency every 10-12 minutes.

Skimmer spots can be merged with spots from conventional DX clusters using software such as
WintelnetX, freeware by K1TTT. In that case, Skimmer spots are distinguished from regular spots
by the addition of unique markers. In the Bandmaps, Skimmer or RBN spots are identified with "#"
after the callsign and bearing; spots from your own Skimmer, identified by the callsign set in your
Station Data), are marked with "!"

Check
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In this Section...

1. Features

2. Colors of the callsigns
3. Keyboard Assignments
4. Mouse Assignments:

5. Wildcard search

1. Features

e The Check window displays all the callsigns from the MASTER.DTA file and worked calls from
the current log, which match the input in the callsign field of the Entry window.

e The Check window is not cleared until a character is typed in the callsign field in the Entry
window, so clearing the callsign field won't clear the Check window.

¢ All callsigns are shown in upper case.

¢ |n order for the Check window to be active, there must be a valid master.dta file in the
program file directory. A variety of such files may be downloaded from this site . For
example, master.dta files are available comprising only US and Canadian callsigns. The
master.dta file used for a given contest is selected on the Associated Files tab of the Contest
set-up window.

The title bar shows Mul: or Q: followed by the band.

e 2X: - This station would be a Double Multiplier on this band (this country and zone)

e Mul: - This station would be a Multiplier on this band (country, section, etc.)

¢ Q: - This station would be a new QSO on this band

e Example: Mul: 15 20 Q: 160 80 40 10 - This station would be a new Multiplier on 15 and 20
meters, or just a new QSO on 160, 80, 40 and 10

Note: For the title bar to operate correctly, the "Available Mults and Q's" window must be
open.

The Check window is divided into two areas:

e Upper area: callsigns found in this contest log
o QSOs made in this contest
e Lower area: callsigns found in the selected master.dta file
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ohede @ (LSRR Sl checlctuk 10_0: 16060 4020 15

baster DTA: and no callsign is entered the Missing
16-8-2006 9:48:23 : : Master. DT
1076508 Butes CheCk_WmeW will show the Get it from Internel]
date, time and length of the

MASTER.DTA file.

When the master.dta file for the
selected contest is not found or
missing a warning will be given,
Use 'Download latest Check
partial file (Master.DTA)
(Internet)' under "Tools' to
download the file from the
Internet

Check - Q: 160 80 40 20 15 10 il When there are no matches Check - Q: 160 10
Unique| found Unique will be shown in N1MM - Dupel
big red letters

E3)

When the station entered is a
dupe it will be shown in black
and the text Dupe! will be added
in red

E3)

Check - 2 160 80 40 10 (: 20

PVEBDR - Dupel

PVeDX

v Show N+1 Calls
Set Font
Help

On this window's right-click menu, shown above, there is the option to select "Show N+1 calls." If
this option is checked, callsigns will be shown that are one letter or number different from the
callsign entered in the Entry Window, as in this example. This can be very helpful when listening
under difficult conditions where you are not sure of the callsign.

e When a callsign entered matches a call in the log, the callsign in the Check partial window wiill
be set to bold and 12 point font (PA1M below).
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e Entering PATM in the callsign field will give PATM, PATIMR, PATMV and all others with PA1M in
the callsign (picture below left). When N+1 is selected also all callsigns with one character
difference will be shown (picture below right).

N+1 not selected PA1M entered in Entry window |N+1 selected

Check - Q: 160 80 40 20 15 10 3l No QSOs match the entered call fai e B L E PR LR 3]

in the log so the window starts Fal1K
PATM  Pa1MR PaTMY i i

P L with g blank line. When a PAIM  FalMRE  PATMY
callsign matches the master.dta J|Faimvl  PAOM PA1A F41B
- T P&TH PalT Palw  PAIX
file or the log it will be set to Fi b PE1H |

bold and 12 point font

(Example: PA1M)

When N+1 selected,PA1K is
found in the log and many more
callsigns differing by only one
character are found in the
master.dta file. The differing
character is shown bold

2. Colors of the callsigns

Blue |New contact on this band

Black Dupe contact or a station in a non-workable location.
This means that you don't need this station because he is a dupe or you are not allowed to
work him by the contest rules.

3. Keyboard Assignments

o Alt+Y - will "yank" the first call from the Check window into the callsign field of the Entry
Window that has the entry focus.

4. Mouse Assignments:
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o Left mouse key clicking on a callsign in the listbox
o Click on call - Enter the call into the callsign field on the Entry window replacing
whatever was there.
= When clicking on a call with spaces, only the first token will be loaded as callsign
¢ Right mouse key clicking, a menu will appear
o Show N+1 Calls - show all callsigns with one character difference from the callsign
entered in the Entry window callsign field. The different character will be shown bold.
o Set Font - Set the font for the Check Partial window, a selection window will appear.
o Help - Show the help file for this window.

5. Wildcard search

If one or more characters are not known a ? may be used in the callsign field in the Entry Window.
It needs two sequential characters like N?MM or N1? to find the call. So M?M will not work!

Searching for leading wildcards is also implemented. l.e. ?1M matches KN1M as well as N1MM.
N+1 will do this automatically for one ? im place of each expected character in the call.The use of
two question-marks is also allowed, for example ??1M

Examples:

PA?M will match PA1M, PA7MM etc.
P?1M will match PA1M, PG1M, PF1MO etc.

P?3 will match no callsigns because there are no two sequential characters
?1M will match N1MM, KN1M, PA1M etc.

Available Mults and Qs

In this Section...

Quick Tour (a must read!)
Step 1. Setup
Step 2. Adjust Window Positions
Step 3. Connect the Sound Card and the CW interface
Step 4. Entering a Call
Step 5. Using the Space Bar to Tab
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Step 6. Using the Tab Key
Step 7. Bandmaps, Spots and Other Cool Stuff
Step 8. Spots are Fun
Step 9. Actually Logging Contacts
Step 10. The Exciting Finale
Step 11. CW and WAV Recordings
Installing and Upgrading N1MM Logger
1. First-Time Installation Instructions
2. Using the Program the First Time
3. Subsequent Install Instructions / Upgrading to a New Program Version
4. Uninstalling the Program
Setting up the Program
1. Setup Station Information
. Setup Radio Control
. Setup Packet/Telnet
. Setup PTT-ing the Rig/Sending CW
. Setup WAV Files (SSB)
. Sending Messages in CW
. Setup 'Sent Exchange'
. Setup the Exchanges
9. Setup Function Keys for Enter Sends Message (ESM) mode
10. Command Line Parameters
Basic Functions
1. Help
. Going Through the Entry Window Fields
. Resizing Windows
. Select New Contest
. Delete Contest
. Select Country file
. Select Master.dta file
. Changing Frequency
9. Changing Band
10. Changing Mode
11. Changing Operator
12. Setting CW Speed
13. Split Operation
13.1. Setting Spit Frequencies Manually
13.2. Setting Split Frequencies Automatically by Packet Spots
13.3. Resetting to non-split mode
13.4. Split Operation Key Assignments
14. Running Mode
15. Search and Pounce Mode (S&P)
15.1. How to check if you are in Running mode or in S&P mode?
16. CQ Key
17. Set up the Sent exchange message(s)
18. Function Key Conventions
19. Set Up N1MM to Record and Playback Voice Recordings (recording on the fly)

O NO O~ OWN

O NO O~ WDN
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19.1. Playing WAV Files
19.2. Recording WAV Files
19.3. Soundcard Control in Configurer
20. Quick Edit
21. Meaning of Colors
22. Multipliers and QSOs
23. Connecting to a Telnet Cluster
24. How to Save the Log
25. Function Key Macros
26. Save and Restore Window Positions
27. Editing Lookup Tables
28. Backup and Restore
28.1. Method 1: Full backup/restore on same computer - backup and restore
the whole N1MM logger subdirectory
28.2. Method 2: Partial backup/restore on same computer - make a partial
backup and restore.
28.3. Installing on a Different Computer
29. Basic Functions for RTTY

Advanced Functions

1. Mobile/Rover Support
1.1. How Mobile/Rover Works
2. Call History Lookup
2.1. The Call History Text File
2.1.1. Menu options
3. Spot Filtering
4. Transmit on same band with two radios
5. Big Gun versus Little Pistol switch
5.1. So you are a big station
5.2. So you are a little pistol
6. Staying in Run Mode (great for Dxpeditions) or in S&P mode
7. Auto Send
8. Enter Sends Messages (ESM) Mode
8.1. Basic ESM Functionality
8.2. How to Prevent the Cursor from Moving to the Next Exchange Field
8.3. How to Skip Sending the Callsign or Exchange Field (SSB)?
9. QSYing Wipes the Call & Spots QSO in Bandmap
10. Single Operator Call Stacking
10.1. Additional SOCALLSTACK Information
10.2. Digital Call Stacking
10.3. How to Tell Visually Which Call Will be Put in Next
11. Call Stacking (same or different bands) - Multi-User Mode
12. Serial Number Server
13. Contest Reporting Application
14. Starting a Contest with a Number Other Than 001
15. Single Operator 2 Radios (SO2R)
16. Footswitch Support

Configurer Dialog
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. Configurer >Hardware tab

1.1. Hardware setup

1.2. Set button examples

1.3. Other Information

1.4. Windows NT/2000/XP (32 bit OS)

. Configurer >Telnet Cluster tab
. Configurer >Files Tab

3.1. Files Field Descriptions

. Configurer >Function Keys Tab

4.1. Function Keys Field Descriptions
4.2. Remapping Function Keys

. Configurer >Digital Modes Tab

5.1. Digital Modes Field Descriptions

. Configurer >Other Tab

6.1. Other Tab Field descriptions

. Configurer >Winkey Tab

7.1. Winkey Field Descriptions

7.2. How to Set Up Winkey in NTMM Logger
Configurer >Mode Control Tab

8.1. Mode Control Field Descriptions
Configurer >Antennas Tab

10. Configurer >Audio Tab
Start a New Contest Log or Open an Existing Contest Log

1.
2.
3.

Start a new contest log
Open an Existing Contest Log
Contest Specific Information
3.1. Contest Tab
3.2. Tab: Associated Files

Entry Window

© 0O ~NOOAWN

. Button Assignments

. Callsign/Exchange Editing Features
. Other Info

. Status Bar Information

. Callsign Colors

The Red and Green dots (LEDs)

. The Entry Windows
. Other Features
. Function Keys

9.1. General
9.2. Running mode and S&P mode

10. Other Keys

11. File Menu Selections
12. Edit Menu Selections
13. View Menu Selections
14. Tools Menu Selections
15. Config Menu Selections

15.1. Configure Ports, Telnet Address, Other - Also called Configurer.
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15.2. Change Your Station Data

15.3. Change Sub Bands

15.4. Clear INI file settings

15.5. Find all windows (move to within 800 *600)
15.6. Enter Sends Messages (ESM mode)

15.7. AutoSend Threshold - Ctrl+Shift+M

15.8. Spot all S&P QSOs

15.9. QSYing wipes the call & spots QSO in bandmap
15.10. Do not run on CQ-frequency

15.11. Show non-workable spots

15.12. Reset Rx freq when running split

15.13. Dual Rx always on

15.14. CQ Repeat - Alt+R

15.15. Set CQ repeat time - Ctrl+R

15.16. Call History Lookup

15.17. Record QSOs

15.18. Change Packet/CW/SSB/Digital Message Buttons - Alt+K

15.19. Multi-User Mode
15.20. Change Exchange Abbreviations
15.21. SO2R

15.22. WAE - Special commands for the WAE DX contest only

16. Window Menu Selections
17. Help Menu Selections
Bandmap

1.
. Two radio scenario

. Other

. Colors of the incoming spots:
. Keyboard Assignments

. Button Assignments

. Mouse Assignments

. Example bandmap usage

O NO O bW

Packet

A~ ON -

0 N O

One radio scenario

and Telnet

. Colors used

. Initial Button Assignments
. Keyboard Assignments

. Mouse Assignments

. Right Click Menu

5.1. Packet Filters

. Special keys:

. Macro keys

. How to add/edit/delete a Telnet cluster
9.

How to setup and connect a Telnet cluster

10. How to setup and connect to a Packet cluster using a TNC
11. Auto connecting to a cluster

12. Spotting stations

13. Multi-User setup
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14. Computers on a LAN
15. Packet via the soundcard
16. Supported Packet clusters:
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17. CW Skimmer and the Reverse Beacon Network (RBN)

Check
1. Features
2. Colors of the callsigns
3. Keyboard Assignments
4. Mouse Assignments:
5. Wildcard search
Available Mults and Qs
1. The Header
. The Band Buttons
. Spot List Box

Mouse Assignments
. Right-Click menu
. Multi-mode contests

O N WN

. Band button Assignments
. Band button background colors

The Available Mults and Qs window for single-mode contests is similar to this example (beginning

with release 9.12.5).

Available - 49 Mults 31 Qs [*)
Mults Qs

4 160 1/2

3 M 0/5

28 40 24738

14 L EM7

1] 15 0/0

1] 10 00
Call | Freq | Dir | Mode | TS ~
EBTD 7009.0 OB7* | Cw 12417 2148
(AR LY 35501 2680 Ow 12417 2147
EABGTO 7015.9 057", Cw 12972147 [
KD, 7027.8 OBO°.. Cw 12417 2146
ITOLK 7003.2 062 W 12417 2140
WML 7034.0 2647 Cw 12417 2136
WTGE 14049.1 28101 O 1217 2136
SP2GWH 7009.5 0457 W 12417 2134
[ 3AZ1 7011.1 059°..  Cw 12417 2133
COEWD 140123 207 Ow 12417 2133
HEACZE 140223 183 W 12417 2132
DL4R 7011.0 05071 O 1217 2130

70147 OB0°. O 1217 2129

YO7LCE 70220 O50° 1 O 1217 2125 ™
£ | >
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This window consists of three parts, the header, the band buttons and at the bottom the multiplier
list box.

1. The Header

The header shows the number of Available Multipliers and QSQO's. (Example 4 Mults 12 Qs), and

226 of 680

2. The Band Buttons

Available - 11 Mults 12 Qs (No Spot Focus Change) 3]

Mults Qs
0 160 0/0
3 an 042
4 Al 1/2
4 20 1141
0 15 0/0
0 10 0/0
Call | Freq | Dir | Mode | TS
DLAHG 14014.9 a7 Cw 121813239
DLSLM 140332 047 Cwf 12181329
QARG 140257 04671 Cwf 12181329
DLAFCE 14011.5 0471 O 12181328
FG/DGE2 140852 1447 Cwf 12181328
EARAGF 14051.8 naze..  Cw 12-18 1326
ADR 3526.2 2200, | 2181325

DJ4B: 82 o7

AKARS f1E2 2207

=

W 218 1325
12181324
12181320

also reports on some of the right-click menu items that may affect what happens when you click on
a spot. See below for specifics.

You will note that this window does not appear to have the entry focus except when you have right-
clicked to access the context menu to change the window's settings. This is as designed, because
keyboard/mouse click focus should normally be on the Entry Window. Nonetheless, mouse clicks
on band buttons and individual spots will be acted upon, as outlined below.

The top part of this window indicates the number of multipliers (left column) and potential contacts
(right column) available on each band. The two numbers in the right column reflect the number of

workable (non-dupe) QSOs available, and the total number - the latter is useful to determine
relative band opening quality in a contest, like Sweepstakes, where late in the contest you may
have worked most of the active stations. For example, the right column might display "2/47",
indicating a wide-open band but with only two stations you have not already worked.

Red numbers indicate the band with the largest number of contacts (QSOs) available. The WARC

bands only appear when DX (the default general logging contest) is the active contest. A VHF
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version will appear when a VHF contest is selected.

For a contest such as FD that allows HF and VHF, the lack of band buttons for VHF+ means (i)
there will be no available spot totals displayed for the VHF+ bands; and (ii) there is no single click to
QSY to VHF. You must either type in a frequency or QSY the radio manually to get to a VHF+ band.
Even though the HF button set is shown, VHF spots that are workable in a particular contest will
still appear in the lower pane of the available window (and on the band map); like other spots, those
VHF+ spots are clickable to QSY (assuming radio support).

Each of the band buttons changes color when a callsign is entered in the callsign field or, in the
case of contests where the multiplier cannot be determined from the callsign, when the exchange is
copied. The color (green, red, blue or none) denotes whether that station is needed on that band as
a double multiplier (green), a single multiplier (red), a valid non-duplicate QSO (blue) or not needed
(none). The intention is to let you know whether you need that current station's multiplier on other
bands, so that you can move him if you wish.

The active band's button text is shown in bold.

3. Spot List Box

The list box (the lower section of the window) shows spots received via Packet or Telnet. There are 4
columns: Call, Frequency, Bearing (Dir), and Time (TS) in the format "mm-dd hhmm". Clicking on
the selected column title will sort the column, clicking again will reverse the sort order. An indicator
of split spots (a "AA+") appears next to frequency. Spots coming from a local Skimmer are shown
with a (!) to the right of the bearing, and those from a non-local Skimmer with (#).A sunrise/sunset
indicator (a "A/Aa") is shown to the right of the bearing for spots where applicable, as an aid to
determining which spots may either be "perishable" or particularly suited to a gray-line QSO.

The color codes described are applied to each call listed; however, duplicate QSOs are not
displayed.

4. Band button Assignments

e Left click on band button - Set the left radio or VFO-A to the first spot on the band specified.
¢ Right click on band button - Set the right radio or VFO-B to the first spot on the band
specified.
o Note: When both Entry windows are open on the same band (in SO2V), then clicking on

a call will bring this call to the window without transmit focus. Select the correct
radio/VFO by right or left clicking the band button. You should not be able to select the
same band on both radios in SO2R, unless you deliberately do it on the radios' front
panels. For obvious reasons, this is not a good idea,
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5. Band button background colors

¢ Blue: Available QSO

e Red: Single Multiplier. Example: CQWW - QSO is either zone or country multiplier (one
multiplier)

e Green: Double or better Multiplier. Example: CQWW - QSO is a zone and a country multiplier
(two multipliers)

e Gray: Dupe

6. Mouse Assignments

¢ Left mouse key clicking on a callsign in the list box
o SO1V
= Single Left click - Always send the spot to VFO-A.
= Shift + Single Left click - No action.
o SO2V + set for "Basic VFO Selection" (set in the Right-Click menu explained below)
= The selection Basic VFO Selection" or "Advanced VFO Selection" can be set/seen
in the right click menu.
= When set for "Advanced VFO Selection" the window title tells you the setting of
this option.
= Single Left click - Send the spot to VFO-A.
= Shift + Single Left click - Send the spot to VFO-B.
o SO2V + set for "Advanced SO2V VFO Selection" (set in the Right-Click menu explained
below)
= Single Left click
= If both VFO's are not on the spot band, send the spot to the Active VFO. The
spot VFO Entry Window and Bandmap wil be made active.
= |f either VFO is on the spot band, use the VFO which is on the spot band
checking the active VFO first. The spot VFO Entry Window and Bandmap wil
be made active.
» Shift + Single Left click - reverse the VFO selection determined above.
o SO2R + set for "SO2R Focus Follows Spot" (set in the Right-Click menu explained
below)
= The radio that the spot is sent to will be made active if "SO2R Focus Follows Spot"
is checked. If the option is un-checked, the window focus will not change.
= Single Left click
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= |f both radios are not on the spot band, send the spot to the inactive radio.

n [f either radio is on the spot band, send the spot to that radio.
= Shift + Single Left click - Reverse the VFO selection determined above if the
selection will not place both radios on the same band.

o Double click - Go to the frequency with the active VFO. The callsign on which you have
clicked is placed in the callsign field in the Entry window overwriting anything that was in

there!

¢ Left mouse button clicking on column title
o Toggle the sort order of the spot list between ascending and descending based on the

column selected (Call, Frequency, Bearing (Dir), Time (TS).

7. Right-Click menu

The following screen-shot shows the right-click menu effective with version 10.8.0

v Advanced 502V VFO Selection (radio dependent)
v Enable right did: Q5Y on spat

Turn Rotor

v Show Qs Mults

1
2
3
4

- Show Focus Radio/NFO

- Show Mon-Focus Radio/NFO
- Show Both RadiosNFOs

- Show All Bands

160M
a0mM
40M
20M
15M
10M

v All Modes
CW Mode
S5E Mode
RTTY Mode
PSK Mode
Contest Mode Category

Help

If you right click in the Available Window these menu items will appear. Not all menu items are

always selectable.

¢ Delete Spot - Delete selected spot from the list of spots. This option is only selectable when
you right-click on a call-sign in the lower list box.
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¢ Advanced SO2V VFO Selection (radio dependent) - Determines the SO2V single left click
behavior on a spot in the bandmap. See the details above. The option is grayed out when
SO2V isn't selected and the window title tells you the setting of this option. Added because
not all radios will work with the Advanced setting.

e Enable right click QSY on spot - When checked a right click on a spot will cause the inactive
radio or VFO to be programmed without changing the Entry window focus. If a split spot is
selected in SO2V mode, the TX frequency will not be programmed because it will change a
potential RUN frequency. When this occurs, a message is printed at the bottom of the Entry
window. Right clicking on a spot in SO2R mode that would place both radios on the same
band is ignored. This option needs to be unchecked to allow spots to be deleted or the rotor
to be turned from the Available window. This option is grayed out, not available in SO1V
mode.

e SO2R Focus Follows Spot - Determines the SO2R single left click behavior on a spot in the
bandmap. See the details above. The option is grayed out when SO2R isn't selected and the
window title tells you the setting of this option.

e Turn Rotor - Turn rotator to bearing for selected callsign

The remaining options operate at all times. Note that none of the following options affect the
contents of the bandmap(s). Only the list of calls in the Available window will change.

e Show Q's_Mults - toggle between showing all spots or just multipliers

¢ 1 - Show Focus Radio/VFO - Show only spots on the band of the VFO or Radio which has
entry focus.

e 2 - Show Non-Focus Radio/VFO - Show only spots on the band of the the VFO or Radio

which does not have entry focus.

3 - Show Both Radios/VFOs - Show spots on the bands of both VFOs or Radios.

4 - Show All Bands - Show spots on all bands.

160 - Show only 160 meter spots.

¢ 80 - Show only 80 meter spots.

¢ 40 - Show 40 meter spots.

e 20 - Show only 20 meter spots.

¢ 15 - Show only 15 meter spots.

¢ 10 - Show only 10 meter spots.

Beginning with version 10.8.0, this menu permits setting of spot filters by mode. The options are:

e All Modes

e CW Mode

SSB Mode

RTTY Mode

PSK Mode

Contest Mode Category
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Only one of these options can be selected at a time. The first three are self-explanatory. Since
many spots The program distinguishes between RTTY and PSK spots based on the Comments
field in the spot - BPSK, PSK31, or any other word containing "PSK". If "Contest Mode Category" is
selected, the program will only display spots in the Available window that conform to the Contest
Mode Category selected in the Select Log Type dialog (also called the Contest Setup dialog).

© Filtering notes

There are three levels of spot filtering available. The first of these is at the DX cluster node,
using whatever filtering capabilities are built into the node. Because N1MM Logger stops
processing telnet messages when CW is being sent, users who are connected to a very high
volume node, such as the Reverse Beacon Network's Telnet node, may find it advantageous to
block some of the less useful spots (for US users, you might not want spots from VK, for
example).

The second level of spot filtering is accessible from the right-click menu of the Packet/Telnet
window, and decides which spots received from the cluster node should be forwarded to the
Bandmap and the Available window. If too many spots are forwarded, depending on how fast
your computer is, you may encounter brief delays in execution of commands (such as sending
of CW messages) while the program catches up, so it is probably a good idea to use some
filtering at one or both of these levels.

The third level of filtering is in the Available window, and it only governs which spots are shown
in the window's lower pane. For example, if you decide only to list CW spots, the bandmaps will
continue to display all spots, and the top pane of the Available window will continue to display
overall spot numbers for each band, but the lower pane's list of spots will contain only CW
spots. You can quickly switch back and forth between showing all spots, just those on the
current band, only CW or SSB or digital spots, or any other band/mode combination.

¢ Help - Shows this section of the manual from the web site. Internet required

Hovering with the mouse over a spot in the list will show a tooltip with more info about the spot
(frequency, spotter, time, comments)

8. Multi-mode contests

Beginning with version 10.7.2, this window will display one column of band buttons for each mode
in multi-mode contests. Operation is otherwise similar to that in single-mode contests. If the
contest's rules specify that multipliers only count once per band, the colors of both modes' buttons
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for that band will change in unison; if multipliers count once per band and mode, then the band

button colors will show the status, as described below, on each band/mode combination.

Available - 2 Mults 151 §s (Advanced VFO Control) [x]

Mults Qs

CW SSB

3 160 | 160 | 10410

11 an | an | 1111

5 40 | 40 | 43243

34 20 | 20 | 84784

2 15| 15| 2/2

1 10 | 10 | 141
Call | Freg | Dir | Mode | TS ~
5575 7005.7 050°.. Cw 09-03 2052
SKIMAR/P 70082 053°.. Cw 09-03 2052
4KEFD 70123 037°.. Cw 09-03 2052
RLI4F 7014.0 031°.. Cw 09-03 2052
LT14B 70221 040°.. Cwf 09-03 2052
LIA3ARL 70296 033°. Cw 09-03 2052
RNZaA 7007.0 033°. Cw 09-03 2051
RNTNY 7009.0 029 Cw 09-03 2051
LZ1IEZ 70185 050°..  Cw 09-03 2051